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ASG Support Numbers

ASG provides support throughout the world to resolve questions or problems regarding
installation, operation, or use of our products. We provide all levels of support during normal
business hours and emergency support during non-business hours. To expedite response time,
please follow these procedures.

Please have this information ready:

. Product name, version number, and release number
J List of any fixes currently applied
. Any alphanumeric error codes or messages written precisely or displayed

. A description of the specific steps that immediately preceded the problem

o The severity code (ASG Support uses an escalated severity system to prioritize service to
our clients. The severity codes and their meanings are listed below.)

. Verify whether you received an ASG Service Pack for this product. It may include
information to help you resolve questions regarding installation of this ASG product. The
Service Pack instructions are in a text file on the distribution media included with the
Service Pack.

If You Receive a Voice Mail Message:

1 Follow the instructions to report a production-down or critical problem.

2 Leave a detailed message including your name and phone number. A Support representative
will be paged and will return your call as soon as possible.

3 Please have the information described above ready for when you are contacted by the Support
representative.

Severity Codes and Expected Support Response Times

Severity Meaning Expected Support Response
Time
1 Production down, Within 30 minutes

critical situation
2 Major component of product disabled Within 2 hours

3 Problem with the product, but customer has ~ Within 4 hours
work-around solution

4 "How-to" questions and enhancement Within 4 hours
requests

ASG provides software products that run in a number of third-party vendor environments. Support
for all non-ASG products is the responsibility of the respective vendor. In the event a vendor
discontinues support for a hardware and/or software product, ASG cannot be held responsible for
problems arising from the use of that unsupported version.



Business Hours Support

Your Location

Phone

Fax

E-mail

United States and
Canada

Australia
England
France
Germany

Singapore

All other countries:

800.354.3578

61.2.9460.0411
44.1727.736305
33.141.028590
49.89.45716.222
65.332.2922

1.941.435.2200

941.263.2883

61.2.9460.0280
44.1727.812018
33.141.028589
49.89.45716.400
65.337.7228

Non-Business Hours - Emergency Support

Your Location

Phone

Your Location

support@asg.com

support.au@asg.com
support.uk@asg.com
support.fr@asg.com

support.de@asg.com

support.sg@asg.com

support@asg.com

Phone

United States and
Canada

Asia
Australia
Denmark
France
Germany
Hong Kong
Ireland
Israel/Bezeq
Japan/IDC

800.354.3578

65.332.2922
0011.800.9932.5536
00.800.9932.5536
00.800.3354.3578
00.800.3354.3578
001.800.9932.5536
00.800.9932.5536
014.800.9932.5536
0061.800.9932.5536

Japan/Telecom
Netherlands
New Zealand
Singapore
South Korea
Sweden/Telia
Switzerland
Thailand

United Kingdom

All other countries

0041.800.9932.5536
00.800.3354.3578
00.800.9932.5536
001.800.3354.3578
001.800.9932.5536
009.800.9932.5536
00.800.9932.5536
001.800.9932.5536
00.800.3354.3578

1.941.435.2200



ASG Web Site

Visit http://www.asg.com, ASG’s World Wide Web site.

Submit all product and documentation suggestions to ASG’s product management team at
http://www.asg.com/asp/emailproductsuggestions.asp.

If you do not have access to the web, FAX your suggestions to product management at (941)
263-3692. Please include your name, company, work phone, e-mail ID, and the name of the ASG
product you are using. For documentation suggestions include the publication number located on
the publication’s front cover.


http://www.asg.com/asp/emailproductsuggestions.asp
http://www.asg.com
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Preface

This ASG-Insight Reference Guide provides instruction for using ASG-Insight (herein
called Insight). Insight is a powerful interactive system automating the analysis process
of COBOL programs.

Allen Systems Group, Inc. (ASG) provides professional support to resolve any questions
or concerns regarding the installation or use of any ASG product. Telephone technical

support is available around the world, 24 hours a day, 7 days a week.

ASG welcomes your comments, as a preferred or prospective customer, on this
publication or on any ASG product.

About this Publication

This publication consists of these chapters:

. Chapter 1, "Introduction," provides an overview of Insight.

. Chapter 2, "File," describes commands available on Insight’s File menu.

. Chapter 3, "View," describes commands available on Insight’s View menu.

o Chapter 4, "Search," describes commands available on Insight’s Search menu.

. Chapter 5, "Logic," describes commands available on Insight’s Logic menu.

. Chapter 6, "Task." describes commands available on Insight’s Task menu.

. Chapter 7, "List." describes commands available on Insight’s List menu.

. Chapter 8, "Options," describes commands available on Insight’s Options menu.

. Chapter 9, "Help," describes commands available on Insight’s Help menu.

. Chapter 10, "Commands." describes commands available in Insight.

. Chapter 11, "Analyze," describes the analyze process.

X
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Chapter 12, "AKR Utilities," describes how to use AKR utilities.

Chapter 13, "Paragraph Control Transfer Methods," describes how control is passed
to and from target paragraphs.

Chapter 14, "Help Facility," describes how to use the comprehensive online help
facility.

Related Publications

The documentation library for ASG-Insight consists of these publications (where nn
represents the product version number):

Note:

ASG-Center Installation Guide (CNX0300-nn) contains installation and
maintenance information for ASG-Center, the common set of libraries shared by the
ASG-Existing Systems Workbench (ESW) suite of products.

ASG-Insight Installation Guide (INX0300-nn) provides instruction about the
installation and maintenance of ASG-Insight.

ASG-Insight Quick Reference Card (INX0900-rn) provides a summary of the
commands and functions within ASG-Insight.

ASG-Insight Quick Reference Guide (INX0600-nn) summarizes the syntax and use
of ASG-Insight commands.

ASG-Insight Reference Guide (INX0400-nn) provides detailed information about
the pop-ups, screens, and commands used in ASG-Insight, including field
descriptions, usage notes, and command syntax.

ASG-Insight User’s Guide (INX0200-nn) provides user information for
ASG-Insight.

To obtain a specific version of a publication, contact the ASG Service Desk.




Preface

ASG-Existing Systems Workbench (ASG-ESW)

ASG-ESW (herein called ESW) is an integrated suite of components designed to assist
organizations in enhancing, redeveloping, or re-engineering their existing systems. ESW
products use the Application Knowledge Repository (AKR) to store source program
analysis information generated by the Analytical Engine. Figure 1 represents the
components of ESW.

Figure 1 + ASG Existing Systems Workbench

Existing Systems Workbench I

HI ASG-Insight for Program Understanding |

HI ASG-Estimate for Resource Estimation |

ASG-SmartEdit for COBOL Editing
ASG-SmartEdit-Browse

ASG-SmartTest for Testing/Debugging
-TSO
-CICs

ASG-Center - IMS

- ASM

- APS

- PLI

-TCA

- DB2 Stored Procedure

N H ASG-SmartDoc for Program Documentation |
Application

Knowledge
Repository (AKR)

%| ASG-Recap for Portfolio Analysis |

HI ASG-Alliance for Application Understanding |

%I ASG-Encore |

HI ASG-AutoChange |

3} ASG-Bridge |

xi
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This table contains the name and description of each ESW component:

ASG-Alliance Alliance

The application understanding component that is
used by IT professionals to conduct an analysis of
every application in their environment. Alliance
supports the analysis and assessment of the
impact of change requests upon an entire
application. Alliance allows the programmer/
analyst to accurately perform application analysis
tasks in a fraction of the time it would take to
perform these tasks without an automated
analysis tool. The impact analysis from Alliance
provides application management with additional
information for use in determining the resources
required for application changes.

ASG-AutoChange AutoChange

The COBOL code change tool that makes
conversion teams more productive by enabling
quick and safe changes to be made to large
quantities of code. AutoChange is an interactive
tool that guides the user through the process of
making source code changes.

ASG-Bridge Bridge

The bridging product that enables field expansion
for program source code, without being required
to simultaneously expand the fields in files or
databases. Because programs are converted in
smaller groups, or on a one-by-one basis, and do
not require file conversion, testing during the
conversion process is simpler and more thorough.

ASG-Center Center

The common platform for all ESW products.
Center provides the common Analytical Engine to
analyze the source program and store this
information in the AKR. This common platform
provides a homogeneous environment for all
ESW products to work synergistically.

Xii
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ASG-Encore

Encore

The program re-engineering component for
COBOL programs. Encore includes analysis
facilities and allows you to extract code based on
the most frequently used re-engineering criteria.
The code generation facilities allow you to use the
results of the extract to generate a standalone
program, a callable module, a complement
module, and a CICS server. Prior to code
generation, you can view and modify the
extracted Logic Segment using the COBOL
editor.

ASG-Estimate

Estimate

The resource estimation tool that enables the user
to define the scope, determine the impact, and
estimate the cost of code conversion for COBOL,
Assembler, and PL/I programs. Estimate locates
selected data items across an application and
determines how they are used (moves, arithmetic
operations, and compares). Time and cost factors
are applied to these counts, generating cost and
personnel resource estimates.

ASG-Insight

Insight

The program understanding component for
COBOL programs. Insight allows programmers
to expose program structure, identify data flow,
find program anomalies, and trace logic paths. It
also has automated procedures to assist in
debugging program abends, changing a
computation, and resolving incorrect program
output values.

ASG-Recap

Recap

The portfolio analysis component that evaluates
COBOL applications. Recap reports provide
function point analysis and metrics information,
program quality assessments, intra-application
and inter-application comparisons and
summaries, and historical reporting of function
point and metrics information. The portfolio
analysis information can also be viewed
interactively or exported to a database,
spreadsheet, or graphics package.

ASG-SmartDoc

SmartDoc

The program documentation component for
COBOL programs. SmartDoc reports contain
control and data flow information, an annotated
source listing, structure charts, program summary
reports, exception reports for program anomalies,
and software metrics.
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ASG-SmartEdit SmartEdit The COBOL editing component that can be
activated automatically when the ISPF/PDF
Editor is invoked. SmartEdit provides
comprehensive searching, inline copybook
display, and syntax checking. SmartEdit allows
you to include an additional preprocessor (for
example, the APS generator) during syntax
checking. SmartEdit supports all versions of IBM
COBOL, CICS, SQL, and CA-IDMS.

ASG-SmartTest SmartTest The testing/debugging component for COBOL,
PL/I, Assembler, and APS programs in the TSO,
MVS Batch, CICS (including file services), and
IMS environments. SmartTest features include
program analysis commands, execution control,
intelligent breakpoints, test coverage, pseudo
code with COBOL source update, batch connect,
disassembled object code support, and full screen
memory display.

Invoking ESW Products

Xiv

The method you use to invoke an ESW product depends on your system setup. If you
need assistance to activate a product, see your systems administrator. If your site starts a
product directly, use the ISPF selection or CLIST as indicated by your systems
administrator. If your site uses the ESW screen to start a product, initiate the ESW screen
using the ISPF selection or CLIST as indicated by your systems administrator and then
typing in the product command on the command line.

The product names can also vary depending on whether you access a product directly or
through ESW. See "ESW Product Integration" on page xv for more information about
using ESW.
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To initialize ESW products from the main ESW screen, select the appropriate option on
the action bar pull-downs or type the product shortcut on the command line.

Alliance AL Understand » Application
AutoChange CcC Change P Conversion Set
Bridge BR Change » ASG-Bridge
Encore (Re-engineer) EN Re-engineer » Program
Estimate ES Measure » ASG-Estimate
Insight (Understand) IN Understand » Program
Recap (Portfolio Analysis) RC Measure » Portfolio
SmartDoc (Document) DC Document » Program
SmartEdit SE Change » Program

Or

Change » Program with Options

SmartTest ST Test » Module/Transaction

ESW Product Integration

Because ESW is an integrated suite of products, you are able to access individual ESW
products directly or through the main ESW screen. As a result, you might see different
fields, values, action bar options, and pull-down options on a screen or pop-up depending
on how you accessed the screen or pop-up.

Certain ESW products also contain functionality that interfaces with other ESW products.
Using SmartTest as an example, if Alliance is installed, SmartTest provides a dynamic
link to Alliance that can be used to display program analysis information. If Insight is
installed and specified during the analyze, the Insight program analysis functions are
automatically available for viewing logic/data relationships and execution path. For
example, the Scratchpad option is available on the Options pull-down if you have Insight
installed. Access to these integrated products requires only that they be installed and
executed in the same libraries.
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Examples

Example 1. Figure 2 shows the Encore Primary screen that displays when you access
Encore directly.

The Encore Primary screen contains these eight action bar menu items: File, View,
Extract, Generate, Search, List, Options, and Help.

Figure 2 « Encore Primary Screen

File Uiew Edtract Generate 3Zearch List Options  Help

AEG-Encare
CoHHand ===
etttk e e Wbtk
Aotk debookk dobolelolk ebototck
eddoth eddotk dehdettck  tedetokk Hefok
oot oot debtsok etttk Hepok
Hefototok
etk

Copykight Allen Swsteds Graup, Inc., an unpublished work.
A proprietary product of ASG, Inc. Use restricted to authorized licensees.
Uizit the ASG Zupport Web fite at www.asg.cod

Figure 3 shows the Encore Primary screen that displays when you access Encore through
ESW by selecting Re-engineer P Program from the ESW action bar menu. Notice that the
Primary screen name changes to ASG-ESW - Program Re-engineering when you enter
Encore through ESW. Also, the Logic menu item displays if Insight is installed.

Figure 3 « ESW Encore Primary Screen

File UView Edtract Generate Search Logic List Options Help

ASE-EIN - Prograd Re—engineering

CoHHand ===
Aottt Hetebbt bbb Aottt
Aettsick desteik etttk etetotek:
Aottt Aottt Hebetebbt bbbk Hebek
Aottt Aottt debebbebk bbbk Hebek
Atk
Aotk

Copyright Allen Systeds Group, Inc., an unpublished wark.
A proprietary product of ASG, Inc. Use restricted to authorized licensess.
Visit the ASE Support Web Zite at wuw,asg.cod
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Example 2. Figure 4 shows the File - Analyze Submit pop-up that displays when you
access SmartTest directly. Figure 5 shows the File - Analyze Submit pop-up that displays
when you access SmartTest through ESW.

Notice that the Analyze features field in Figure 5 lists additional ESW products than
shown on Figure 4. This field is automatically customized to contain the ESW products
you have installed on your system.

The actions shown on these screens also vary. For example, the D action (ASG-SmartDoc
Options) is available on the File - Analyze Submit screen if the SmartDoc product is
installed on your system. In Figure 4, the ASG-SmartDoc Options action is not available.

Figure 4 « File - Analyze Submit Screen

File - Analyze SUbHiT
CorAdand ===

E - Edit JCL 2 - EUbHIit JCL

CoMpile and link JoL (PDE or sequential):
Data set nane 'USER1Z2.REL.CGHNTL{VIAPCOBC)

Analyze features [v-M]i
REG—EMartTests ¥ Extended Analy=isl M

AKR data set naWe 'USER1Z2, GEMERAL.AKR’
AKR prograd nade [if overriding PROGRAA-IO0)

Analyze options:

CoHpile? [Y<H] o« v o« v o o o o T [¥ if needad by features)
Link l1oad Hodule reusable® [Y-M] T

Figure S« File - Analyze Submit Screen (Accessed through ESW)

File - Analwze ZubHit
CoHHand ===

E - Edit JCL ¥ - EubMiT JOL 0 - A%E-EnartDoc Options

CoHpile and link JCL [PDS or sequentiall:
Data sef nade 'USER1Z2.REL.CNTLIHTEST)

Analyze features [Y-M]:
AEG-In=sights T AEG-EHartTestl I Exdtended Analwsi=l N
AEG-ERarthoc: N AEG-Encores N

AKR data =set naHe 'UZERL1Z.GEMERAL.AKR’

AKR prograd nade [if owverriding PROGRAA-I0]

Analyze options:

CoHpile? (YNl « o o« o &« & & & & T [ if needed by features)
Link l1oad Hodule reusable® [veM] T [ASG-5HartTest
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Publication Conventions

Xviii

ASG uses these conventions in technical publications:

Convention

Represents

ALL CAPITALS

Initial Capitals on Each Word

lowercase italic
monospace

Monospace

Vertical Separator Bar (| )
with underline

Directory, path, file, dataset, member, database,
program, command, and parameter names.

Window, field, field group, check box, button, screen,
option names, and names of keys. A plus sign (+) is
inserted for key combinations (e.g., Alt+Tab).

Information that you provide according to your
particular situation. For example, you would replace
filename with the actual name of the file.

Characters you must type exactly as they are shown.
Code, JCL, file listings, or command/statement syntax.

Also used for denoting brief examples in a paragraph.

Options available with the default value underlined (e.g.,
YIN).



Introduction

Insight is the ESW component that is designed to help you understand COBOL programs.
Insight exposes program structure, identifies data flow, finds program anomalies, and
traces logic paths. It also has automated procedures for debugging program abends,
changing computations, and resolving incorrect program output values.

Insight Overview

Insight analyzes COBOL programs using IBM's TSO/ISPF interface, and is an electronic
window that lets you see the internal workings of a COBOL program.

Insight features Common User Access (CUA) screens, pull-downs, and pop-ups designed
to give you easy access to all product features.

An action bar is the line of keywords displayed at the top of a screen. Each keyword
represents an action category performed on that screen. To view the action list on a
pull-down, move the cursor to the desired keyword and press Enter. To make a selection,
type the number that corresponds to the desired action and press Enter. The result is either
a generated command or a pop-up.

A pop-up is a window that displays on your screen that allows you to enter information
for the requested action.

Note:
See the ASG-Insight User’s Guide for more information.

Powerful Insight facilities provide a precise, consistent, and thorough analysis of COBOL
source code. You no longer need to summarize information from source listings, cross-
references, and primitive online browse facilities. Each task is automated, yet blends with
your current maintenance practices. You can determine what information you want and
when you want it. You can also direct whether an overview or the details of a program
display.
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Benefits

Insight analyzes COBOL source code rapidly and accurately.

Use Insight's flexible options to get an overview of both structured and unstructured
programs. Insight gives you online access to complete data cross-referencing. These
references include automatic checks for group level and redefined datanames. In addition,
Insight retains the results so you can further evaluate them with other commands.

These Insight features reduce effort, eliminate oversights, and save time:

Efficiency. Collects information automatically from limited listings and browse
facilities. Use an Insight action bar selection or a command to evaluate your program and
to receive concise results.

Accuracy. Evaluates COBOL source code consistently and precisely.

Usability. Features easy-to-use CUA screens, pull-downs, and pop-ups eliminating the
need to search and summarize program listings. Results are summarized in screen
formats that prepare you for your next query.

Accessibility. Integrates accessibility into your daily TSO/ISPF work environment and
supplies useful help facilities.

Focus. Manages technical details so that you can focus on understanding programs and
assessing your changes.

Understandability. Provides pull-downs, pop-ups, and commands to automate each
task needed to learn a program. Pop-ups or Insight commands easily reveal any COBOL
program characteristic, and the resulting analysis is presented clearly.

Insight offers these five features that help you through the understanding process:
. Determining program structure

. Identifying data usage and relationships

. Tracing data usage in logic

. Tracing logic flow

. Saving, reusing, and printing information



File

This chapter describes items on the Insight File menu and contains these sections:

Topic Page

File Pull-down 4

File - Open Program Request Pop-Up 5

AKR Program Selection Pop-up 1

File - Close Program Request Pop-up 10
File - Save Program Request Pop-up 11
File - Analyze Submit Pop-up 12
File - AKR Utility Pop-up 15
File - AKR Directory Pop-up 17
File - AKR Allocate/Expand Pop-up 20
File - ASG-SmartEdit Request Pop-up 22
File - Execute Script Pop-up 23
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File Pull-down

Actions

To access, edit, and analyze programs, manage the AKR, execute script files, and exit

Insight, follow this step:

» Select File on the action bar and press Enter. The File pull-down, shown in Figure 6,

displays.

Figure 6 *

File Pull-down

File Wiew Zearch Logic Task List Options Help
_ 1. open... M - Prograd Understanding
2. Close...
T, Fave...
d. Analyze...
Se AKR UtilitWaua
6. AZG-SHArtEdit... Hettetst ctefotedobk Hefetetok
T. EMecute script... | ek dekkbek etttk
. EMit Aok
Heh
edetetch edetetch deddetbok  betedobk Hefok
Hefototok Hefototok defobtsok etttk Hepok
Heddoth
Hefetotah

copyright Allen systeds Group, INC., an unpublished work.
A proprietary product of ASG, IncC. Use pestricted to authorized licensess.
Vizit the AEG Zupport Mebk Zite at www.asg.con

1. Open Displays the File - Open Program pop-up used to type the AKR and
program name to be opened.

2. Close Displays the File - Close pop-up used to exit the active program
without ending the Insight session.

3. Save Displays the File - Save pop-up used to save marks and/or equates
in the active program.

4. Analyze Displays the File - Analyze Submit pop-up used to submit an

Analyze job, and to specify the AKR to store the analyze
information.

5. AKR Utility

Displays the File - AKR Ultility pop-up used to display the program
directory, allocate or expand an AKR, rename a program, and
delete a program.
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Action Result

6. ASG-SmartEdit Displays the File - SmartEdit Request pop-up used to specify
whether you want to edit or browse the source code.

This action only displays on the pull-down if SmartEdit is installed.

7. Execute script  Displays the File - Execute Script pop-up used to specify the dataset
name and script option.

8. Exit Closes the active program, ends the Insight session, and returns to
the screen that you used to access Insight.

Use the values specified on the Options - Product Parameters
pop-up to determine if equates and marks are to be saved when you
select this action.

File - Open Program Request Pop-Up

To open a program for examination in Insight, follow this step:

» Select File » Open and press Enter. The File - Open Program Request pop-up, shown
in Figure 7, displays.

Figure 7 « File - Open Program Request Pop-up

File - Open Program Request
Type AKR information and program name. Then press Enter.

Application Knowledge Repository (AKR) :

Data set name . . 'VIAUSR.BRIDGEG60.AKR'

Program name . . (blank for selection list)
Volume serial . . (if not cataloged)
Password . . . . (if password protected)

A program initially displays in Source View. Use the View pull-down to select other
views. See "Source View Screen" on page 29 and "View" on page 25 for more
information regarding views.
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Fields

Data set name Required. Type the dataset name of the AKR where the program
resides.

Program name  Optional. Type the name of the program if not entered in the Data set
name field. If the program name is not entered, the AKR Program
Selection pop-up displays to select the program name.

Volume serial Required if the dataset is not cataloged. Type the volume serial
number of the device where the AKR resides.

Password Required if the dataset is protected. Type the dataset password.

Note:

After you enter the AKR information on the File - Open Program Request pop-up, it is
saved and displays on the pop-up the next time it is opened.

Usage Notes

When you open a new program while another program is open, the File - Open Program
Request pop-up (Figure 8 on page 6) displays specifying the active program disposition
and any updates. After you select an option, the AKR Program Selection pop-up displays
allowing you to open a new program.

Figure 8 « File - Open Program Request Pop-up When Active Program Exists

File - Open Program Request

A program is currently open. Select an action to
be performed on the open program before opening
new program. Then press Enter.

1 1. Close the program, save any updates
2. Close the program, no updates saved
3. Do not close program

Note:
You can also open new programs with the CALL command, the PROGRAM command,
or the VIEW command. See "Commands" on page 177 for more information on these
commands.




AKR Program Selection Pop-up

2 File

To list information about each program in the AKR and choose a program

1 Leave the program name on the File - Open Program pop-up blank and press Enter.
The AKR Program Selection pop-up, shown in Figure 9, displays.

Figure 9 « AKR Program Selection Pop-up

CALLDYN
CALLLAB
CHKACCT2
CTXP0O1
DB2SAMP
DB2001
DB2002
DB2003
DB2004
DECLTEST
DECLTV
DLITCBL
EMPINQ
IDMST001
IDMST002

Command ===>

AKR Program Selection

Alias Of

VIAPGM3

Lines

Application Knowledge Repository: USER.TEST.AKR

DDMMYYYY
DDMMYYYY
DDMMYYYY
DDMMYYYY
DDMMYYYY
DDMMYYYY
DDMMYYYY
DDMMYYYY
DDMMYYYY
DDMMYYYY
DDMMYYYY
DDMMYYYY
DDMMYYYY
DDMMYYYY
DDMMYYYY

Scroll ===> CSR

Time Jobname

:MM:SS SRENRAPA
MM:SS SRENRAPA
MM:SS VIADBDB

:MM:SS SRENLESD
MM:SS SRENRAPD
MM:SS SRENRAPD
:MM:SS SRENRAPD
MM:SS SRENRAPD
MM:SS SRENRAPD
:MM:SS SRENRAPA
MM:SS SRENRAPA
MM:SS SRENRAPA
:MM:SS SRENLESJ
MM:SS SRENRAPI
MM:SS SRENRAPI

2 Select a program using the line command area or type SELECT in the command

input area.

More than one Insight user can view a COBOL program at the same time. The first

person who enters a program has write access and can save marks and equates. All

subsequent users cannot save marks and equates and receive a message that the program
is currently being viewed.

You can scroll the AKR Program Selection pop-up using either the scroll commands or
the LOCATE command. The LOCATE command scrolls directly to the specified name.

If the name does not exist, the scroll facility displays the nearest match.
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Fields

Field Description

Application Specifies the AKR dataset name specified on the File - Open
Knowledge Program Request pop-up.
Repository

Line command area  Identifies the line command area, which accepts these line
commands:

S Selects the specified program. The Source View screen
displays.

/ Locates the specified program. The screen is scrolled until
the specified program is at the top of the display.

Name Specifies the name of the program in the AKR, from the
PROGRAM-ID statement.

If the analyzed program contains an ENTRY point, Name is the
ENTRY point name.

If you overrode the name in the PROGRAM-ID statement when
you submitted the analyze job, Name is the name you entered in
the AKR program name field on the File - Analyze Submit
pop-up.See "File - Analyze Submit Pop-up" on page 12 or "File
- AKR Directory Pop-up" on page 17 for more information about
AKR entries.

Alias Of Specifies the name of the program containing the ENTRY point,
if the analyzed program contains an ENTRY point.

If you overrode the name in the PROGRAM-ID statement when
you submitted the analyze job, Alias of is the name that you
entered in the AKR program name field on the File - Analyze
Submit pop-up.See "File - AKR Directory Pop-up" on page 17
for more information about alias names in the AKR.
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Field Description

Type Indicates the analysis type(s) performed on the program. The
File - Analyze Submit pop-up shows the analysis type when the
analyze job is submitted. Insight only uses programs with the IN
analysis type. These are the valid analysis types:

EN Indicates an Encore analysis was performed.
IN Indicates an Insight analysis was performed.
ST Indicates a SmartTest analysis was performed.
DS Indicates a SmartDoc analysis was performed.
DC Indicates a SmartDoc analysis with a COBOL
compile was performed.
DX Indicates an Extended SmartDoc analysis was
performed.
DA Indicates an Extended SmartDoc analysis with a
COBOL compile was performed.
ASM Indicates the program is an Assembler source
program.
PROFILE  Indicates that the member contains SmartTest
profile information.
METRICS Indicates that the member contains SmartDoc
metric information.
INTERNAL This is an Encore feature that indicates the
member contains logic segment information.
Lines Lists the number of program source lines.
Date/Time Lists the date and time the program was analyzed.
Jobname Specifies the job name that analyzed the program.
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File - Close Program Request Pop-up

Field

10

To exit the active program without exiting Insight and to save marks and equates, follow
this step:

» Select File » Close and press Enter. The File - Close Program Request pop-up, shown
in Figure 10, displays.

Figure 10 * File - Close Program Request Pop-up

File - Close Program Request

Select the desired disposition of any updates
for the program to be closed. Then press Enter.

2 1. Close the program, save any updates
2. Close the program, no updates saved

Use the File - Save Program Request pop-up or the SAVE command to save marks and
equates.

Field Options

Option Overrides the values set on the Options - Product Parameters pop-up. If
you select no option, Insight uses the values on the Options - Product
Parameters pop-up to determine if marks and equates are to be saved.
Choose one of these options:

Close the program, save updates

Exits the active program saving any marks and equates that you
created or changed during the session. This overrides the values set on
the Options - Product Parameters pop-up.

Close the program, no updates saved

Exits the active program without saving any marks and equates that
you created or changed during the session. This overrides the values
set on the Options - Product Parameters pop-up.
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File - Save Program Request Pop-up

Field

Usage Notes

To save the AKR marks and/or equates that were created or changed, without ending the
session, follow this step:

» Select File » Save and press Enter. The File - Save pop-up, shown in Figure 11,
displays.

Figure 11 ¢ File - Save Program Request Pop-up

File - Save Program Request

Select the updates (if any) to be saved for the
current program. Then press Enter.

1 1. Save user MARKs and EQUATEs
2. Save user MARKs only
3. Save user EQUATEs only

To save marks and equates, use the File - Close pop-up or the SAVE command.

Field Description

Option Overrides the values set on the Options - Product Parameters pop-up. If
you select no option, Insight uses the values set on the Options - Product
Parameters pop-up to determine if marks and equates are to be saved.

Choose one of these options:
Save User MARKSs and EQUATEs

Select 1 to save all marks and equates for the active program. This
overrides the values set on the Options - Product Parameters pop-up.

Save User MARKSs only

Select 2 to save all marks created or changed for the active program.
Equates are not saved. This overrides the values set on the
Options - Product Parameters pop-up.

Save User EQUATESs only

Select 3 to save all equates entered for the active program. Marks are
not saved. This overrides the values set on the Options - Product
Parameters pop-up.

See "Options - Scratchpad Pop-up" on page 161 for information about creating user
marks and equates.

11
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File - Analyze Submit Pop-up

Options

12

To edit and submit JCL, to specify the AKR information for the analyze job, and to store
the information on the AKR, follow this step:

» Select File » Analyze, or type ANALYZE in any command input area, and press Enter.
The File - Analyze Submit pop-up, shown in Figure 12, displays.

Note:

You can also analyze programs using other methods. See "Analyzing a COBOL
Program" on page 340 for more information.

Figure 12 » File - Analyze Submit Pop-up

ASG-ESW - Prepare Program
Command ===>

E - Edit JCL S - Submit JCL D - Doc Options

Compile and link JCL (PDS or sequential):
Data set name '"USER.TEST.CNTL (YOURJCL) '

Analyze features (Y/N):
Understand: Y Test: Y Extended Analysis: Y Document: N
Re-engineer: N

AKR data set name 'USER.TEST.AKR'

AKR program name (if overriding PROGRAM-ID)

Analyze options:

Compile? (Y/N) . . . . . . . . . Y (Y if needed by features)
Link load module reusable? (Y/N) Y (Test only)

Option Description

E - Edit JCL Enables you to review or change the compile/analyze JCL, if
required. To do this, type E and press Enter. The JCL member you
specified in the Data Set Name field generates the JCL to be edited,
applying the rules outlined in the Analyze appendix. The Edit screen
displays the generated JCL.

Type SUBMIT to submit the edited JCL for execution when you
have completed editing. Optionally, you can save the edited JCL in
a partitioned dataset using the CREATE command. Otherwise, any
changes made at this time are not saved.
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Option Description

D - Doc Options  Displays only if SmartDoc is installed. Type D to display the
File - SmartDoc Options screen used to request an Extended
SmartDoc analysis and to specify what reports (if any) are
generated.

S - Submit JCL Submits the JCL to compile/analyze the specified program. The JCL
submitted is generated from the JCL member specified in the Data
Set name field, using the rules outlined in the Analyze appendix.

Fields

Field Description

Data setname  Required. The PDS member or sequential dataset containing the JCL
to compile and link the program. If the JCL resides in a source
manager such as Librarian or Panvalet, use the VIASUB edit macro
to submit the compile/analyze job.

Understand Displays only if Insight is installed. This type of analysis provides
Insight logic and program execution flow capabilities. If Insight is the
only product installed, this field contains YES and cannot be changed.
The defaultis Y.

Test Displays only if SmartTest is installed. Y indicates that a SmartTest
compile/analysis will be performed. This type of analysis provides the
testing and debugging information required by SmartTest. If
SmartTest is the only product installed this field contains YES and
cannot be changed. The defaultis Y.

Extended Displays only if SmartTest is installed. This type of analysis provides
Analysis comprehensive program analyzing capabilities in addition to the
testing and debugging capabilities of SmartTest. The defaultis Y.

A SmartDoc extended analysis is specified on the File - SmartDoc
Options screen.

Document Displays only if SmartDoc is installed. This type of analysis provides
the report information generated by SmartDoc. If SmartDoc is the
only product installed this field contains YES and cannot be changed.
The default is Y.

Re-engineer Displays only if Encore is installed. This type of analysis provides the
logic and program execution flow capabilities of Encore. YES
specifies that an Encore compile/analysis is to be performed. The
default is N.
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AKR data set Required. Type the name of the AKR that is to contain the

name information for the analyzed program.

AKR program  Optional. Type an alias name to be used by the analyze process to save
name its results in the AKR.

If you do not enter a value in this field, the analyze job saves the
results in the AKR using the PROGRAM-ID statement name in the
COBOL source.

If you enter a AKR program name, the analyzed job saves the results
using the entered name in the AKR, and also as an PROGRAM-ID
alias.

If a program contains ENTRY points, the analyze job also saves a
member for each ENTRY point in the AKR, with an alias of the
PROGRAM-ID.

Note:

This field is only used for the AKR program name and does not
change the COBOL program name in the source.

Analyze options

Optional. Type the analyze options you want to override. Default
options for the analyze job are established at installation time.
Analyze options that can be entered in this field are described in the
Analyze appendix.

Compile?

Optional. You do not need to compile or link a program if Insight,
Encore, or SmartDoc are the only analyze features specified. Type N
in this field to suppress the JCL compile step and link steps. This field
is forced to a value of Y if SmartTest and/or Extended analysis is
selected.

Link load
module reusable

Optional. Use this field to test a program under SmartTest that is
dynamically loaded and is tested with RUN MONITOR. You must
mark the load module as reusable to retain the Breakpoints across
calls. The defaultis Y.




2 File

File - AKR Utility Pop-up

To display the program directory, allocate or expand an AKR, rename a program, and
delete a program, follow this step:

» Select File » AKR Ultility and press Enter. The File - AKR Utility pop-up, shown in
Figure 13, displays.

Figure 13 « File - AKR Utility Pop-up

ASG-ESW - AKR Utility
Command ===>

Blank - Display member list D - Delete member
A - Allocate/expand AKR R - Rename member

Application Knowledge Repository (AKR):

Data set name . . 'VIAUSR.BRIDGE60.AKR'

Member . . . . . (1f "R" or "D" selected)
New name . . . . (1f "R" selected)

Volume serial . . (if not cataloged)
Password . . . . (if password protected)

Options

Options Description

Blank - Display member  Displays the File - AKR Directory pop-up that lists the
list programs stored in the AKR. You can also delete or rename
programs on the File - AKR Directory pop-up.

A - Allocate/expand AKR Select option A to allocate a new AKR or to expand an
existing AKR. Type the AKR name in the Data set name
field to display the File - AKR Allocate/Expand pop-up. If
expanding an existing AKR, type YES in the Expand
existing AKR field on that pop-up.

D - Delete member Select option D to delete a program. Prior to selecting
option D, type the AKR name in the Data set name field and
the program name in the Program field.

R - Rename member Select option R to rename a program. Prior to selecting
option R, type the AKR name in the Data set name field, the
program name in the Program field, and the new name in the
New name field.

15
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Field Description

Data set name Required. Type the name of the AKR directory. If the TSO ID
qualifier is the same as the user ID, type the group, type, and program
without quotes. If the TSO ID qualifier is different than the user ID,
type the project, group, type, and program within quotes.

Member Required when deleting or renaming a program; otherwise, you can
enter the program name either in the Program field or in the Data set
name field. Type the name of the program in the AKR.

New name Required when renaming a program. Type the new name of the
program. The name must be 1 to 10 alphanumeric characters.

Volume serial ~ Required if the dataset specified in the Data set name field is not
cataloged. Type the volume serial number. If the dataset is cataloged,
this field is optional.

Password Required if the dataset is protected. Type the dataset password.

16
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File - AKR Directory Pop-up

Fields

To list all members in the specified AKR, follow this step:

» Leave the command input area blank on the File - AKR Ultility pop-up and press Enter.
The File - AKR Directory pop-up, shown in Figure 14, displays.

Figure 14 » File - AKR Directory Pop-up

File - AKR Directory

Command ===> Scroll ===> CSR

AKR: USER.TEST.AKR Row: 1

Total members: 26 Total entries: 29

D - Delete R - Rename Total records: 12000 Free space: 41.2%

Name New name Alias of Type Date Time Jobname Space

_ $$SEGMENTS INTERNAL DDMMYYYY HH:MM SRENMDR 0.0%

_ AT810BO IN, RN DDMMYYYY HH:MM SRENDSMB 1.1%
DBMSCBL ET070BO IN, RN DDMMYYYY HH:MM SRENDSMB
DBMSCBL ET760BO IN, RN DDMMYYYY HH:MM SRENDSMB

_ DSM00022 IN, RN DDMMYYYY HH:MM SRENDSMB 0.3%

_ ET070BO IN, RN DDMMYYYY HH:MM SRENDSMB 3.3%

_ ET760BO0 IN, RN DDMMYYYY HH:MM SRENDSMB 1.7%

_ ET927BJ IN, RN DDMMYYYY HH:MM SRENDSMB 2.8%

E02031 IN, RN DDMMYYYY HH:MM SRENDSMB 1.6%

~ INDEXBUG IN, RN DDMMYYYY HH:MM SRENMDR2 0.3%

: INDEXDEM IN, RN DDMMYYYY HH:MM SRENMDRY9 0.3%

_ LSTRACEO IN, RN DDMMYYYY HH:MM SRENFKKB 0.3%

_ LSTRACEL IN, RN DDMMYYYY HH:MM SRENFKKB 0.3%

Scroll to view members that are not visible, or type L (Locate) plus a character string to
scroll to a specific member. The pop-up scrolls to the member that most closely matches
the character string.

Field Description

AKR Specifies the complete dataset name of the requested AKR as entered
on the File - AKR Utility pop-up.

Row Specifies the relative number in the AKR of the first member
displayed on this pop-up.

Total members  Specifies the total number of members in this AKR, not including

aliases.
Total entries Specifies the total number of members in this AKR, including aliases.
Total records Specifies the number of records allocated to this AKR, as entered in

the Space Amount field on the File - AKR Allocate/Expand pop-up
when the AKR was either allocated or expanded.

If the Space Units was entered as Tracks or Cylinders on that pop-up
instead of Records, the amount is converted to Records for display in
the Total records field.
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Free space

Indicates the amount of available space in this AKR, rounded to the
nearest .1 percent.

Line command
area

Specifies the area to the left of the Name field, which accepts these
commands:

D - Delete Type D to the left of each program you want to delete
from the AKR. You can also delete programs on the
File - AKR Utility pop-up.

R - Rename Type R to the left of the program you want to rename,
and type the new name in the New name field. When
you change the name of a primary program, the alias
name is automatically changed. You can also rename
programs on the File - AKR Utility pop-up.

Note:
Alias programs cannot be deleted or renamed.

Name

Specifies the names of the member in the AKR. Program names are
taken from the PROGRAM-ID statement. If the analyzed program
contains an ENTRY point, Name is the ENTRY point name.

If the name in the PROGRAM-ID statement was overridden at the
time the analyze job was submitted, Name is the name that you
entered in the AKR program name field on the File - Analyze Submit
pop-up.

See "File - AKR Directory Pop-up" on page 17 for more information
about entries in the AKR.

New name

Specifies the new member name. This field is required when you
rename a member. The member name must be 1 to 10 alphanumeric
characters.

Alias of

Specifies the name of the program that contains the ENTRY point, if
an analyzed program contains an ENTRY point.

If the you overrode the name in the PROGRAM-ID statement at the
time the analyze job was submitted, Alias of is the name that you
entered in the AKR program name field on the File - Analyze Submit
pop-up.

An alias program cannot be deleted or renamed. The alias name is
automatically changed when you either delete or rename the primary
program.

See "File - AKR Directory Pop-up" on page 17 for more information
about alias names in the AKR.




2 File

Type Indicates the type of analysis that was performed on the member and
specified on the File - Analyze Submit pop-up. These are the valid

types:
AL
ST
IN
DS

DX
DA

ASM
RC
EN

All Alliance analysis was performed.
A SmartTest analysis was performed.
An Insight analysis was performed.

A SmartDoc analysis was performed. DC - A
SmartDoc analysis with a COBOL compile was
performed.

A SmartDoc Extended analysis was performed.

A SmartDoc Extended analysis with a COBOL
compile was performed.

The program is an Assembler source program.
A Recap analysis was performed.

An Encore analysis was performed.

Type PROFILE

METRICS

INTERNAL

This feature indicates the member contains profile
information. Generally, the member name is the
profile user ID. Profile information is automatically
saved when you use the SmartTest Session Tailoring
screen to specify the testing environment options.
After you specify program level testing options on the
Session Tailoring screen (and they are saved in the
AKR profile member), the profile member is used by
SmartTest when you initiate a test session. A profile
is only used (and updated) by the user for whom it is
created. The profile member automatically reflects
any modifications to the Session Tailoring screen.

This is a SmartDoc feature that indicates the member
contains metrics information. The Name field
contains $$METRIC or the name you assigned to the
metrics using the Rename function. The $$METRIC
member contains metrics calculated for the programs
in this AKR.

This is an Encore feature that indicates the member
contains logic segment information. The Name field
contains $$SEGMENTS or the name assigned to the
member using the Rename function. The
$SSEGMENTS member contains the logic segment
information.

Date Specifies the date the program was analyzed.
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Field Description

Time Specifies the time the program was analyzed.
Jobname Specifies the Job name used to analyze the program.
Space Specifies the percentage of space the program is using on this AKR.

This percentage is rounded to the nearest .1 percent.

File - AKR Allocate/Expand Pop-up

To allocate a new AKR

1 From the ASG-ESW - AKR Utility pop-up, select option A and press Enter. The
File - AKR Allocate/Expand pop-up, shown in Figure 15, displays.

Figure 15 « AKR Allocate/Expand Pop-up with SMS and a VSAM AKR

File - AKR Allocate/Expand
Command ===>
S - Submit JCL E - Edit JCL C - Specify Catalog
Expand existing AKR . . . NO (Yes or No)
AKR data set name . . . . 'USER.TEST.AKR'

Management Class ... (Blank for default MGMTCLAS)

Storage Class . . . . . (Blank for default STORCLAS)
Volume . . . . . . .

Data Class . . . . . . (Blank for default DATACLAS)
Space units . . . . . RECORDS (Records, Tracks or Cylinders
Space amount . . . . 4000 (Total AKR size in above units)
Unique . . . . . . . YES (Enter NO for a VSAM data space)

Job statement information:

/ /NAME JOB (ACCOUNT) , NAME,

// MSGCLASS=A

//* INSERT '/*ROUTE PRINT NODE.USER' HERE IF NEEDED.

//*

2 Type NO in the Expand existing AKR field and press Enter. The space the AKR
needs depends on the size and the number of COBOL programs that are being
analyzed and placed in it.

To allocate a new AKR or to expand an existing AKR

1 From the ASG-ESW - AKR Utility pop-up, select option A and press Enter. The
File - AKR Allocate/Expand pop-up, shown in Figure 15, displays.

2 Type YES in the Expand existing AKR field and press Enter.
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Fields

2 File

Option Description

S - Submit JCL Submits the generated JCL to allocate or expands the AKR shown
in the AKR Data Set Name field.

E - Edit JCL Enables you to edit the generated JCL used to allocate or to expand
the AKR shown in the AKR data set name field.

C - Specify Catalog Displays the AKR Catalog Information pop-up that is used to
specify the dataset name and password of a catalog, if required.

Field Description

Expand existing AKR Expands the AKR shown in the AKR data set name field. Type
NO to allocate a new AKR. The default is NO.

AKR data set name Specifies the AKR name specified on the File - AKR Utility
pop-up.

Management Class If your site uses SMS, type the management class for the AKR.
The default is set during installation.

Storage Class If your site uses SMS, type the storage class for the AKR. The
default is set during installation.

Volume Required if you are not using SMS. Type the volume serial
number where the AKR is to reside.

Data Class If your site uses SMS, type the data class for the AKR. The
default is set during installation.

Space units Optional. Do not enter if you are using SMS. Type the type of
units to allocate. The units must be records, tracks, or cylinders.
The default is records.

Space amount Required if you are not using SMS. Type the amount of space
to allocate in the type of units specified in the Space units field.
The space needed for the AKR depends on the size and the
number of programs being analyzed and placed in it. See the
ASG-Center Installation Guide for space estimates.

Unique Optional. Type NO if the AKR is a sub allocation in a VSAM

data space on the volume. Otherwise, type YES. The default is
YES.
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Field Description

Job statement Required to submit JCL. Type the appropriate JOB statement

information information for your site. Ifyou need to specify either a private
catalog or the password for your catalog, type C in the command
input area to display the AKR Catalog Information pop-up. You
can use this pop-up to specify the Catalog DSN and Password.

Catalog DSN Optional. Type the catalog dataset name if you want the AKR
dataset name to be added to a private catalog.

Password Required if the CATALOG DSN is protected. Type the
password for the catalog dataset name specified in the
CATALOG DSN field.

File - ASG-SmartEdit Request Pop-up

22

Note:
This pop-up is only available if SmartEdit is installed.

To browse or to edit the source code using SmartEdit, follow this step:

» Select File » SmartEdit and press Enter. The File - ASG SmartEdit Request pop-up,
shown in Figure 16, displays.

Figure 16 » File - ASG-SmartEdit Request Pop-up

File - ASG-SmartEdit Request

Select Edit or Browse, and select the Options
Panel display option. Then press Enter.

Type of request Options
1 1. Edit / Display options panel
2. Browse




2 File

Fields

Field Description

Type of request Either edits or browses the source code. The Edit or Browse Entry
pop-up displays.

Display options Displays the Edit or Browse Options pop-up before accessing the

panel Edit or the Browse Entry pop-up. If not specified, the Edit or
Browse Options pop-up is bypassed and the Edit or Browse Entry
pop-up displays. The default is to display the Edit or Browse
Options pop-up.

File - Execute Script Pop-up

To begin processing a script file, follow this step:

» Select File » Execute script and press Enter. The File - Execute Script pop-up, shown
in Figure 17, displays.

Figure 17 » File - Execute Script Pop-up

File - Execute Script

Type a data set name, a data set name with a member name, or just a member
name in parentheses. Select the "Single step" option if you wish to
execute the script one command at a time.

If you wish to "resume" normal execution of a "single step" script, select
the "Resume automatic mode" option. If you wish to cancel a "single step"
script, select the "Cancel execution" option. The "resume" and "cancel"
options should be entered with a blank data set name field.

Data set name

Options

1 1. Automatic
2. Single step
3. Resume automatic mode
4. Cancel execution
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Field Description

Data set Required. Specifies the name of the script file to be processed.

name

Options Specifies the processing mode for the script file. These are the three
options:

. Automatic

Each command in the script file is executed consecutively. This is
the default.

. Single Step
Each command in the script file displays in the command input area.
You can either change or erase the displayed command. Press Enter
to actually execute the displayed command. Processing of the script
file continues in this manner until all commands have been
displayed.

. Resume Automatic Mode
After a script file has begun executing in Single step mode, selecting
Resume executes the remaining script file commands without
stepping through each.

. Cancel execution
After a script file has begun executing in Single step mode, selecting
Cancel stops the execution of the remaining script file commands.
Script files can also be executed using the EXECUTE command. See

'

'EXECUTE Command" on page 209 for more information.
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View

This chapter describes items on the Insight View menu and contains these sections:

Topic Page

View Pull-down 27
Source View Screen 29
View - Tree View Request Pop-up 30
Tree View Screen 33
View - Structure View Request Pop-up 37
Perform Structure View Screen 33
View - Paragraph Cross-Reference Request Pop-up 34
View - Paragraph Cross Reference Pop-up 36
View - Program Summary Pop-up 47
Program Summary - Files Pop-up 48
Program Summary - Data Pop-up 50
Program Summary - Copy Members Pop-up 51
Program Summary - Sections/Paragraphs Pop-up 52
Program Summary - Control Flow Pop-up 54
Program Summary - Preprocessor Statements Pop-up 55
View - Levels Request Pop-up 57
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Topic Page
View - Reset Request Pop-up 58
View - Exclude Request Pop-up 59

Insight displays analyzed COBOL program information in source, graphical, and list
formats. These formats give different views of the program and its logical components.
Use these views to examine the program and to learn a programs structure and function.

The View pull-down has three primary view methods to assist you in isolating,
understanding, and identifying the important sections of the source program. These are
the types of views:

View Description
Source view Presents the actual COBOL source code in source statements order.
Tree view Presents the paragraph hierarchy, that shows the program structure in

logical execution order.

Structure view  Presents the program structure graphically.

You can change the magnification in all of the view methods (i.e., you can zoom in and
out of logical program components). Each view is created from the same original
COBOL source program, but presents a different perspective, and is concurrently
available and synchronized with the other views. You may switch back and forth between
views and retain the results of certain analysis inquiries.

The Structure and Tree Views display the logical program components and can be
tailored to display varying program structure levels. Tailor these displays using the

Request pop-ups for each.

You can request these program understanding list formats from any primary view:

Format Description

The Paragraph Shows the control flow between paragraphs in the program.
Cross-reference

The Program Profile Provides information about file, copy member, section, control,
and database usage.




View Pull-down

Actions

Use the View pull-down shown in Figure 18 to perform these tasks:

. View a program

. View paragraph cross-reference information

. View program information

. Display or exclude source according to program hierarchical structure

. Change the information level viewed

. Rese

t the display

. Exclude lines from the display

To display the View pull-down, follow this step:

» Select View from the action bar and press Enter.

Figure 18 «

View Pull-down

File

Wiew %earch Logic Task List Options Help

ComHa

. Bource

. Treea..

. Btructure...

. Paragraph H-ref...
« Progran SUHHarY...
« ZO0OH N

. Zoon out

. Leuels...

. Reset...

« Exclude...

Ll e Rl B R B S

-

grad Understanding

1

copyright Allen SysteWs Group. IncC., an unpublished vork.

A proprietary product of ASG. Inc.

Uze pestricted to authorized 1licenseess.

Vizit the AEG Zupport Mebk Zite at www.asg.cod

3 View

1. Source Displays the Source View screen, that shows the program in
COBOL source statement order.
2. Tree Displays the program in logical execution order, showing logical

program units and the relationships between related units. When
you choose this action, the View - Tree View Request pop-up
displays allowing you to specify the format of the Tree View

display.
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3. Structure

Displays the program in a graphical format, with each box on the
screen representing a logical program unit. When you choose this
action, the View - Structure View Request pop-up displays

allowing you to specify the format of the Structure View display.

4. Paragraph X-ref

Displays the View - Paragraph Cross Reference Request pop-up
used to customize the View - Paragraph Cross Reference pop-up.

5. Program summary

Displays the View - Program Summary pop-up, used to select the
type of summary information displayed.

6. Zoom in

Displays source lines according to the hierarchical levels of the
program. When you select this action, a message displays to
remind you to position the cursor and to press Enter.

7. Zoom out

Excludes source lines according to the hierarchical levels of the
program. When you select this action, a message displays
reminding you to position the cursor and press Enter. This action
is not valid on the Perform Structure View screen.

8. Levels

Displays the View - Levels Request pop-up used to specify the
new level number. This action is valid only on the Tree View and
Perform Structure View screens.

9. Reset

Displays the View - Reset Request pop-up used to specify what
display features to reset, including highlighting, tags, excluded
lines, pending line commands, and messages.

10. Exclude

Displays the View - Exclude Request pop-up used to specify the
exclude options and string.




3 View

Source View Screen

Usage Notes

Note:

A program first displays in the Source View format. Select View P Source or type
SOURCEVIEW to return to Source View from the Tree View or the Perform Structure
View.

To display the COBOL source program code in a textual format, follow this step:

» Select View P Source and press Enter. The Source View screen, shown in Figure 19,
displays. This screen displays each source line and functions similar to the ISPF
Browse option.

Figure 19 * Source View Screen

File View Search Logic Task List Options Help
Source View Program: VIAIDEMO
Command ===> Scroll ===> CSR

KKk kk  Kkkkkk kX kkk Xk kkkkkkkxkkxxx TOP OF DATAX * %k K % % kK ok sk % & o % % Kk % % % K o % % k & % % % &

000001 IDENTIFICATION DIVISION.

000002 PROGRAM-ID. VIAIDEMO.

000003 AUTHOR. WRITTEN BY ASG AT LANGLVL 2.
000004 ENVIRONMENT DIVISION.

000005 CONFIGURATION SECTION.

000006 SOURCE-COMPUTER. IBM-370.

000007 OBJECT-COMPUTER. IBM-370.

000008 INPUT-OUTPUT SECTION.

000009 FILE-CONTROL.

000010 SELECT MASTERIN ASSIGN TO S-MASTERIN.
000011 SELECT MASTER-RPT ASSIGN TO S-MREPORT.
000012 DATA DIVISION.

000013 FILE SECTION.

000014 FD MASTERIN

000015 RECORDING MODE IS F

000016 BLOCK CONTAINS 0 RECORDS
000017 LABEL RECORDS ARE STANDARD.
000018

000019 COPY VIAIMAST.

The Source View screen displays individual source lines, with the copy members properly
expanded. The name of the program that is being viewed displays in the upper right corner
of the screen.

To close the active program and display the primary Insight screen, follow this step:

» Press PF3 or type END on the Source View screen. See the "END Command" on
page 200 for more information.

The Source View screen is also available in the Task facility.
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View - Tree View Request Pop-up

To format a program to display on the Tree View screen

1 Select View » Tree and press Enter. The View - Tree View Request pop-up, shown
in Figure 20, displays.

Figure 20 » View - Tree View Request Pop-up

View - Tree View Request

Type request options. Then press Enter. For a name selection list
for a range (other than 1 or 2), type a pattern (e.g. ABC*) in the
name field.

Levels 2 of 5 of depth
Contents Range
1 1. Labels 1 1. Procedure division
2. Labels and performs 2. All entry points
3. Labels, performs and GOTOs 3. Perfrange name
4. Labels, performs, GOTOs and 4. Entry point name
conditionals 5. Nested program name
Name
Options
Repetition

2  Complete these fields:

a  Specify the number of levels you want to view.

You can change the levels at any time by selecting View P Levels action or by
typing LEVELS and pressing Enter.

b  Select the type of statements to be displayed in the Contents field.

¢ Specify how much of the program to display in the Range field.

Note:
Each configuration parameter field contains default values when this pop-up first
displays. If you change these defaults, the new values are retained for subsequent
sessions.

3 Press Enter to display the Tree View screen shown in Figure 21 on page 33.
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3 View

Levels

Optional. Specifies the number of hierarchical levels of COBOL source
statements that display. Change the level depth value to either increase or
decrease the amount of detail displayed. The amount of detail increases as
the level depth increases.

The total number of levels in the program displays to the right of this field.
Type a number equal to or less than this number, or enter the value MAX.
When you specify MAX levels, the actual number of levels displayed
depends on the Repetition Option. The default is 2.

Contents

Optional. Specifies the number of the statement type(s) to be displayed.
Each statement type is a subset of the COBOL statements contained in the
program. Insight classifies COBOL statements into subsets by grouping
together COBOL verbs of a similar nature.

These are the subsets available on this screen:

Labels The PROCEDURE DIVISION statement, and all section and
paragraph names in the PROCEDURE DIVISION. This is
the default.

Performs Statements containing the PERFORM, SORT, or MERGE
verbs.

GOTOs Statements containing an ALTER or GO TO verb.

Conditionals Statements or parts of statements that conditionally change
the flow of control in a program such as IF, ELSE, and
WHEN.

Range

Optional. Specifies how much of the program is to be displayed.
These ranges are available:

1. Procedure Division  Displays the entire PROCEDURE DIVISION.
This is the default.

2. All Entry Points Displays the entire PROCEDURE DIVISION
and all ENTRY points.

3. Perfrange Name Displays one perform range. If you select this
range, you must enter the perform range name in
the Name field.

4. Entry Point Name Displays one ENTRY point. If you select this
range, you must enter the entry point name in the
Name field.
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5. Nested Program Name Displays one nested program. If you select this
range, you must enter the program name in the
Name field of the code that is executed by
entering the specified program. Requires Name
field.

Name Specifies the name of the perform range, entry point, or nested program to
be displayed. This field is required if you select the Perfrange name, Entry
point name, or Nested program name for the Range. This field is ignored if
you select either range 1 or 2.

If this field is left blank, a selection list pop-up displays allowing you to
select the desired name. You canuse wildcard characters [question mark (?)
for 1 character; asterisk (*) for zero or more characters] in this field to
reduce the size of the selection list. On the selection list pop-up, specify
the Name by typing S next to the desired name.

Repetition Determines whether perform range structures entirely display wherever
they appear in the program.

If not specified, the complete perform range structure displays the first time
it displays in the program. Subsequent references to the perform range do
not display, and are tagged as REPEAT to the right of the PERFORM
statement.

If specified, the perform range is fully displayed wherever it occurs. The
default is display the perform range only the first time it displays.

When you request MAX level depth, the actual number of levels displayed may be
different, depending on the value in the Repetition field. MAX displays all levels in the
program; however, if the maximum level consists of only repeated perform ranges, then
the level display is truncated to the next higher level that does not consist exclusively of
repeated perform ranges.



Tree View Screen

3 View

The Tree View screen, shown in Figure 21, displays logical program units and the
relationships between them. A logical program unit is a PERFORMed range of code
including GO TO code, or a CALLed program. COBOL source lines show Logical

programs, and indents show unit relationships.

Figure 21 » Tree View Screen

File View Search Logic Task List Options Help

Tree View LINE 1 OF 98
Command ===> Scroll ===> CSR
ASG1582I 5 OF 5 LEVELS DISPLAYED IN THE VIEW.
hhkhkhkhkk hkhkhkkkhkkhkhkhhkhkkhhhkhkhhkkkkkkkk TOP OF DATA khkhkhkhkhkhkhkhkkhkhkhkhkhkhkhkhkhkhkrhkhkkhkkhkkkkxk

000000 PROCEDURE DIVISION.

000001 PERFORM PROGRAM-INIT.

000002 PROGRAM-INIT.

000002 PERFORM P005-VAL-PARM THRU POOS5-EXIT.

000003 PO05-VAL-PARM.

000003 IF DBA-DEPT-CODE > 24 COND
000003 :  PERFORM P999-ABEND-PROGRAM.

000004 : P999-ABEND-PROGRAM.

000004 : CALL 'ABENDPGM' USING ABEND-CODE. PGM EXIT
000003 IF DBA-DEPT-CODE < 16 COND
000003 :  PERFORM P999-ABEND-PROGRAM.

000004 :  P999-ABEND-PROGRAM. REPEATED
000004 : CALL 'ABENDPGM' USING ABEND-CODE.

000003 POO5-EXIT.

000002 PERFORM P010-OPEN THRU PO19-EXIT.

000003 P010-OPEN.

000003 CALL 'DBAOPEN1' USING DBA-DEPT-CODE.

000003 CALL 'DBAOPEN2' USING DBA-DEPT-CODE.

000003 PO19-EXIT.

Tree View Generated Tags

The left column on the Tree View screen indicates the nesting level for each statement.

This table lists the valid tags:

Tag Description

+ Indicates lower levels of program structure not displayed. To view the

lower level structure, use the ZOOMIN command.

Indicates that the statement or label is artificially indented to highlight a

conditional statement.

COND Indicates the control flow verb is part of a conditional (IF, AT END, etc.).

PGM EXIT Indicates a program exit.

RECUR Indicates the PERFORM is recursive.
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Tag Description

REPEATED  Ifa PERFORM range is repeated, a REPEATED tag is placed on the line
REP of the duplicate PERFORM range.

SOURCE The displayed line is actual source code.
SRC

The most basic Tree View displays paragraph and section labels. All executed
PERFORM statement labels under the paragraph label containing the PERFORM are
indented. Program exits also display.

You can view Control flow statements to understand how the labels are executed.
Indentation is directly related to the nesting level of the PERFORM statement.

Primary Commands

These primary commands perform the specified functions on the Tree View screen when
they are entered in the command input area:

Command Description

BRANCH  Locates the occurrence of the PERFORM within the Tree View display.
If the label is not shown, a message displays.

END Exits the Tree View screen.

JUMP Returns to the Source View screen at the location corresponding to the
current cursor location where this command is issued on the Tree View
screen. Jump also functions as the J line command.

LEVELS n  Redisplays the Tree View screen to the nth level. Any level less than n is
expanded to the requested level. Levels greater than n are removed. The
LEVELS command works globally throughout the displayed program.

RESET Removes highlighting, erases tags in columns 73 through 80, and
redisplays excluded lines.
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ZOOMIN

Expands the Tree View diagram to the next lower hierarchical level.
Typing ZOOMIN on a label expands all PERFORMs contained by the
paragraph. If there are no more hierarchical levels, or they have already
been expanded, the source displays for that label.

If all levels have been displayed and you type ZOOMIN, an error message
displays because ZOOMIN cannot be entered on a source line.

Z0OMOUT

Removes levels. The first level removed is the source. If there is no
source displayed, lower levels are removed. If both source and lower
levels have been removed, no more levels are removed.

Paragraphs or PERFORMs are marked as containing results (i.e., they are
tagged as USE, MOD, or REF). If the results at the source level are
desired, ZOOMIN may be used to see the source and the actual results.
Results do not display if they are not outside Tree View's bounds.

These commands work the same way in Tree View as they do in Source
View:

. REPEAT
. RECALL

The EXCLUDE, FINDXTND, and HIGH commands function the same
way in Tree View as they do in Source View except these operands are
not applicable in Tree View:

. FIRST
. LAST
. PREV
. NEXT

The LPRINT and LPUNCH commands can be executed in the Tree View
screen, however, the only valid operands are asterisk (*) and NOTE.
LPRINT and LPUNCH copy the specified target to the List and Punch
file, respectively.

The SCROLL command can be executed in the Tree View screen,
however, these operands are the only valid operands in Tree View:

. HI

. FIRST

. LAST -NHI
. NEXT

. PREV
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Line Commands

These line commands perform the specified functions on the Tree View screen:

Line Command Description

Fn Redisplays n excluded lines beginning with the first excluded line. The
default is 1.

J Returns to the Source View screen at the location where this command
is issued on the Tree View screen. This command also functions as the
JUMP primary command.

Ln Redisplays n lines starting with the last line in the block of excluded
lines.

Sn Redisplays n lines starting with the first line in the block of excluded

lines. The defaultis 1.

SS Redisplays a block of lines. Type on the first and last line in the block
of lines to be redisplayed.

Xn Excludes n lines from being displayed. The default is 1.

XX Excludes a block of lines from being displayed. Type this command on
the first and last line to excluded.

71 Performs the ZOOMIN command at the line where it is entered. See
"ZOOMIN/ZOOMOUT Commands" on page 324 for more
information.

Z0 Performs the ZOOMOUT command at the line where it is entered. See
"ZOOMIN/ZOOMOUT Commands" on page 324 for more
information.
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View - Structure View Request Pop-up

To format the program on the Perform Structure View screen

Select View P Structure and press Enter. The View - Structure View Request pop-up,
shown in Figure 22, displays.

Figure 22 » View - Structure View Request Pop-up

View - Structure View Request

Type request options. Then press Enter. For a name selection list
for a range (other than 1 or 2), type a pattern (e.g. ABC*) in the
name field.

Levels 2 of 4 of depth
Range
1 1. Procedure division

2. All entry points

3. Perform range name

4. Entry point name

5. Nested program name
Name
Options

Repetition

Specify these configuration parameters:

a  Specify the number of hierarchical levels you want to view.

You can change the levels at any time by selecting View P Levels action or by
typing LEVELS and pressing Enter.

b Specify how much of the program you want to display in the Range field.

Note:
Each field contains default values for the configuration parameters when the
View - Structure View Request pop-up first displays. If you change these defaults,
the new values are retained for subsequent sessions.

Press Enter to display the Perform Structure View screen, shown in Figure 23 on
page 40.
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Fields
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Field Description

Levels Specifies the number of hierarchical levels of COBOL source statements
that display. Change the level depth value to increase or to decrease the
amount of detail displayed. The amount of detail increases as the level depth

increases.

The total number of levels in the program displays to the right of this field.
Type a number equal to or less than this number, or enter the value MAX.
When you specify MAX levels, the actual number of levels displayed
depends on the Repetition Option. The default is 2.

Range Specifies how much of the program is to be displayed. These are the valid

ranges:

1. Procedure Division

2. All Entry Points

3. Perfrange Name

4. Entry Point Name

5. Nested Program Name

Displays the entire PROCEDURE DIVISION.
This is the default.

Displays the entire PROCEDURE DIVISION
and all ENTRY points.

Displays one perform range. If you select this
range, you must enter the perform range name
in the Name field.

Displays one ENTRY point. If you select this
range, you must enter the entry point name in
the Name field.

Displays one nested program. If you select this
range, you must enter the program name in the
Name field of the code that is executed by
entering the specified program. Requires the
Name field.




Usage Notes

3 View

Field Description

Name Required if you select the Perform range name, entry point name, or nested
program name for the Range. This field is ignored if you select either Range
1or2.

Type the name of the perform range, entry point, or nested subprogram to be
displayed.

If you leave this field blank, a selection list pop-up displays allowing you to
select the desired target name. Wildcard characters [question mark (?) for 1
character; asterisk (*) for zero or more characters] can be entered in this field
to reduce the size of the selection list.

On the selection list pop-up, specify the Name by typing S next to the
desired name.

Repetition  Specifies whether perform range structures display entirely display
wherever they appear in the program.

If not specified, the complete perform range structure displays the first time
it displays in the program. A box containing the notation REPEAT
represents subsequent references to the perform range.

If specified, the perform range structure fully displays whenever it occurs.
The default is to display the perform range only the first time it displays.

When you choose MAX level depth, the actual number of levels displayed may be
different, depending on the value in the Repetition field. MAX displays all levels in the
program; however, if the maximum level consists of only repeated perform ranges, then
the level display is truncated to the next higher level that does not consist exclusively of
repeated perform ranges.
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Perform Structure View Screen
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The Perform Structure View screen, shown in Figure 23, represents a COBOL program
structure graphically and reflects the hierarchical relationship between the logical
components (usually PERFORMed code and CALLed programs).

Figure 23 * Perform Structure View Screen

File View Search Logic List Utility Help
Perform Structure View PROGRAM: VIAIDEMO
===> SCROLL ===> CSR
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The Perform Structure View screen displays the logical program units and all transfers of
control between these components. Transfers of control include PERFORMs, GOTOs,
and CALLs.

Boxes represent logical program units, and lines between the boxes represent
relationships. Insight assigns a unique number to each box and displays that number in
the upper right corner of the box. The unit name displays in the box. If the name does not
fit inside the box, the name is truncated and an asterisk (*) represents the remaining
characters.

If the box contains REPEATED, the first occurrence box number that displays the entire
perform range structure is contained inside the box in the lower right corner.

When this screen first displays, a message stating the number of levels displayed, and the
total number of program levels displays. Use the Levels option to change the number of
levels displayed.



Usage Notes

3 View

Use scrolling commands (UP, DOWN, LEFT, and RIGHT) to see the whole structure
chart. The More field displays in the upper right corner of the screen below the SCROLL
field when the screen is scrollable. The More field lists the available scrolling directions
for the current window, and indicate you can view additional data by scrolling in the
indicated direction(s). These are the indicators:

+ DOWN
- UP

> RIGHT
< LEFT

To view the COBOL source code statements for a particular logical program unit box on
the Structure View screen, follow this step:

» Select View » Zoom in, or type ZOOMIN, and press Enter.
The Source View screen displays as a pop-up with a shortened action bar. This screen

displays the highlighted COBOL source statements in the requested perform range and
excludes all other lines from the display.

Note:

For more information about the ZOOMIN/ZOOMOUT commands, see "Commands" on
page 177. For more information about the Zoom in action on the View pull-down, see
"Actions" on page 27.
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View - Paragraph Cross-Reference Request Pop-up

To customize the View - Paragraph Cross Reference Request pop-up, follow this step:

» Select View P Paragraph X-refand press Enter. The View - Paragraph Cross-Reference
Request pop-up, shown in Figure 24, displays.

Figure 24 « View - Paragraph Cross-Reference Request Pop-up

View - Paragraph Cross-Reference Request

To list transfers of control to or from paragraphs in the program,
type a target name and select a target type and direction. Then
press Enter. For a name selection list for a target type (other
than types 1 and 6), type a pattern (e.g. ABC*) in the target name
input field.

Target name

Target type Direction
1. None - use cursor 1 1. Previous
Mark name 2. Next
Perfrange name
Program name
Subset name
Line range
Label name

~N oUW N

Fields

Target Type Description

Target name Optional. Type the mark name, perform range name, program name,
subset name, line range, or label name used as a basis for the paragraph
cross-reference. If you want to use cursor positioning to select the target,
leave this field blank. The information you enter in the Target name
field must correspond to the information in the Target type field.

If this field is left blank and you choose a Target type other than None,
a selection list pop-up displays that allows you to select the desired
target name. Wildcard characters [question mark (?) for 1 character;
asterisk (*) for zero or more characters] can be entered in this field to
reduce the size of the selection list. On the selection list pop-up, specify
the Name by typing S next to the desired name.

Target type Optional. Select the type of target represented by the entry in the Target
name field. The default is None - use cursor.

Choose from these options:
1. None - Use Cursor Specifies the target by positioning the cursor on
the desired target. When you select this Target

type, the previous View screen displays to allow
cursor placement.
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Target Type Description

2. Mark

3. Perfrange

4. Program

5. Subset

Specifies that the entry in the Target name field is
a mark name (i.e., a set of source lines created
using the scratchpad pop-ups or the COPY,
MARK, MERGE, or RENAME commands). The
View - Paragraph Cross Reference pop-up
displays all paragraph names that contain the
specified mark name.

Specifies that the entry in the Target name field is
a perform range name. All paragraph names that
contain the perform range display on the

View - Paragraph Cross Reference pop-up.

Specifies that the entry in the Target name field is
a program name. All paragraph names that
contain the program display on the

View - Paragraph Cross Reference pop-up.

Specifies that the entry in the Target name field is
a predefined COBOL language subset.
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Target Type Description

These are the predefined subsets:

ASsignment DEBug 10

CAll DEFinition LABel
Clcs DIRective MAINIine
COBOLII DIVision MATH
COBOL/370  DL/T| DL/1 Output
COMment DML PARagraph
CONditional ~ ENtry PERform
COPY EXIt | PGMExit RETurn
DB2/SQL FALLthrough  SECtion
DDL GOto SORTMerge
DEAD IDMS STructure
DEADCode INClude TESted
DEADData Input UNTested

Note:

See the ASG-Insight User’s Guide for a description of each subset and
subset type. The TESted and UNTested subsets are only available if
you have applied TCA results. See the ASG-SmartTest TCA User’s
Guide for more information.

A screen subset:
Highlighted | HI
NONHighlighted | NHI
Excluded | X
NONExcluded | NX
A tagged lines subset of tags appearing in columns 73 through 80.

The View - Paragraph Cross Reference pop-up displays all paragraph
names that contain statements of the specified subset type.

Line Specifies the Target name field entry is a single line number or range of
lines. Columns 1 through 6 of the Source View display Line numbers.
The View - Paragraph Cross Reference pop-up displays all paragraph
names that contain the specified line(s).
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Target Type Description

Label Specifies the entry in the Target name field is a label (i.e., any
PROCEDURE DIVISION paragraph name or section name, or the
literals PROCEDURE and PROC). The View - Paragraph Cross
Reference pop-up displays all paragraph names that contain the
specified label.

Direction Specifies the type of transfer. These are the valid values:

Previous Displays paragraphs where control is transferred to the
target paragraph. The default is Previous.

Next Displays paragraphs where control is transferred from the
target paragraph.

View - Paragraph Cross Reference Pop-up
The View - Paragraph Cross Reference pop-up shows how control is transferred to or
from the target paragraphs. Use this pop-up to determine these items:
. How to get to a paragraph
. Which paragraphs transfer control to a paragraph

. Which paragraphs does this paragraph transfer control to
To display The View - Paragraph Cross Reference pop-up, follow this step:

» Type PREF on any screen or press Enter on the View - Paragraph Cross-Reference
Request pop-up. The View - Paragraph Cross Reference pop-up, shown in Figure 25,
displays.

Figure 25 » View - Paragraph Cross Reference Pop-up

View - Paragraph Cross Reference
Command ===> Scroll ===> CSR

Target (s) : LABEL PROCEDURE
Direction: NEXT

A : Add to target P : Execute PREF S : Select for viewing
S Target paragraph(s) How Goes to
PROCEDURE DIVISION PERFORM PROGRAM-INIT
" " PERFORM POOO-NEXT

PROGRAM EXIT

Tk kkkkkkkkk Xk kkkkkkkxkkkxkkkkk* BOTTOM OF DATA * % % ko % % kK sk % k K o % % k ok % % &k %k & % k &k % %

To copy data to the List file, follow this step:

» Use the LPRINT * command on this pop-up.
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Fields
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Target(s)

Specifies the paragraph name(s) of the requested target.

Direction

Specifies the type of transfer. PREVIOUS highlights paragraphs
where control is transferred from and NEXT highlights paragraphs
where control is transferred to. The default is PREVIOUS.

Line command
area

Specifies the area to the left of the Comes from or Target
paragraph(s) field, which accepts these entries:

A Adds the selected paragraph to the target paragraph(s). If the
direction is PREVIOUS, the target paragraph is added at the top
of the list. If the direction is NEXT, the target paragraph is
added to the end of the list.

Executes another paragraph cross-reference.

S Returns to the source code with the first line of the paragraph
displayed at the top of the screen.

Target
Paragraph(s)

The paragraphs requested as the target in the PREF command. Ditto
marks (") display when multiple paragraphs transfer control to the
same paragraph.

How

Indicates the way control is transferred from or to the target
paragraph.

If the target is reached through more than one occurrence of the same
transfer method, the number of occurrences, in parentheses, follows
the method of transfer. For example:

PERF(2), GO(3)

indicates that the target was reached through 2 PERFORMs and 3
GOTOs.

Note:

For a complete list of paragraph control transfer methods and
abbreviations, see "Paragraph Control Transfer Methods" on

page 383.

Comes from

Displays when the direction is PREVIOUS. It lists the paragraph
names that transfer control to the target paragraph(s). All paragraphs
that relate to the target paragraph are grouped together.

Goes to

Displays when the direction is NEXT. It lists the paragraph names
that receive control from the target paragraph(s).
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View - Program Summary Pop-up

Fields

To select the type of summary information to view

1 Select View P Program Summary and press Enter. The View - Program Summary
pop-up, shown in Figure 26, displays.

Figure 26 » View - Program Summary Pop-up

View - Program Summary
Options
1 1. Files

2. Data

3. Copy members

4. Sections

5. Control flow

6. CICS, DB2, etc.

2 Type the number corresponding to the type of summary information you want to
view.

Each option on the View - Program Summary pop-up presents a collection of facts
about a particular program entity type, such as a file, data item, perform range, or
called subprogram. The default is Files. View the program summary information to
save time and facilitate decision making.

Option Description

Files Displays the Program Summary - Files pop-up showing counts of
file usage and statements.

Data Displays the Program Summary - Data pop-up, that shows the
number of statements that include the various types of uses of data
items.

Copy members Displays the Program Summary - Copy Members pop-up,
indicating the number of lines copied for all copy members.

Sections Displays the Program Summary - Sections/Paragraphs pop-up, that
shows the number of lines in the various program sections and
paragraphs.
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Option Description

Control flow Displays the Program Summary - Control Flow pop-up, indicating
the number of each type of control flow statement.

CICS, DB2, etc. Displays the Program Summary - Preprocessor Statements pop-up
indicating the number of database statements, including SQL,
IDMS, CICS, and DL/

Program Summary - Files Pop-up

To display file usage and statement counts, follow this step:

» Select View P Program Summary » Files and press Enter. The Program
Summary - Files pop-up, shown in Figure 27, displays.

Figure 27 « Program Summary Files Pop-up

Program Summary - Files
FD FD FD SD
Seq Rel Indx (Seq)
vsage:
Input only . . . : 1 0 0 0
Output only . 2 0 0 0
Input/Output . . : 0 0 0 0
Total File Count . : 3 0 0 0
Input:
Statements . . . : 1 0 0 0
Paragraphs . . . : 1 0 0 0
Output:
Statements . . . : 10 0 0 0
Paragraphs . . . : 5 0 0 0
Fields
FD Seq Specifies File Descriptions (FDs) defined with ORGANIZATION IS
SEQUENTIAL in the FILE-CONTROL paragraph.
RD Rel Specifies File Descriptions (FDs) defined with ORGANIZATION IS
RELATIVE in the FILE-CONTROL paragraph.
FD Indx Specifies File Descriptions (FDs) defined with ORGANIZATION IS
INDEXED in the FILE-CONTROL paragraph.
SD (Seq) Specifies Sort File Descriptions (SDs), categorized by Insight as

sequential files.
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Field Description

Input only Specifies the number of FD and SD definitions referenced only in
input (e.g., READ) statements.

Output only Specifies the number of FD and SD definitions referenced only in
output (e.g., WRITE) statements.

Input/Output Specifies the number of FD and SD definitions referenced in both
input (e.g., READ) and output (e.g., WRITE, REWRITE) statements.

Total File Count Specifies the number of FD and SD definitions in the FILE

SECTION.
Input Specifies the number of statements that reference an FD or SD
Statements definition.
Paragraphs Specifies the number of paragraphs containing input statements that

reference an FD or SD definition.

Output Specifies the number of statements that reference an FD or SD
Statements definition.
Paragraphs Specifies the number of paragraphs containing output statements that

reference an FD or SD definition.

49



ASG-Insight Reference Guide

Program Summary - Data Pop-up

To display the number of statements that include the various data item types in the
program, follow this step:

» Select View P Program Summary P Data and press Enter. The Program
Summary - Data pop-up, shown in Figure 28, displays.

Figure 28 « Program Summary - Data Pop-up

Program Summary - Data
*
01/77 Subitem 88 COMP DISPLAY
Total Count . . . : 24 133 1 10 0
Usage:
Redefines . . . . : 1 0 0 0 0
Modified, not used 7 81 0 2 0
Used, not modified 7 22 1 1 0
Indirect ref. only 4 19 0 0 0
Dead . . . . . . : 3 4 0 2 0
Input statements 1 0 0 0 0
Output statements : 10 0 0 1 0
Role:
SQL host variable : 0 0 0 0 0
Linkage . . . . . : 1 3 0 1 0
CALL ... Using . : 3 2 0 1 0
in FD/RD/SD . . . : 2 24 0 0 0

Fields

Field Description

01/77 Specifies the number of data variables defined as 01 or 77 level
data items.
Subitem Specifies the number of data variables defined as subordinate to

01 level data items, with the exception of 88 level data items
that are counted separately.

88 Specifies the number of data variables defined as 88 level data
items.

COMP Specifies the number of data items defined with USAGE IS
COMP.

DISPLAY Specifies the number of data items defined with USAGE IS
DISPLAY.

Total Count Specifies the total number of data items defined as 01/77,

Subitem, 88, COMP, and DISPLAY.

Redefines Specifies the number of data items defined with a REDEFINES
clause.
Modified, not used Specifies the number of data items modified but not used.
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Used, not modified

Specifies the number of data items used but not modified.

Indirect ref. only

Specifies the number of data items referenced (i.e, used or
modified) through an alias, e.g., a RENAME or REDEFINE.

Dead

Specifies the number of data items not used or modified,
directly or indirectly, in the program.

Input statements

Specifies the number of data items referenced in input
statements.

Output statements

Specifies the number of data items referenced in output
statements.

SQL host variable Specifies the number of data items referenced in EXEC SQL
statements as host COBOL variables.

Linkage Specifies the number of data items appearing in the LINKAGE
section.

CALL ... Using Specifies the number of data items referenced in the USING
clause of CALL statements.

In FD/RD/SD Specifies the number of data items associated with an FD, RD,

or SD definition (i.e., the number of defining input/output
buffers).

Program Summary - Copy Members Pop-up

To display information about all COPY statements in the program, including Librarian
-INC members, Panvalet ++INCLUDE members, and SQL INCLUDEs, follow this step:

» Select View P Program Summary » Copy members and press Enter. The Program

Summary - Copy Members pop-up, shown in Figure 29, displays.

Figure 29 » Program Summary - Copy Members Pop-up

Program Summary - Copy Members

Command ===> Scroll ===> CSR
Member Name Lines Contents

VIAIMAST 24 01(l) OTHER-DATA (23)

Kk hkhkhkhkhkhkkhkrkhkhkhkhkkhkhkkhkhkhkhkhhkhhkhkxkhkxx BOTTOM OE‘ DATA Kk ok ok ok ok ok ok ok ok ok ok kokk ok ok kkokkkokkok
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Fields

Field Description

Member Name  Specifies the member name as it displays in the copy statement.

Lines Specifies the number of source lines copied for that member.

Contents Describes the overall contents of the copied member. These are the
valid descriptions:

. IDENTIFICATION DIVISION lines

. ENVIRONMENT DIVISION lines

. FD, SD, RD, and CD definitions

. 01, 88, and 77 level items

. OTHER level items (i.e., 02 through 49 level)
. PROCEDURE DIVISION statements

. Program elements from multiple DIVISIONs

Program Summary - Sections/Paragraphs Pop-up
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To show the number of lines in the various program sections and paragraphs, follow this
step:

» Select View P Program Summary P Sections and press Enter. The Program
Summary - Sections/Paragraphs pop-up, shown in Figure 30, displays.

Figure 30 » Program Summary - Sections/Paragraphs Pop-up

Program Summary - Sections/Paragraphs
Location Lines
Data Division . . . . . . : 219
File Section . . . . . : 39
Working-Storage Section : 171
Linkage Section . . . . : 8
Procedure Division . . . : 266
Number of SECTIONs . . : 1
Number of labels . . . : 26
"EXIT only" . . . . : 10
GOTO/ALTER targets . : 4
In-line code . . . . : 4
PERFORMed . . . . . : 22
Deadcode . . . . . . : 4
Number of statements . : 110
Within PERFORMs .. 99
Deadcode . . . . . . : 4
Total . . . . . . . . . . : 496
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Fields

Field Description

Data Division Specifies the total number of source lines, including comments, for
each of these sections:

. File Section
. Working-Storage Section

. Linkage Section

Procedure Specifies the total number of PROCEDURE DIVISION source lines,
Division including comments. These subtotals are included:

. The number of SECTIONSs in the PROCEDURE DIVISION.

. The number of paragraphs in the PROCEDURE DIVISION,
including these areas:

— the number of paragraphs containing only an EXIT
statement

— and the number of paragraphs targeted by GO TO or
ALTER statements.

—  The number of paragraphs not reached via PERFORMs
(i.e., they execute as a result of fall through code).

—  The number of paragraphs reached via PERFORMs.

—  Thenumber of paragraphs containing dead code (i.e., code
that is never reachable).

The number of statements (not source lines) in the PROCEDURE
DIVISION are included for these statements:

. The number of statements executed by PERFORM statements.

. The number of unreachable statements.

Total Specifies the number of source lines in the program, including
comment lines.
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Program Summary - Control Flow Pop-up

To show the number of each control flow statement type in the program, follow this step:

» Select View P Program Summary » Control flow and press Enter. The Program
Summary - Control Flow pop-up, shown in Figure 31, displays.

Figure 31 « Program Summary - Control Flow Pop-up

External CALL statements . . . .
Prograns CALLed . . . . . . .
PERFORH stateHents o« o o o o o«
Number of PERFORH ranges . . .

GO TO statedents . . . o & & . .
Hurbetr of labels reached . . .

HuWber of ALTERed GO TO= . . .
HUlti-way branches .« & o o & w0
GO TO...DEPEMDING OM... . . .
EVALUATEwes & & & & = & & = &
ON CONDITION statenents « o« o o o
End-of-file [AT END...] . . .

Frograd fummary - Control Flow

Ranges PERFORHed HOPe than once . . &

Labels reached Wore than once . . . &

Other Input-Output CGn?iTiDnS
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Fields

External CALL statements

Specifies the number of CALL statements in the
PROCEDURE DIVISION. A subtotal of the number of
unique programs called is included.

PERFORM statements

Specifies the number of PERFORM statements in the
program. Subtotals are included for the number of
unique Perform Range targets and the number of
ranges performed multiple times.

GO TO statements

Specifies the number of GO TO statements in the
program. Subtotals are included for the number of
unique labels that are targets of GO TOs, the number of
labels that can be reached from multiple GO TOs, and
the number of GO TOs that are the targets of ALTER
statements.
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Field Description

Multi-way branches Specifies the number of GO TO DEPENDING ON and
EVALUATE statements in the program. Subtotals are
included for the number of GO TO DEPENDING ON
and EVALUATE statements.

ON CONDITION statements  Specifies the number of statements containing
exception condition clauses, including SIZE,
OVERFLOW, INVALID KEY, NO DATA, END OF
PAGE, and END OF FILE. Subtotals are included for
the number of AT END condition statements, the
number of other I/O exceptions (e.g., INVALID KEY),
and the number of arithmetic exceptions (e.g., ON
OVERFLOW, ON SIZE ERROR, etc.).

Program Summary - Preprocessor Statements Pop-up

To display the number of database statements in the program, including SQL, IDMS,
CICS, and DL/I, follow this step:

» Select View P Program Summary » CICS, DB2, etc. The Program
Summary - Preprocessor Statements pop-up, shown in Figure 32, displays.

Figure 32 « Program Summary - Preprocessor Statements Pop-up

Program Summary - Preprocessor Statements
SQL IDMS CICS DL/I
Usage:
Input only . . . : 7 0 N/A N/A
Output only . 1 0 N/A N/A
Input/Output . . : 2 0 N/A N/A
Total Count . . . : 10 0 N/A N/A
Input:
Statements . . . : 2 0 0 0
Paragraphs . . . : 2 0 0 0
Output:
Statements . . . : 6 0 0 0
Paragraphs . . . : 5 0 0 0
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Fields

Field Description

SQL Specifies the number of Tables and Views referenced in EXEC SQL
statements.

IDMS Specifies the number of IDMS Record Names referenced in IDMS
COBOL statements.

CICS Specifies the number of EXEC CICS statements.

DL/ Specifies the number of EXEC DL/I statements, including CALL

'CBLTDLI' statements.

Input only Specifies the number of database definitions referenced only by
statements that query the database.

Output only Specifies the number of database definitions referenced only by
statements that update the database.

Input/Output Specifies the number of database definitions referenced by statements
that query or update the database.

Total Count Specifies the number of database definitions.

Input Specifies the number of query-type statements that reference a
Statements database definition.

Input Specifies the number of paragraphs containing query-type statements
Paragraphs that reference a database definition.

Output Specifies the number of update-type statements that reference a
Statements database definition.

Output Specifies the number of paragraphs containing update-type statements
Paragraphs that reference a database definition.

56



3 View

View - Levels Request Pop-up

To redisplay the current Tree View or Perform Structure View screen to the specified
level, follow this step:

P Select View P Levels and press Enter. The View - Levels Request pop-up, shown in
Figure 33, displays.

Figure 33 » View - Levels Request Pop-up

View - Levels Request

To re-build a Tree View or Structure View with a
different level of program hierarchy, type a
number or MAX. Then press Enter.

Levels 2 of 3 of depth
Field
Levels Specifies the number of hierarchical levels to be displayed. Change

the level depth value to increase or decrease the amount of detail
displayed. The amount of detail increases as the level depth increases.

The total number of levels in the program displays to the right of this
field. Type a number equal to or less than this number, or type the
value MAX to display all levels. The default is 2.
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View - Reset Request Pop-up

Fields

58

To remove highlighting, tags, messages, redisplay excluded lines, and cancel pending
line commands, follow this step:

P Select View P Reset and press Enter. The View - Reset Request pop-up, shown in
Figure 34, displays.

Figure 34 » View - Reset Request Pop-up

Viey - Reset Request

To reset some o all prograd dizplay features,
felect an option. Then press Entar.

optiaons

2 ALl
Highlights
Tags
EHdcCluded lines
Line coddands
HESS&QES

Field Description

All Optional. If specified, all conditions indicated by each of the other
fields on this pop-up reset. If not specified, only those options selected
reset. The default is to reset all conditions.

Highlights Optional. If specified, any line that was highlighted is returned to
nonhighlighted. If not specified, highlighted lines remain highlighted
unless the All option is specified. The default is lines remain
highlighted.

Tags Optional. If specified, tags in the columns 73 through 80 are erased. If
not specified, tags remain unless the All option is specified. The
default is lines remain tagged.

Excluded lines  Optional. If specified, excluded lines redisplay. If not specified,
excluded lines remain excluded unless the All option is specified. The
default is lines remain excluded.




3 View

Field Description

Line commands Optional. If specified, pending line commands cancel. If not specified,
pending line commands remain on the screen unless the All option is
specified. The default is pending line commands remain displayed.

Messages Optional. If specified, short or long messages are removed from the
display. If not specified, messages remain displayed on the screen
unless the All option is specified. The default is messages remain
displayed.

View - Exclude Request Pop-up

To exclude lines from the screen display, follow this step:

P Select View » Exclude and press Enter. The View - Exclude Request pop-up, shown in
Figure 35, displays.

Figure 35 ¢ View - Exclude Request Pop-up

View - ExClude Request

To edclude specific lines frodM the prograd being
uiewed, select the desired option. Then press
Enter. For the "string” option, twpe the string
to be eHcluded.

options
1l 1. A1l lines
2. ALl highlighted lines
3. All non-highlighted lines
d. ALl lines containing a string

Ftring

A line of dashes and text stating n LINE(S) NOT DISPLAYED represent excluded lines.
The Exclude action is valid on Source View and Tree View.
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Fields

Field Description

Options Specifies the lines to exclude from the screen display. These are the
valid options:

1. All Lines Excludes all lines from the screen
display. This is the default.
2. All Highlighted Lines Excludes all lines highlighted as the

result of one or more actions or
commands from the screen display.

3. All Non-highlighted Lines ~ Excludes all non-highlighted lines
from the screen display.

4. All Lines Containing a String Excludes all lines containing the string
specified in the String field. If this
Option is selected, the String field is
required.

String Required if Option 4 is selected. Type a string of alphanumeric or DBCS
characters. This field is ignored if any other Option is selected.
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This chapter describes items on the Insight Search menu and contains these sections:

Topic Page

Search Actions 62
Search Pull-down 65
Search - Data Name Pop-up 06
Search - Label Name Pop-up 70
Search - Paragraph Name Pop-up 72
Search - Pattern String Pop-up 75
Search - COBOL Subset Name Pop-up 78
Search - Perform Range Name Pop-up 81
Search - Program Name Pop-up 84
Search - User Mark Name Pop-up 86
Search - Line Range Pop-up 88
Search - Any/Unknown Type Pop-up 91
Search - Branch Request Pop-up 93
Branch Previous Options Pop-up 95
Selection List Pop-ups 96
IN-Clause Option Pop-up 97
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The Search facility enables you to find, highlight, scroll, print, punch, or exclude a
specified target. Depending on the value in the Action field and the current view screen,
these items can be a target:

. Dataname

. Label name

. Paragraph name

. Pattern

. COBOL subset

. Perform range

. Program

. User mark

. Line number

The Search facility has three different views to assist you in isolating, understanding, and
identifying important sections of the source program. The three views, the Source View,
Tree View, and Perform Structure View, are created from the same original COBOL
source program, but present a different perspective. These views are concurrently

available and synchronized with the other views. You can switch back and forth between
the views and retain the results of certain actions.

Search Actions

Find

62

Use the Find action to search the source code for one or all occurrences of the target. The
results are presented in these views:

View Description

Source View Positions the cursor at the first target in the specified
direction, highlights all occurrences found, and places tags
indicating the type of target found to the right of each
statement.

Tree View Positions the cursor at the first perform range containing the
target in a top/down manner, highlights all found
occurrences, and places tags indicating the type of target
found to the right of each statement.

Perform Structure View  Positions the cursor at the first perform range and highlights
all results found.




Highlight

Scroll

Print

4 Search

Use the Highlight action to highlight source code lines or boxes containing the specified
target. Previously highlighted lines or boxes remain unchanged. The results are presented
in these views:

View Description

Source View Positions the cursor at the first target in the specified
direction, highlights all occurrences found, and places tags
indicating the type of target found to the right of each
statement.

Tree View Positions the cursor at the first perform range containing the
target in a top/down manner, highlights all found
occurrences, and places tags indicating the type of target
found to the right of each statement.

Perform Structure View  Positions the cursor at the first perform range and highlights
all results found.

Use the Scroll action to position the screen to the line or box containing the target.
Previously highlighted lines or boxes remain unchanged. The results are presented in this
manner. The results for this action are the same in each view.

Note:

This action is valid only on the Search - Any/Unknown Type pop-up for Tree View and
Perform Structure View.

Use the Print action to copy lines or boxes containing the specified target to the List file
for subsequent processing. The results for this Action are the same in each view.

Note:

This action is valid only on the Search - Any/Unknown Type pop-up for Tree View and
Perform Structure View.
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Punch

Exclude
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Use the Punch action to copy lines or boxes containing the target to the Punch file for
subsequent processing. The results for this action are the same in each view.

Note:

This Action is valid only on the Search - Any/Unknown Type pop-up for Tree View and
Perform Structure View.

Use the Exclude action to exclude source code lines containing the target. The results are
presented in these views:

View Description

Source View Searches the source code for one or all occurrences of the
target and omits the resulting source code lines.

Tree View Searches the source code for one or all occurrences of the
target and omits the resulting lines.

Perform Structure View Searches the source code for one or all occurrences of the
target and positions the cursor to the first box containing an
excluded source code line.




Search Pull-down

Actions

4 Search

Use the Search pull-down shown in Figure 36 to conduct an intelligent source code
search for one or all occurrences of a specified target. This section describes the actions
available on the Search pull-down.

To display the Search pull-down, follow this step:

» Select Search on the action bar and press Enter.

Figure 36 » Search Pull-down

File Uiew

fearch Logic Task List Options Help

ComHand ===

. Data...

« Label...

. Paragrapha..
. FtFifga..

. Eubset...

o PEFFOFH. .

. Prograf... etttk etttk
. Hark...
o LimEa..
. ANYaas defeetdok beteteteh Hefok
. Branch...

grad Understanding

!

o
Ll e Rl R R B O

% i1s,

copyright Allen systeds Group, INC., an unpublished work.
A proprietary product of ASG, InC. Use pestricted to authorized 1icensess.
Vizit the AEG Zupport Mebk Zite at www.asg.cod

1. Data

Displays the Search - Data Name pop-up used to search for data items.

2. Label

Displays the Search - Label Name pop-up used to search for a specified
label name.

3. Paragraph

Displays the Search - Paragraph Name pop-up used to search for
statements in a paragraph.

4. String Displays the Search - Pattern String pop-up used to search for a
character string.

5. Subset Displays the Search - COBOL Subset Name pop-up used to search for
COBOL subsets.

6. Perform Displays the Search - Perform Range Name pop-up used to search for

statements within a perform range.
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Action Description

7. Program Displays the Search - Program Name pop-up used to search for
statements in subprograms.

8. Mark Displays the Search - User Mark Name pop-up used to search for
statements in a set of marked lines.

9. Line Displays the Search - Line Range pop-up used to search for statements
within line ranges.

10. Any Displays the Search - Any/Unknown Type pop-up used to search for
targets when the type is unknown.

11. Branch Displays the Search - Branch Request pop-up used to branch to a
specific location.

Search - Data Name Pop-up

To find, highlight, scroll, print, punch, or exclude datanames, depending on the value in
the Action field and the current view screen, follow this step:

» Select Search P Data and press Enter. The Search - Data Name pop-up, shown in
Figure 37, displays.

Figure 37 « Search - Data Name Pop-up

Search - Data Name

Type a data name and select search options. Then press Enter. For
a selection list, enter a pattern (e.g. ABC*) in the name area.
Data name
References Indirect impact Size change
1 1. All 1 1. None levels . . .

2. Defs 2. Of size change

3. Uses 3. Of value change

4. Mods
Direction Options Action
1 1. All _ No data aliasing 1 1. Find

2 Next _ IN-clause... 2. Highlight

3. Previous 3. Scroll

4 First 4. Print

5 Last 5. Punch

6. Exclude
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4 Search

Data name

Specifies a COBOL dataname or qualified COBOL dataname. A
dataname refers to any valid COBOL reference for a data element.

To display the Selection List pop-up, leave the Data Name field blank or
type a pattern with wildcard characters [question mark (?) for one
character; asterisk (*) for zero or more characters].

Note:
See "Selection List Pop-ups" on page 96 for more information.

Datanames can be concatenated by placing a plus sign (+) between the
datanames.

References

Restricts the search to only those datanames that are defined, used, or
modified, when you specify the type of dataname reference. These are the
valid references:

1. All  Includes occurrences of the dataname where its value is
defined, tested, used, set, or modified. This is the default.

2. Defs Includes definitions of the dataname in the DATA DIVISION.

3. Uses Includes occurrences of the dataname where its value is being
tested or used.

4. Mods Includes occurrences of the dataname where its value is being
set or modified.

Indirect
impact

Expands the search to include occurrences of datanames indirectly
affected by the specified dataname. These are the valid values:

1. None Includes only occurrences of the dataname where it
is directly tested, used, set, modified, or defined
(based on the value of the References field). This is
the default.

2. Of size change Includes datanames that could be directly or
indirectly affected if the size of the specified
dataname were to be changed.

3. Of value change Includes datanames that could be directly or
indirectly affected if the value of the specified
dataname were to be changed.
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Size change
levels

Identifies the depth of the indirect impact of a size change that is desired.
When this field is used, all references affected within the specified level
show. If left blank, all levels are searched

Direction Restricts the search to a specific direction or occurrence. These are the
valid values:

1. All Searches for all occurrences of the dataname and displays
the number found in the short/long message field. This is
the default.

2. Next Searches forward from a specified cursor position to the
next occurrence of the dataname. Next is valid on Source
View only.

3. Previous Searches backward from a specified cursor position to the
previous occurrence of the dataname. Previous is valid on
Source View only.

4. First Searches from the top of the source file to the first
occurrence of the dataname. First is valid on Source View
only.

5. Last Searches backward from the bottom of the source file to the
last occurrence of the dataname. Last is valid on Source
View only.

Options No Data Aliasing Specifies that aliases for the specified dataname are

ignored. If left blank, aliases of the dataname are
included. This is the default.

Aliases include:
Parent higher level group item
Child lower level item

Rename/Redefinition  renamed, redefined, or 88
level items

IN-clause Optional. If specified, displays the IN-Clause Option
pop-up used to restrict the source lines or boxes to be
considered for a search. If left blank, the entire source
code program is searched. The default is the entire
program. See "IN-Clause Option Pop-up" on page 97
for more information.




4 Search

Field Description

Action Optional. Specify the action to be performed on the dataname. These are
the valid values:

Note:

Results depend on the current view screen. See "Search Actions" on
page 62 for more information.

1. Find

2. Highlight

3. Scroll

3. Print

4. Punch

5. Exclude

Searches for one or all occurrences of the dataname.
Double Byte Character Set (DBCS) identifiers or patterns
can be specified to locate DBCS strings. Find is the default.

Highlights source code lines or boxes containing the
dataname. Lines or boxes already highlighted are not reset.

Positions the screen to the first line containing the
dataname. Previously highlighted lines remain unchanged.
Scroll is valid on Source View only.

Copies lines containing the dataname to the List file. The
List file is processed on the Options - Log/List/Punch
Definition pop-up. Print is valid on Source View only.

Copies lines containing the dataname to the Punch file. The
Punch file is processed on the Options - Log/List/Punch
Definition pop-up. Punch is valid on Source View only.

Omits source code lines containing occurrences of the
dataname from the display. In Perform Structure View, the
cursor is positioned to the first box representing a logical
program unit that contains an excluded source code line.
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Search - Label Name Pop-up

Use the Search - Label Name pop-up to find, highlight, scroll, print, punch, or exclude a
specified label name and all control transfers to that label name, depending on the value
in the Action field and the current view method.

To display the Search - Label Name pop-up, follow this step:

» Select Search P Label and press Enter. The Search - Label Name pop-up, shown in
Figure 38, displays.

Figure 38 « Search - Label Name Pop-up

Search - Label Name
To find label name references, type a name and select search
options. Then press Enter. For selection list, type a pattern

(e.g. ABC*) in the name area.

Label name

Direction Options Action
1 1. All _ IN-clause... 1 1. Find
2 Next 2. Highlight
3. Previous 3. Scroll
4 First 4. Print
5 Last 5. Punch
6. Exclude

Fields

Field Description

Label name  Required. Type any PROCEDURE DIVISION paragraph name or
section name. You can also specify the PROCEDURE and PROC
literals.

To display the Selection List pop-up, leave the Label Name field blank,
or enter a pattern with wildcard characters [question mark (?) for one
character; asterisk (*) for zero or more characters].

Note:
See "Selection List Pop-ups" on page 96 for more information.

Label names may be concatenated by placing a plus sign (+) between the
label names.
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Direction Restricts the search to a specific direction or occurrence. These are the
valid values:

1. All Searches for all occurrences of the label name and
displays the number found in the short/long message
field. This is the default.

2. Next Searches forward from a specified cursor position to the
next occurrence of the label name. Next is valid on
Source View only.

3. Previous Searches backward from a specified cursor position to
the previous occurrence of the label name. Previous is
valid on Source View only.

4. First Searches from the top of the source file to the first
occurrence of the label name. First is valid on Source
View only.

5. Last Searches backward from the bottom of the source file to
the last occurrence of the label name. Last is valid on
Source View only.

IN-clause Displays the IN-Clause Option pop-up used to restrict the source lines
or boxes to be considered for a search. If left blank, the entire source
code program is searched. The default is the entire program. See
"IN-Clause Option Pop-up" on page 97 for more information.

Action Specifies the action to be performed on the target. These are the valid

actions:

Note:

Results depend on the current view screen. See "Search Actions" on
page 62 for more information

1. Find Searches for one or all occurrences of the label name.
This is the default.

2. Highlight Highlights source code lines or boxes containing the
label name. Lines or boxes already highlighted are not
reset.

3. Scroll Positions the screen to the first line containing the label

name. Previously highlighted lines remain unchanged.
Scroll is valid on Source View only.
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Field Description

4. Print Copies lines containing the label name to the List file.
The List file is processed on the
Options - Log/List/Punch Definition pop-up. Print is
valid on Source View only.

5. Punch Copies lines containing the label name to the Punch file.
The Punch file is processed on the
Options - Log/List/Punch Definition pop-up. Punch is
valid on Source View only.

6. Exclude = Omits lines containing occurrences of the label name
from the display. In Perform Structure View, the cursor
is positioned to the first box representing a logical
program unit that contains an excluded source code line.

Search - Paragraph Name Pop-up

Use the Search - Paragraph Name pop-up to find, highlight, scroll, print, punch, or
exclude statements in a specified paragraph, depending on the value in the Action field
and the current view method.

To display Search - Paragraph Name pop-up, follow this step:

» Select Search » Paragraph and press Enter. The Search - Paragraph Name pop-up,
shown in Figure 39, displays.

Figure 39 » Search - Paragraph Name Pop-up

Search - Paragraph Name
To find all statements in a paragraph, type a name and select the
search options. Then press Enter. For a name list, type a pattern

(e.g. ABC*) in the name area.

Paragraph name

Direction Options Action
1 1. All _ IN-clause... 1 1. Find
2 Next 2. Highlight
3. Previous 3. Scroll
4 First 4. Print
5 Last 5. Punch
6. Exclude
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4 Search

Paragraph Name Specifies the name of the paragraph to search.

To display the Selection List pop-up, leave the Paragraph Name field
blank, or enter a pattern with wildcard characters [question mark (?)
for one character; asterisk (*) for zero or more characters].

Note:
See "Selection List Pop-ups" on page 96 for more information.

Paragraph names may be concatenated by placing a plus sign (+)
between the paragraph names.

Direction

Optional. The search can be restricted to a specific direction or
occurrence by specifying a direction. These are the valid values:

1. All Searches for all occurrences of the paragraph name
and displays the number found in the short/long
message field. This is the default.

2. Next Searches forward from a specified cursor position to
the next occurrence of the paragraph name. Next is
valid on Source View only.

3. Previous Searches backward from a specified cursor position to
the previous occurrence of the paragraph name.
Previous is valid on Source View only.

4. First Searches from the top of the source file to the first
occurrence of the paragraph name. First is valid on
Source View only.

5. Last Searches backward from the bottom of the source file
to the last occurrence of the paragraph name. Last is
valid on Source View only.

IN-clause

Displays the IN-Clause Option pop-up used to restrict the source
lines or boxes to be considered for a search.

If left blank, the entire source code program is searched. The default
is the entire program.

See "IN-Clause Option Pop-up" on page 97 for more information.
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Field Description

Action Specifies the action to be performed on the paragraph name. Results
depend on the current view screen. See "Search Actions" on page 62
for more information.

74

These are the valid values:

1. Find

2. Highlight

3. Scroll

4. Print

5. Punch

6. Exclude

Searches for one or all occurrences of the paragraph
name. This is the default.

Highlights source code lines or boxes containing the
paragraph name. Lines or boxes already highlighted
are not reset.

Positions the screen to the first line containing the
paragraph name. Previously highlighted lines remain
unchanged. Scroll is valid on Source View only.

Copies lines containing the paragraph name to the List
file. The List file is processed on the

Options - Log/List/Punch Definition pop-up. Print is
valid on Source View only.

Copies lines containing the paragraph name to the
Punch file. The Punch file is processed on the
Options - Log/List/Punch Definition pop-up. Punch is
valid on Source View only.

Omits lines containing occurrences of the paragraph
name from the display. In Perform Structure View, the
cursor is positioned to the first box representing a
logical program unit that contains an excluded source
code line.




Search - Pattern String Pop-up

Fields

4 Search

Use the Search - Pattern String pop-up to find, highlight, scroll, print, punch, or exclude a
pattern, depending on the value in the Action field and the current view method.

To display the Search - Pattern String pop-up, follow this step:

» Select Search P String and press Enter. The Search - Pattern String pop-up, shown in

Figure 40, displays.

Figure 40 » Search - Pattern String Pop-up

String

Search - Pattern String

Type a string and select search options.

Then press Enter.

String type
1 1. Simple

2. Hexadecimal

3. Text

4. Picture
Direction
1 1. All

2. Next

3. Previous

4. First

5. Last

Begin column

Location

1 1. Any
2. Word
3. Prefix
4. Suffix

Options

IN-clause...

End column

Action

1

AU WN

Find
Highlight
Scroll
Print
Punch
Exclude

Field Description

String Required. Specifies a string of alphanumeric or DBCS characters. It is
not necessary to enclose the string in single or double quotes. All
characters are used for the pattern search.

String type Specifies the type of pattern string. These are the valid values:

1. Simple

2. Hexadecimal

3. Text

Indicates a string that is not a hexadecimal, text, or a
picture string. This is the default.

Specific unprintable characters may be specified by
giving the EBCDIC hexadecimal value.

A character string may be entered regardless of
upper or lowercase by using the text option.
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Field Description

4. Picture You may enter a string profile instead of exact
characters. Insight defines nine special characters for
use in picture strings. You can combine these special
characters with other characters. These are the valid
special characters:

pP=' Any character

P Any non blank character
P Any non display character
P'# Any numeric character
p- Any character

P'‘@'  Any character

p< Any character

P> Any character

P'§' Any character

Location Specifies the location to search for the pattern string. These are the
valid values:

1. Any Specifies a string anywhere in the source code.

2. Word  Specifies a string preceded and followed by any
non-alphanumeric character (except hyphen).

3. Prefix  Specifies a word that begins with the specified string.

4. Suffix  Specifies a word that ends with the specified string.

Direction Restricts the search to a specific direction or occurrence. These are the
valid values:

1. All Searches for all occurrences of the string and displays the
number found in the short/long message field. This is the
default.

2. Next Searches forward from a specified cursor position to the
next occurrence of the string. Next is valid on Source
View only.

3. Previous Searches backward from a specified cursor position to
the previous occurrence of the string. Previous is valid on
Source View only.
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4. First Searches from the top of the source file to the first
occurrence of the string. First is valid on Source View
only.

5. Last Searches backward from the bottom of the source file to
the last occurrence of the string. Last is valid on Source
View only.

IN-clause Displays the IN-Clause Option pop-up used to restrict the source lines
or boxes to be considered for a search. If left blank, the entire source
code program is searched. The default is the entire program. See
"IN-Clause Option Pop-up" on page 97 for more information.

Action Specifies the action to be performed on the string. These are the valid
values:

Note:

Results depend on the current view screen. See "Search Actions" on
page 62 for more information.

1. Find Searches for one or all occurrences of the string. This is
the default.

2. Highlight Highlights source code lines or boxes containing the
string. Lines or boxes that are already highlighted are not
reset.

3. Scroll Positions the screen to the first line containing the string.
Previously highlighted lines remain unchanged. Scroll is
valid on Source View only.

4. Print Copies lines containing the string to the List file. The
List file is processed on the Options - Log/List/Punch
Definition pop-up. Print is valid on Source View only.

5. Punch Copies lines containing the string to the Punch file. The
Punch file is processed on the Options - Log/List/Punch
Definition pop-up. Punch is valid on Source View only.

6. Exclude  Omits lines containing occurrences of the string from the
display. In Perform Structure View, the cursor is
positioned to the first box representing a logical program
unit that contains an excluded source code line.
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Field Description

Begin column  Specifies the column number where the search is to begin. The default
is column 7.

End column Specifies the column number where the search is to end. The default is
column 66.

Search - COBOL Subset Name Pop-up
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Use the Search - COBOL Subset Name pop-up to find, highlight, scroll, print, punch, or
exclude statements in COBOL subsets, depending on the value in the Action field and the
current view method.

To display the Search - COBOL Subset Name pop-up, follow this step:

P Select Search » Subset and press Enter. The Search - COBOL Subset Name pop-up,
shown in Figure 41, displays.

Figure 41 » Search - COBOL Subset Name Pop-up

Search - COBOL Subset Name

Type a subset name and select search options. Then press Enter.
For a selection list, type a pattern (e.g. ABC*) in the name area.

Subset name

Direction Options Action

1 1. All IN-clause... 1 1. Find
2. Next - 2. Highlight
3. Previous 3. Scroll
4. First 4. Print
5. Last 5. Punch
6. Exclude




4 Search

Fields

Field Description

Subset name  Specifies the name of a predefined COBOL subset. Subsets can be
concatenated by placing a plus sign (+) between the subset names.

These are the predefined subsets:

ASsignment CAll Clcs

COBOLII COBOL/370  COMment
CON(ditional COPy DB2/SQL

DDL DEAD DEADCode
DEADData DEBug DEFinition
DIRective DIVision DL/1 | DL/1
DML ENtry EXIt | PGMEXxit
FALLthrough GOto IDMS

INClude Input 10

LABel MAINline MATH

Output PARagraph PERform
RETurn SECtion SORTMerge
STructure TESted UNTested
Note:

See the ASG-Insight User’s Guide for a description of each subset and
subset type.

A screen subset:

Highlighted | HI

NONHighlighted | NHI

Excluded | X

NONExcluded | NX

Tagged lines subsets of tags in columns 73 through 80.

To display the Selection List pop-up for subsets, leave the Subset name

field blank, or enter a pattern with wildcard characters [question mark
(?) for one character; asterisk (*) for zero or more characters].

See "Selection List Pop-ups" on page 96 for more information.
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Direction Restricts the search to a specific direction or occurrence. These are the
valid values:

1. All Searches for all occurrences of the subset and displays
the number found in the short/long message field. This is
the default.

2. Next Searches forward from a specified cursor position to the
next occurrence of the subset. Next is valid on Source
View only.

3. Previous  Searches backward from a specified cursor position to
the previous occurrence of the subset. Previous is valid
on Source View only.

4. First Searches from the top of the source file to the first
occurrence of the subset. First is valid on Source View
only.

5. Last Searches backward from the bottom of the source file to
the last occurrence of the subset. Last is valid on Source
View only.

IN-clause Displays the IN-Clause Option pop-up used to restrict the source lines
or boxes to be considered for a search. If left blank, the entire source
code program is searched. The default is the entire program.

See "IN-Clause Option Pop-up" on page 97 for more information.

Action Specifies the action to be performed on the subset. Results depend on the
current view screen. See "Search Actions" on page 62 for more
information. These are the valid actions:

1. Find Searches for one or all occurrences of the subset. This is
the default.

2. Highlight  Highlights source code lines or boxes containing the
subset. Lines or boxes already highlighted are not reset.

3. Scroll Positions the screen to the first line containing the subset.
Previously highlighted lines remain unchanged. Scroll is
valid on Source View only.

4. Print Copies lines containing the subset to the List file. The

List file is processed on the Options - Log/List/Punch
Definition pop-up. Print is valid on Source View only.
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Field Description

5. Punch Copies lines containing the subset to the Punch file. The
Punch file is processed on the Options - Log/List/Punch

Definition pop-up.

6. Exclude Omits lines containing occurrences of the subset from
the display. In Perform Structure View, the cursor is
positioned at the first box representing a logical program

unit that contains an excluded source code line.

Search - Perform Range Name Pop-up

Use the Search - Perform Range Name pop-up to find, highlight, scroll, print, punch, or
exclude statements in a perform range, depending on the value in the Action field and the

current view method.

To display the Search - Perform Range Name pop-up, follow this step:

P Select Search » Perform and press Enter. The Search - Perform Range Name pop-up,

shown in Figure 42, displays.

Figure 42 » Search - Perform Range Name Pop-up

Search - Perform Range Name

Type a perfrange name and select search options.
For a selection list, type a pattern (e.g. ABC*)

Perfrange name

Then press Enter.

in the name area.

Direction Options Action
1 1. All _  IN-clause... 1 1.
2 Next 2.

3. Previous 3.

4 First 4.

5 Last 5.

6.

Find
Highlight
Scroll
Print
Punch
Exclude
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Fields

Field Description

Perfrange Name Specifies the name in a PERFORM statement, or the name of any
section contained in the DECLARATIVES.

To display the Selection List pop-up, leave the Perfrange Name
field blank, or enter a pattern with wildcard characters [question
mark (?) for one character; asterisk (*) for zero or more
characters]. See "Selection List Pop-ups" on page 96 for more
information.

Direction Restricts the search to a specific direction or occurrence. These
are the valid values:

1. All Searches for all occurrences of the perform range
and displays the number found in the short/long
message field. This is the default.

2. Next Searches forward from a specified cursor position
to the next occurrence of the perform range. Next
is valid on Source View only.

3. Previous  Searches backward from a specified cursor
position to the previous occurrence of the perform
range. Previous is valid on Source View only.

4. First Searches from the top of the source file to the first
occurrence of the perform range. First is valid on
Source View only.

5. Last Searches backward from the bottom of the source
file to the last occurrence of the perform range.
Last is valid on Source View only.

IN-clause Displays the IN-Clause Option pop-up used to restrict the source
lines or boxes to be considered for a search. If left blank, the entire
source code program is searched. The default is the entire
program. See "IN-Clause Option Pop-up" on page 97 for more
information.
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Field Description

Action Specifies the action to be performed on the perform range. Results
depend on the current view screen. See "Search Actions" on
page 62 for more information. These are the valid actions:

1. Find

2. Highlight

3. Scroll

4. Print

5. Punch

6. Exclude

Searches for one or all occurrences of the perform
range. This is the default.

Highlights source code lines or boxes containing
the perform range. Lines or boxes already
highlighted are not reset.

Positions the screen to the first line containing the
perform range. Previously highlighted lines
remain unchanged. Scroll is valid on Source View
only.

Copies lines containing the perform range to the
List file. The List file is processed on the

Options - Log/List/Punch Definition pop-up. Print
is valid on Source View only.

Copies lines containing the perform range to the
Punch file. The Punch file is processed on the
Options - Log/List/Punch Definition pop-up.
Punch is valid on Source View only.

Omits lines containing occurrences of the perform
range from the display. In Perform Structure View,
the cursor is positioned to the first box
representing a logical program unit that contains
an excluded source code line.
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Search - Program Name Pop-up

Fields
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Use the Search - Program Name pop-up to find, highlight, scroll, print, punch, or exclude
statements in sub-programs, depending on the value in the Action field and the current
view method.

To display the Search - Program Name pop-up, follow this step:

» Select Search P Program and press Enter. The Search - Program Name pop-up, shown
in Figure 43, displays.

Figure 43 » Search - Program Name Pop-up

Search - Program Name
Type a (sub)program name and select search options. Then press
Enter. For a selection list, type a pattern (e.g. ABC*) in the name

area.

Program name

Direction Options Action
1 1. All _  IN-clause... 1 1. Find
2 Next 2. Highlight
3. Previous 3. Scroll
4 First 4. Print
5 Last 5. Punch
6. Exclude
Field Description
Program name Specifies the name of the main program or any nested program.

To display the Selection List pop-up, leave the Program name field
blank, or enter a pattern with wildcard characters [question mark (?)
for one character; asterisk (*) for zero or more characters]. See
"Selection List Pop-ups" on page 96 for more information.

Program names may be concatenated by placing a plus sign (+)
between the program names.

Direction Restricts the search to a specific direction or occurrence. These are
the valid values:

1. All Searches for all occurrences of the program name
and displays the number found in the short/long
message field. This is the default.

2. Next Searches forward from a specified cursor position to
the next occurrence of the program name. Next is
valid on Source View only.




4 Search

Field Description

3. Previous

4. First

5. Last

Searches backward from a specified cursor position
to the previous occurrence of the program name.
Previous is valid on Source View only.

Searches from the top of the source file to the first
occurrence of the program name. First is valid on
Source View only.

Searches backward from the bottom of the source
file to the last occurrence of the program name. Last
is valid on Source View only.

IN-clause Displays the IN-Clause Option pop-up used to restrict the source
lines or boxes to be considered for a search. If left blank, the entire
source code program is searched.

The default is the entire program. See "IN-Clause Option Pop-up" on
page 97 for more information.

Action Specifies the action to be performed on the program name. Results
depend on the current view screen. See "Search Actions" on page 62
for more information. These are the valid actions:

1. Find

2. Highlight

3. Scroll

4. Print

Searches for one or all occurrences of the program
name. This is the default.

Highlights source code lines or boxes containing the
program name. Lines or boxes already highlighted
are not reset.

Positions the screen to the first line containing the
program name. Previously highlighted lines remain
unchanged. Scroll is valid on Source View only.

Copies lines containing the specified target to the
List file. The List file the Options - Log/List/Punch
Definition pop-up. Print is valid on Source View
only.
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Field Description

5. Punch Copies lines containing the specified target to the
Punch file. The Punch file is processed on the
Options - Log/List/Punch Definition pop-up. Punch
is valid on Source View only.

6. Exclude Omits lines containing occurrences of the program
name from the display. In Perform Structure View,
the cursor is positioned to the first box representing
a logical program unit that contains an excluded
source code line.

Search - User Mark Name Pop-up
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Use the Search - User Mark Name pop-up to find, highlight, scroll, print, punch, or
exclude sets of marked lines, depending on the value in the Action field and the current
view method.

To display the Search - User Mark Name pop-up, follow this step:

P Select Search » Mark and press Enter. The Search - User Mark Name pop-up, shown
in Figure 44, displays.

Figure 44 » Search - User Mark Name Pop-up

Search - User Mark Name

Type a mark name and select search options. Then press Enter. For
a selection list, type a pattern (e.g. ABC*) in the name area.

Mark name

Direction Options Action
1 1. All _ IN-clause... 1 1. Find
2 Next 2. Highlight
3. Previous 3. Scroll
4 First 4. Print
5 Last 5. Punch
6. Exclude




Fields

4 Search

Mark name  Specifies a 1 to 10 alphanumeric character name given to a set or path.
To display the Selection List pop-up, leave the Mark Name field blank or
enter a pattern with wildcard characters [question mark (?) for one
character; asterisk (*) for zero or more characters].

See "Selection List Pop-ups" on page 96 for more information.

Direction Restricts the search to a specific direction or occurrence. These are the
valid values:

1. All Searches for all occurrences of the mark name and displays
the number found in the short/long message field. This is
the default.

2. Next Searches forward from a specified cursor position to the
next occurrence of the mark name. Next is valid on Source
View only.

3. Previous Searches backward from a specified cursor position to the
previous occurrence of the mark name. Previous is valid on
Source View only.

4. First Searches from the top of the source file to the first
occurrence of the mark name. First is valid on Source View
only.

5. Last Searches backward from the bottom of the source file to the
last occurrence of the mark name. Last is valid on Source
View only.

IN-clause Displays the IN-Clause Option pop-up used to restrict the source lines or
boxes to be considered for a search. If left blank, the entire source code
program is searched. The default is the entire program. See "IN-Clause
Option Pop-up" on page 97 for more information.

Action Specifies the action to be performed on the mark name. Results depend

on the current view screen. See "Search Actions" on page 62 for more
information. These are the valid actions:

1. Find Searches for one or all occurrences of the mark name.
This is the default.

2. Highlight  Highlights source code lines or boxes containing the
mark name. Lines or boxes already highlighted are not
reset.
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Field Description

3. Scroll

4. Print

5. Punch

6. Exclude

Positions the screen to the first line containing the mark
name. Previously highlighted lines remain unchanged.
Scroll is valid on Source View only.

Copies lines containing the mark name to the List file.
The List file is processed on the

Options - Log/List/Punch Definition pop-up. Print is
valid on Source View only.

Copies lines containing the mark name to the Punch file.
The Punch file is processed on the

Options - Log/List/Punch Definition pop-up. Punch is
valid on Source View only.

Omits lines containing occurrences of the mark name
from the display. In Perform Structure View, the cursor
is positioned to the first box representing a logical
program unit that contains an excluded source code line.

Search - Line Range Pop-up
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Use the Search - Line Range pop-up to find, highlight, scroll, print, punch, or exclude a
single line or range of lines, depending on the value in the Action field and the current

view method.

To display the Search - Line Range pop-up, follow this step:

P Select Search P Line and press Enter. The Search - Line Range pop-up, shown in

Figure 45, displays.

Figure 45 » Search - Line Range Pop-up

Search - Line Range

Type a line range (or line) and select search options. Then press

Enter.

Line range

Direction Options Action
1 1. All _ IN-clause... 1 1. Find
2 Next 2. Highlight
3. Previous 3. Scroll
4 First 4. Print
5 Last 5. Punch
6. Exclude




Fields

4 Search

Field Description

Line Range Specifies a single line number or range of lines. Line numbers display
in columns 1 through 6 of the Source View.

Direction Restricts the search to a specific direction or occurrence. These are the

valid values:

1. All

2. Next

3. Previous

4. First

5. Last

Searches for all occurrences of the line range and
displays the number found in the short/long message
field. This is the default.

Searches forward from a specified cursor position to the
next occurrence of the line range. Next is valid on Source
View only.

Searches backward from a specified cursor position to
the previous occurrence of the line range. Previous is
valid on Source View only.

Searches from the top of the source file to the first
occurrence of the line range. First is valid on Source
View only.

Searches backward from the bottom of the source file to
the last occurrence of the line range. Last is valid on
Source View only.

IN-clause Displays the IN-Clause Option pop-up used to restrict the source lines
or boxes to be considered for a search. If left blank, the entire source
code program is searched. The default is the entire program. See
"IN-Clause Option Pop-up" on page 97 for more information.

Action Specifies the action to be performed on the line range. These are the

valid actions:
1. Find

2. Highlight

Searches for one or all occurrences of the line range.
This is the default.

Highlights source code lines or boxes containing the
line range. Lines or boxes already highlighted are not
reset.
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Field Description
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3. Scroll

4. Print

5. Punch

6. Exclude

Positions the screen to the first line containing the line
range. Previously highlighted lines remain unchanged.
Scroll is valid on Source View only.

Copies lines containing the line range to the List file.
The List file is processed on the

Options - Log/List/Punch Definition pop-up. Print is
valid on Source View only.

Copies lines containing the line range to the Punch file.
The Punch file is processed on the

Options - Log/List/Punch Definition pop-up. Punch is
valid on Source View only.

Omits lines containing occurrences of the line range
from the display. In Perform Structure View, the
cursor is positioned to the first box representing a
logical program unit that contains an excluded source
code line.

Results depend on the current view screen. See "Search Actions" on
page 62 for more information.




4 Search

Search - Any/Unknown Type Pop-up

Fields

Use the Search - Any/Unknown Type pop-up to find, highlight, scroll, print, punch, or
exclude targets when the type is unknown, does not fit one of the predefined categories,
or is a combination of predefined categories.

To display the Search - Any/Unknown Type pop-up, follow this step:

» Select Search » Any and press Enter. The Search - Any/Unknown Type pop-up, shown
in Figure 46, displays.

Figure 46 » Search - Any/Unknown Type Pop-up

Search - Any/Unknown Type

To find references to a target of "unknown" type (data, label,
etc.), type the target and select search options. Then press Enter

Target

Direction Options Action
1 1. All _  IN-clause... 1
2 Next
3. Previous
4 First
5 Last

Find
Highlight
Scroll
Print
Punch
Exclude

Field Description

Target Specifies the name of the target. Target names can be concatenated by
placing a plus sign (+) between them. To reuse the target of the previous
search, type an asterisk (*) in the Target field.

Ul WN

For COBOL II Release 3 or later programs, a dataname that may be
ambiguous or used multiple times can be qualified by using OF followed by
the program name.

Direction  Indicates the direction for the search. These are the valid values:

1. All Searches for all occurrences of the target and displays the
number found in the short/long message field. This is the
default.

2. Next Searches forward from a specified cursor position to the

next occurrence of the target.

3. Previous Searches backward from a specified cursor position to the
previous occurrence of the target.
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Field Description
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4. First

5. Last

Searches from the top of the source file to the first
occurrence of the target.

Searches backward from the bottom of the source file to the
last occurrence of the target.

IN-clause  Displays the IN-Clause Option pop-up used to restrict the source lines or
boxes to be considered for a search. If left blank, the entire source code
program is searched. The default is the entire program. See "IN-Clause
Option Pop-up" on page 97 for more information.

Action Specifies the action to be performed on the target. Results depend on the
current view screen. See "Search Actions" on page 62 for more
information. These are the valid actions:

1. Find

2. Highlight

3. Scroll

4. Print

5. Punch

6. Exclude

Searches for one or all occurrences of the specified
target.

Highlights source code lines or boxes containing the
specified targets. Lines or boxes already highlighted are
not reset.

Positions the screen to the first line or box containing the
specified target. Previously highlighted lines or boxes
remain unchanged.

Copies lines or boxes containing the specified target to
the List file. The List file is processed on the
Options - Log/List/Punch Definition pop-up.

Copies lines or boxes containing the specified target to
the Punch file for subsequent processing. The Punch file
is processed on the Options - Log/List/Punch Definition

pop-up.

Omits lines containing occurrences of the target from the
display.




4 Search

Search - Branch Request Pop-up

To position the cursor at the target on the Source View screen, follow this step:

» Select Search P Branch and press Enter. The Search - Branch Request pop-up, shown
in Figure 47, displays.

Figure 47 » Search - Branch Request Pop-up

Search - Branch Request

To branch to another area of the program, select the Option desired
For Option 1, type the branch location (Target) information. Then

press Enter. For a name selection list (for Target type 2, 3 or 4),
type a pattern (e.g. ABC*) in the name field.

Option
1 1. Branch to target
2. Return to previous "Branch to target" location
3. Branch to transfer(s) of control to cursor position

Target name

Target type

1 1. None - use cursor
2. Label name
3. Perfrange name
4. Program name

Field Description

Fields

Option Specifies the type of branch to perform. These are the valid options:
Branch to target Positions the cursor to the name specified in the Target name field. If
you select this Option, the Target name field is required. This is the
default.

Return to branch Positions the cursor to the statement from where the previous branch
location occurred.

Display all Redisplays the Source View screen with a long message telling you to

transfers of control  position the cursor to the desired branch location and press Enter. The

to cursor position  cursor is positioned to the statement that branches to the specified
branch location.

If more than one statement transfers control to the specified branch
location, the Branch Previous Options pop-up displays allowing you to
select the desired statement.

If this Option is selected, the Target name and Target type fields are
invalid.
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Target name

Required if Option 1 is selected. Type a Perform Range name, label
name, paragraph name, or section name. For COBOL II Release 3 or
later programs, you can also enter a subprogram name.

For Perform Ranges and label names, if the specified name is not fully
qualified and there are multiple Perform Ranges or labels with the
specified name, the cursor is positioned on the first statement found.

For COBOL II Release 3 or later programs, a data item, label or
program name that may be ambiguous or used multiple times can be
qualified by using OF followed by the program name.

To display the Selection List pop-up, leave the Target name blank or
enter a pattern with wildcard characters [question mark (?) for one
character; asterisk (*) for zero or more characters], and select Target
type 2, 3, or 4. On the Selection List pop-up, select the desired name by
typing S next to the desired name. See "Selection List Pop-ups" on
page 96 for more information.

Target type

None - Use Cursor

Label Name

Perfrange Name

Subprogram Name

Specifies the number of the target type corresponding to the entry in the
Target name field. This field is valid for Option 1 only. These are the
valid target types:

Redisplays the Source View screen with a long message stating to
position the cursor to the selected statement and press Enter. This is the
default.

If the statement is a GO TO, PERFORM, or internal CALL, the cursor
is positioned to the target of that statement. If you select any other
statement type, the cursor is positioned to the next sequential statement
to be executed. The PROCEDURE DIVISION label is located if the
cursor is positioned outside the PROCEDURE DIVISION

Positions the cursor to the specified paragraph or section name. If the
specified name is not fully qualified and there are multiple paragraphs
or sections with the specified name, the cursor is positioned to the first
paragraph or section found.

Positions the cursor to the specified Perform Range. If the specified
name is not fully qualified and there are multiple Perform Ranges with
the specified name, the cursor is positioned to the first Perform Range
found.

Positions the cursor to the specified nested program. For COBOL 11
Release 3 and later programs, a data item, label, or program name that
may be ambiguous or used multiple times can be qualified by using OF
followed by the program name.
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Branch Previous Options Pop-up

Fields

To select a statement for branching, follow this step:

» Type BRANCH PREVIOUS. This pop-up displays when more than one statement
transfers control to the specified branch location on the Search - Branch Request
pop-up. The Branch Previous Options pop-up, shown in Figure 48, displays.

Figure 48 « Branch Previous Options Pop-up

Branch Previous Options LINE 1 OF 3
Command ===> Scroll ===> CSR

Select the statement to be viewed. Then press Enter.

S Line Source statement.

_ 000300 PERFORM P999-ABEND-PROGRAM.

_ 000302 PERFORM P999-ABEND-PROGRAM.
000448 PERFORM P999-ABEND-PROGRAM

Tk ok kK ok Kk K kK R Kk kK R Kk Kk Kk KR K K R K K K BOTTOM OF DATA * % % k% % % %k % o % % % % % % % % % % *k % % % %

When this pop-up first displays, the short message field indicates the number of
statements found.

Field Description

Line command area The area to the left of the Line field, which accepts the S line
command. Type S to select the identified source statement
and to position the cursor to that statement on the Source
View screen.

Line Specifies the source statement line number.

Source statement Specifies the source code statement.
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Selection List Pop-ups
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To display the Selection List pop-up

1

Leave the name field blank.
Or

Enter a pattern with wildcard characters [question mark (?) for one character;
asterisk (*) for zero or more characters] in the name field. The Selection List
pop-up, shown in Figure 49, displays.(The selection list pop-ups are the same
except for the type of list displayed.)

Selection list pop-ups are available for the data, perform range, paragraph, program,
mark, subset, and branch searches.

Figure 49  Selection List - Data Names Pop-up

Selection List - Data Names
Command ===> Scroll ===> CSR

S Data name
ABEND-CODE
ADDRESS1
AREA-CODE
AVG-AMT (DEAD)
BILLING-DAYS
CHECK-CODE (DEAD)
CITY

CLIENT-ID
CONSOLE
CUR-PREFIX
CURRENT-ZIP-DATA
CUSTOMER-ID
DBA-DEPT-CODE
DEBUG-PARM
DET-ADDRESS
DET-AREA-CODE
DET-BILLING-DAYS

Select a name from the list by typing S in the line command area. You can select
more than one name on these pop-ups:

. Selection List - Data Names

. Selection List - Label/Paragraph Names
. Selection List - Subset Names

. Selection List - Program Names

Press Enter to redisplay the Search pop-up with the selected name(s) in the
appropriate field.



IN-Clause Option Pop-up

Fields

To restrict the source lines considered for a search, follow this step:

4 Search

» Specify the IN-clause option on a Search pop-up. The IN-Clause Option pop-up, shown

in Figure 50, displays.

Figure 50 « IN-Clause Option Pop-up

IN-Clause Option

To restrict the source lines to be considered, type one or more
IN-Clause names. Then press Enter. For a selection list, type a
pattern in the appropriate name field.

Line range

Subset name . . .

Paragraph Name

Perfrange name

Program name

User MARK name

4 First Print
5 Last Punch
Exclude

Field Description

Line range

Specifies a single line number or range of lines.

Subset name
valid subsets:

Specifies a predefined COBOL language subset name. These are the

ASsignment CAll Clcs
COBOLII COBOL/370 COMment
CON(ditional COPy DB2/SQL
DDL DEAD DEADCode
DEADData DEBug DEFinition
DIRective DIVision DL/T | DL/1
DML ENtry EXIt | PGMEXxit
FALLthrough GOto IDMS
INClude Input 10

LABel MAINIline MATH
Output PARagraph ~ PERform
RETurn SECtion SORTMerge
STructure TESted UNTested
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Usage Notes
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Field Description

Note:

See the ASG-Insight User’s Guide for a description of each subset
and subset type

A screen subset:

Highlighted | HI

NONHighlighted | NHI

Excluded | X

NONExcluded | NX

Tagged lines subsets of tags in columns 73 through 80.

Paragraph Specifiesa PROCEDURE DIVISION paragraph or section name. The
Name PROCEDURE and PROC literals can also be specified.

Perfrange name Optional. Type the name specified in a PERFORM statement or the
name of any section contained in the DECLARATIVES. The search
includes all statements executed as a result of the PERFORM
statement.

Program name  Optional. Type the name of the main program or any nested program.
The search includes all code contained in the program, including all
programs physically nested inside the specified program.

In most cases, you may specify any combination of IN-clause options. However, some
Insight-defined mark names are incompatible with other logical sets of COBOL
statements and the combinations are not allowed.

All fields on this pop-up are optional. If all fields are left blank, the search is not restricted
(i.e., the entire program is searched).



Logic

This chapter describes items on the Insight Logic menu and contains these sections:

Topic Page

Logic Pull-down 101
Logic Order Search - Data Name Pop-up 102
Logic Order Search - Label Name Pop-up 105
Logic Order Search - COBOL Subset Name Pop-up 107
Logic Order Search - Perform Range Name Pop-up 110
Logic Order Search - User Mark Name Pop-up 112
Logic Order Search - Subprogram Name Pop-up 114
Logic Order Search - Line Number Range Pop-up 116
Selection List Pop-ups 118
Logic Order Search - Trace IN-Clause Option Pop-up 119

The Logic facility is a convenient way to view paths in logical execution order, and to see
how and where specific information is used. The logic order search displays results in
these three ways:

. Show references only- highlights the targets on the path from the starting point to
where the logic order search ends. For example, if the target is Data name and Uses
is selected for References with Forward as the Direction, the highlighted result
would be all the COBOL source statements where a USE of this dataname exists
and are reachable in execution order from the starting point.
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Show execution path(s) from starting point to reference(s) - highlights all
executable statements on the path from the starting point to where the logic order
search ends. This path of executable statements from the starting point to each of
the resulting targets is retained in a path named NETWORK. NETWORK has all
the paths that take you from the starting point of the logic order search to all the
results. The parts of NETWORK that go to the individual results are labeled
SUBNET] through SUBNETn, where n is the number of results that were found.

A new NETWORK is created each time you use this Action. Use the Scratchpad
pop-ups or the MARK command to copy and save a NETWORK.

You can use saved paths for additional analysis when they are used as targets for
other Source View searches or commands.

Trace (single-step) - stops at each conditional statement on the path from the
starting point to the target of the search. A message indicates the reason for
stopping. For a decision point, the line number where the trace function stopped and
the line number to with continue are shown.

All executable statements in the path between a decision and a new decision point
are highlighted. This path of executable statements is retained in a path named
TRACK. A new TRACK is created each time this Action is used. The Scratchpad
pop-ups or MARK command can be used to copy and save a TRACK.

This table contains information tags displayed in columns 73 through 80 for each
highlighted line:

DECISION Specifies the decision point.

STOP PNT Specifies the intermediate (informational) stopping point.
START Specifies the beginning of the trace function.

OPTION n Specifies the option choice.

TARGET Specifies the destination of the trace function.

Multiple information tags on a line are separated with a forward slash (/).



Logic Pull-down

Actions

5 Logic

To follow program execution or search for a specified target, follow this step:

» Select Logic on the action bar and press Enter. The Logic pull-down, shown in
Figure 51, displays.

Figure 51 » Logic Pull-down

File Uiew 3Zearch Logic Task List oOptions Help

_ 1. Data... nderstanding
CoHHand ===3 i 2. Label...
3. Zubset...
Aottt d. PerforH...
Hettnietk S. Hark...
Hetetetok B. PrOgraH... detetetek
etttk To LiNEaas Hebetekk
sheetstoh ebetstok ebtsebh debobick etk
shetededek shetededek etdedeth deteteich etk
Hetotobok
etttk

Copyright ALlen $ystens Group, IncC., an unpublished wark.
A proprietary product of ASG, Inc. Use restricted to authorized licensees.
Visit the ASG Support Web Site at wuN.asq.coH

1. Data Displays the Logic Order Search - Data Name pop-up used to follow
program logic to a specific dataname.

2. Label Displays the Logic Order Search - Label Name pop-up used to follow
program logic to a specific label name.

3. Subset Displays the Logic Order Search - COBOL Subset Name pop-up used
to follow program logic to a COBOL subset.

4. Perform Displays the Logic Order Search - Perform Range Name pop-up used
to follow program logic within a perform range.

5. Mark Displays the Logic Order Search - User Mark Name pop-up used to

follow program logic within a marked set of lines.
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Action Description

6. Program Displays the Logic Order Search - Subprogram Name pop-up used to
follow program logic in subprograms.

7. Line Displays the Logic Order Search - Line Number Range pop-up used
to follow program logic within ranges of lines.

Logic Order Search - Data Name Pop-up

To follow program logic to a specific dataname, follow this step:

» Select Logic » Data and press Enter. The Logic Order Search - Data pop-up, shown in
Figure 52, displays.

Figure 52 » Logic Order Search - Data Name Pop-up

Logic Order Search - Data Name

To find data name references in execution order, type the name and
starting point, and select search options. Then press Enter. For a
data or label name selection list, type a pattern (e.g. ABC*) in the
appropriate input area.

Data name

Start line/label (if any)

References Direction Options
1 1. All 1 1. Next _ Trace
2. Uses only 2 Previous IN-clause...
3. Mods only 3. Forward (all)
4 Backward (all)

Action

1 1. Show data name reference(s)
2. Show execution path(s) from starting point to reference(s)
3. Trace (single-step) from starting point to reference (s)
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5 Logic

Data name

Specifies a COBOL dataname or qualified COBOL dataname.
Dataname refers to any valid COBOL reference for a data element.

To display the Selection List pop-up, leave the Data name field blank
or enter a pattern with wildcard characters [question mark (?) for one
character; asterisk (*) for zero or more characters].

See "Selection List Pop-ups" on page 118 for more information.

Start line/label

Specifies the line number or label name from where to begin the
search.

To use cursor position for the beginning of the search, leave this field
blank. A message prompting you to verify cursor position displays.

To display the Selection List pop-up, enter a pattern with wildcard
characters [question mark (?) for one character; asterisk (*) for zero or
more characters].

See "Selection List Pop-ups" on page 118 for more information.

References

Restricts the trace to only those datanames that are defined, used, or
modified, by specifying the type of dataname references. These are the
valid values:

1. All Includes occurrences of the dataname where its value
is defined, tested, used, set, or modified. This is the
default.

2. Uses only Includes occurrences of the dataname where its value
is being tested or used.

3. Mods only Includes occurrences of the dataname where its value
is being set or modified.

Direction

Optional. The logical search can be restricted to a specific direction or
occurrence by specifying a direction. These are the valid values:

1. Next Searches or traces forward from the starting point to the
next occurrence of the target in each execution path.
This is the default.

2. Previous  Searches or traces backward from the starting point to
the previous occurrence of the target in each execution
path.

3. Forward  Searches or traces forward from the starting point to all
occurrences of the target.

4. Backward Searches or traces backward from the starting point to
all occurrences of the target.
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Direction Description

Trace IN-Clause Displays the Logic Order Search - Trace IN-Clause Option pop-up to
narrow the scope of the logic order trace to a specified perform range
or marked set of lines. If not specified, the scope includes the entire
program. You can only use this option if you selected number 3 for
Action. The default is the entire program is used for the trace.

See "Logic Order Search - Trace IN-Clause Option Pop-up" on
page 119 for more information.

Action Specifies how to display the results logic order search results. These
are the valid actions:

1. Show Data Name Reference(s)

Highlights only the datanames on the path from the starting point
to where the logic order search ends. This is the default.

2. Show Execution Path(s) from Starting Point to Reference(s)

All executable statements on the path from the starting point to
where the logic order search stops are highlighted.

3. Trace (single-step) from Starting Point to Reference(s)

The logic order search stops at all conditional statements on the
path from the starting point to the target of the search.
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Logic Order Search - Label Name Pop-up

To follow program logic to a specific label name, follow this step:

» Select Logic » Label and press Enter. The Logic Order Search - Label Name pop-up,
shown on Figure 53 on page 105, displays.

Figure 53 * Logic Order Search - Label Name Pop-up

Logic Order Search - Label Name

To find label references in execution order, type the label and
starting point, and select search options. Then press Enter. For a
label name selection list, type a pattern (e.g. ABC*) in the
appropriate input area.

Label name

Start line/label (if any)

Direction Options

1 1. Next _ Trace IN-clause...
2. Previous
3. Forward (all)
4. Backward (all)

Action
1 1. Show label name reference(s)
2. Show execution path(s) from starting point to reference(s)
3. Trace (single-step) from starting point to reference (s)
Fields
Field Description
Label name Specifies any PROCEDURE DIVISION paragraph name or section
name. The PROCEDURE and PROC literals can also be specified.
To display the Selection List pop-up, leave the Label name field
blank or enter a pattern with wildcard characters [question mark (?)
for one character; asterisk (*) for zero or more characters].
See "Selection List Pop-ups" on page 118 for more information.
Start line/label Specifies the line number or label name from where to begin the

trace.

To use cursor position for the beginning of the search, leave this
field blank. A message prompting you to verify cursor position
displays.

To display the Selection List pop-up, enter a pattern with wildcard
characters [question mark (?) for one character; asterisk (*) for zero
or more characters].

See "Selection List Pop-ups" on page 118 for more information.
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Direction

Restricts the logical search to a specific direction or occurrence.
These are the valid values:

1. Next Searches or traces forward from the cursor position
to the next occurrence of the target. This is the
default.

2. Previous  Searches or traces backward from the cursor position
to the previous occurrence of the target.

3. Forward  Searches or traces forward from the cursor position
to all occurrences of the target.

4. Backward Searches or traces backward from the cursor position
to all occurrences of the target.

Trace IN-clause

Displays the Logic Order Search - Trace IN-Clause Option pop-up
to narrow the scope of the logic order search to a specified perform
range or marked set of lines. If not specified, the scope includes the
entire program. This option can only be used if number 3 is selected
for Action. The default is the entire program is used for the trace.

See "Logic Order Search - Trace IN-Clause Option Pop-up" on
page 119 for more information.

Action

Specifies how to display the results of the logic order search. These
are the valid actions:

1. Show Label Name Reference(s)

Only the targets on the path from the starting point to where the
logic order search ends are highlighted. This is the default.

2. Show Execution Path(s) from Starting Point to Reference(s)

All executable statements on the path from the starting point to
where the logic order search stops are highlighted.

3. Trace (single-step) from Starting Point to Reference(s)

The logic order search stops at all conditional statements on the
path from the starting point to the target of the search.
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Logic Order Search - COBOL Subset Name Pop-up

Fields

To follow program logic to a COBOL subset, follow this step:

» Select Logic » Subset and press Enter. The Logic Order Search - COBOL Subset Name

pop-up, shown in Figure 54, displays.

Figure 54 « Logic Order Search - COBOL Subset Name Pop-up

Logic Order Search - COBOL Subset Name

ABC*) in the appropriate input area.

Subset name

To find subset references in execution order, type the subset name
and starting point, and select search options. Then press Enter.
For a subset or label name selection list, type a pattern (e.g.

Start line/label (if any)

Direction

1 1. Next
2. Previous
3. Forward (all)
4. Backward (all)

Options
_ Trace IN-clause...

Action
1 1. Show subset name reference(s)

2. Show execution path(s) from starting point to reference (s)
3. Trace (single-step) from starting point to reference (s)

Field Description

Subset name

subsets:

ASsignment CAll
COBOLII COBOL/370
CONditional COPy
DDL DEAD
DEADData DEBug
DIRective DIVision
DML ENtry
FALLthrough GOto
INClude Input
LABel MAINIine
Output PARagraph

Specifies the name of a predefined COBOL subset. These are the valid

Clcs
COMment
DB2/SQL
DEADCode
DEFinition
DL/ | DL/1
EXIt | PGMExit
IDMS

10

MATH
PERform
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Field Description
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RETurn

STructure

Note:

SECtion SORTMerge
TESted UNTested

See the ASG-Insight User’s Guide for a description of each subset and

subset type.

These are the screen subsets:

Highlighted | HI
NONHighlighted | NHI

Excluded | X

NONExcluded | NX
Tagged lines subsets of tags in columns 73 through 80.

To display the Selection List pop-up for subsets, leave the Subset name
field blank, or enter a pattern with wildcard characters [question mark
(?) for one character; asterisk (*) for zero or more characters].

See "Selection List Pop-ups" on page 118 for more information.

Start Specifies the line number or label name to begin the trace.

line/label

To use cursor position for the beginning of the search, leave this field

blank. A message prompting you to verify cursor position displays.

To display the Selection List pop-up, enter a pattern with wildcard
characters [question mark (?) for one character; asterisk (*) for zero or
more characters].

See "Selection List Pop-ups" on page 118 for more information.

Direction Restricts the logical search to a specific direction or occurrence by
specifying a direction. These are the valid values:

1. Next

2. Previous

3. Forward

4. Backward

Searches or traces forward from the cursor position to the
next occurrence of the target. This is the default.

Searches or traces backward from the cursor position to
the previous occurrence of the target.

Searches or traces forward from the cursor position to all
occurrences of the target.

Searches or traces backward from the cursor position to
all occurrences of the target.
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Field Description

Trace Displays the Logic Order Search - Trace IN-Clause Option pop-up to

IN-clause narrow the scope of the logic order search to a specified perform range
or marked set of lines. If not specified, the scope includes the entire
program. This option can only be used if number 3 is selected for Action.
The default is the entire program is used for the trace.

See "Logic Order Search - Trace IN-Clause Option Pop-up" on page 119
for more information.

Action Specifies how to display the logic order search results. These are the
valid actions:

1. Show Subset Name References

Only the targets on the path from the starting point to where the logic
order search ends are highlighted.

2. Show Execution Path(s) from Starting Point to Reference(s)

All executable statements on the path from the starting point to where
the logic order search stops are highlighted.

3. Trace (single-step) from Starting Point to Reference(s)

The logic order search stops at all executable statements on the path
from the starting point to where the search ends.
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Logic Order Search - Perform Range Name Pop-up

To follow program logic within a perform range, follow this step:

» Select Logic » Perform and press Enter. The Logic Order Search - Perform Range
Name pop-up, shown in Figure 55, displays.

Figure 55 » Logic Order Search - Perform Range Name Pop-up

Logic Order Search - Perform Range Name

To find "perform range" references in execution order, type the name
and starting point, and select search options. Then press Enter.
For a perform range or label name selection list, type a pattern
(e.g. ABC*) in the appropriate input area.

Perfrange name

Start line/label (if any)

Direction Options

1 1. Next _ Trace IN-clause...
2. Previous
3. Forward (all)
4. Backward (all))

Action

1 1. Show perfrange name reference(s)
2. Show execution path(s) from starting point to reference (s)
3. Trace (single-step) from starting point to reference(s)

Field Description

Perfrange name Specifies the name in a PERFORM statement or the name of any
section contained in the DECLARATIVES.

Fields

To display the Selection List pop-up, leave the Perfrange Name field
blank or enter a pattern with wildcard characters [question mark (?)
for one character; asterisk (*) for zero or more characters].

See "Selection List Pop-ups" on page 118 for more information.

Start line/label ~ Specifies the line number or label name to begin the trace.

To use cursor position for the beginning of the search, leave this field
blank. A message prompting you to verify cursor position displays.

To display the Selection List pop-up, enter a pattern with wildcard
characters [question mark (?) for one character; asterisk (*) for zero or
more characters].

See "Selection List Pop-ups" on page 118 for more information.
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Direction

Restricts the logical search to a specific direction or occurrence. These
are the valid values:

1. Next Searches or traces forward from the current cursor
position to the next occurrence of the target. This is the
default.

2. Previous Searches or traces backward from the current cursor
position to the previous occurrence of the target.

3. Forward Searches or traces forward from the current cursor
position to all occurrences of the target.

4. Backward Searches or traces backward from the current cursor
position to all occurrences of the target.

Trace IN-clause

Displays the Logic Order Search - Trace IN-Clause Option pop-up to
narrow the scope of the logic order search to a specified perform range
or marked set of lines. If not specified, the scope includes the entire
program. This option can only be used if number 3 is selected for
Action. The default is the entire program is used for the trace.

See "Logic Order Search - Trace IN-Clause Option Pop-up" on
page 119 for more information.

Action

Specifies how to display the logic order search results. These are the
valid actions:

1. Show Perfrange Name References

Only the targets on the path from the starting point to where the
logic order search ends are highlighted.

2. Show Execution Path(s) from Starting Point to Reference(s)

All executable statements on the path from the starting point to
where the logic order search stops are highlighted.

3. Trace (single-step) from Starting Point to Reference(s)

The logic order search stops at all executable statements on the path
from the starting point to where the search function ends.
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Logic Order Search - User Mark Name Pop-up

To follow program logic to a specific mark name, follow this step:

Select Logic » Mark and press Enter. The Logic Order Search - User Mark Name pop-up,
shown in Figure 56, displays.

Figure 56  Logic Order Search - User Mark Name Pop-up

Logic Order Search - User Mark Name

To find mark name references in execution order, type the name and
starting point, and select search options. Then press Enter. For a
mark or label name selection list, type a pattern (e.g. ABC*) in the
appropriate input area.

Mark name

Start line/label (if any)

Direction Options

1 1. Next _ Trace IN-clause...
2. Previous
3. Forward (all)
4. Backward (all)

Action
1 1. Show mark name reference(s)
2. Show execution path(s) from starting point to reference(s)

3. Trace (single-step) from starting point to reference (s)

Field Description

Mark name  Specifies a 1 to 10 alphanumeric character name given to a set or path
using the COPY, MARK, MERGE, or RENAME commands, or one of
these system-generated paths:

Fields

Path: Created by:
TRACK | TRK A TRACE command.
NETWORK | NET A FLOW command.

SUBNETnR | SUBn A path created by the FLOW command that
reaches from the beginning of the NETWORK
to one of the results (nth result).

The TRACK, NETWORK, and SUBNET paths can also be created using
the Logic Order Search pop-ups (see "Logic Pull-down" on page 101).
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Start line/ Specifies the line number or label name at which to begin the trace.

label To use cursor position for the beginning of the search, leave this field

blank. A message prompting you to verify cursor position displays.

To display the Selection List pop-up, enter a pattern with wildcard
characters [question mark (?) for one character; asterisk (*) for zero or
more characters].

See "Selection List Pop-ups" on page 118 for more information.

Direction Restricts the logical search to a specific direction or occurrence by
specifying a direction. These are the valid value:

1. Next Searches or traces forward from the cursor position to the
next occurrence of the target. This is the default.

2. Previous Searches or traces backward from the cursor position to
the previous occurrence of the target.

3. Forward Searches or traces forward from the cursor position to all
occurrences of the target.

4. Backward  Searches or traces backward from the cursor position to
all occurrences of the target.

Trace Displays the Logic Order Search - Trace IN-Clause Option pop-up to

IN-clause narrow the scope of the logic order search to a specified perform range or
marked set of lines. If not specified, the scope includes the entire
program. This option can only be used if number 3 is selected for Action.
The default is the entire program is used for the trace.

See "Logic Order Search - Trace IN-Clause Option Pop-up" on page 119
for more information.

Action Specifies how to display the logic order search results. These are the valid

actions:

1. Show Mark Name References
Only the targets on the path from the starting point to where the logic
order search ends are highlighted.

2. Show Execution Path(s) from Starting Point to Reference(s)
All executable statements on the path from the starting point to where
the logic order search stops are highlighted.

3. Trace (single-step) from Starting Point to Reference(s)

The logic order search stops at all executable statements on the path
from the starting point to where the search ends.
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Logic Order Search - Subprogram Name Pop-up

To follow program logic in sub-programs, follow this step:

» Select Logic P Program and press Enter. The Logic Order Search - Subprogram Name
pop-up, shown in Figure 57, displays.

Figure 57 ¢ Logic Order Search - Subprogram Name Pop-up

Logic Order Search - Subprogram Name

To find program name references in execution order, type the name
and starting point, and select search options. Then press Enter.
For a program or label name selection list, type a pattern (e.g.
ABC*) in the appropriate input area.

Program name

Start line/label (if any)

Direction Options

1 1. Next _ Trace IN-clause...
2. Previous
3. Forward (all)
4. Backward (all)

Action

1 1. Show program name reference (s)
2. Show execution path(s) from starting point to reference(s)
3. Trace (single-step) from starting point to reference (s)

Field Description

Program name  Specifies the name of the main program or any nested program. To
display the Selection List pop-up, leave the Program Name field blank
or enter a pattern with wildcard characters [question mark (?) for one
character; asterisk (*) for zero or more characters].

Fields

See "Selection List Pop-ups" on page 118 for more information.

Start line/label ~ Specifies the line number or label name from where to begin the trace.
To use cursor position for the beginning of the search, leave this field
blank. A message prompting you to verify cursor position displays.
To display the Selection List pop-up, enter a pattern with wildcard
characters [question mark (?) for one character; asterisk (*) for zero
or more characters].

See "Selection List Pop-ups" on page 118 for more information.
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Field Description

Direction Restricts the search to a specific direction or occurrence. These are the
valid values:

1. Next Searches or traces forward from the cursor position to
the next occurrence of the target. This is the default.

2. Previous  Searches or traces backward from the cursor position to
the previous occurrence of the target.

3. Forward  Searches or traces forward from the cursor position to
all occurrences of the target.

4. Backward Searches or traces backward from the cursor position to
all occurrences of the target.

Trace IN-clause Displays the Logic Order Search - Trace IN-Clause Option pop-up to
narrow the scope of the logic order trace to a specified perform range
or marked set of lines. If not specified, the scope includes the entire
program. This option can only be used if number 3 is selected for
Action. The default is the entire program is used for the trace.

See "Logic Order Search - Trace IN-Clause Option Pop-up" on
page 119 for more information.

Action Specifies how to display the logic order search results. These are the

valid actions:

1. Show Program Name References
Only the targets on the path from the starting point to where the
logic order search ends are highlighted.

2. Show Execution Path(s) from Starting Point to Reference(s)
All executable statements on the path from the starting point to
where the logic order search function stops are highlighted.

3. Trace (single-step) from Starting Point to Reference(s)

The logic order search stops at all executable statements on the
path from the starting point to where the search ends.

115



ASG-Insight Reference Guide

Logic Order Search - Line Number Range Pop-up

To follow program logic within ranges of lines, follow this step:

» Select Logic » Line and press Enter. The Logic Order Search - Line Number Range
pop-up, shown in Figure 58, displays.

Figure 58  Logic Order Search - Line Number Range Pop-up

Logic Order Search - Line Number Range

To find line range references in execution order, type the range and
starting point, and select search options. Then press Enter. For a

label name selection list, type a pattern (e.g. ABC*) in the "start"
field.

Line range

Start line/label (if any)

Direction Options

1 1. Next _ Trace IN-clause...
2. Previous
3. Forward (all)
4. Backward (all)

Action
1 1. Show line number range reference(s)
2. Show execution path(s) from starting point to reference(s)

3. Trace (single-step) from starting point to reference (s)

Field Description

Line range Specifies a single line number or range of lines. Line numbers display
in columns 1 through 6 of the Source View.

Fields

Start line/label ~ Specifies the line number or label name from where to begin the
trace. To use cursor position for the beginning of the search, leave
this field blank. A message prompting you to verify cursor position
displays. To display the Selection List pop-up, enter a pattern with
wildcard characters [question mark (?) for one character; asterisk (*)
for zero or more characters].

See "Selection List Pop-ups" on page 118 for more information.
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Direction

Restricts the search to a specific direction or occurrence by
specifying a direction. These are the valid values:

1. Next Searches or traces forward from the cursor position to
the next occurrence of the target. This is the default.

2. Previous Searches or traces backward from the cursor position to
the previous occurrence of the target.

3. Forward Searches or traces forward from the cursor position to
all occurrences of the target.

4. Backward Searches or traces backward from the cursor position to
all occurrences of the target.

Trace IN-clause

Displays the Logic Order Search - Trace IN-Clause Option pop-up to
narrow the scope of the logic order trace to a specified perform range
or marked set of lines. If not specified, the scope includes the entire
program. This option can only be used if number 3 is selected for
Action. The default is the entire program is used for the trace.

See "Logic Order Search - Trace IN-Clause Option Pop-up" on
page 119 for more information.

Action

Specifies how to display the logic order search results. These are the
valid actions:
1. Show Line Number Reference(s)

Only the targets on the path from the starting point to where the
logic order search ends are highlighted. This is the default.

2. Show Execution Path(s) from Starting Point to Reference(s)

All executable statements on the path from the starting point to
where the logic order search stops are highlighted.

3. Trace (single-step) from Starting Point to Reference(s)

The logic order search stops at all executable statements on the
path from the starting point to where the search ends.
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Selection List Pop-ups

To display selection lists for dataname, label name, COBOL subset name,
perform range name, and program name logic order searches

1 Perform one of these actions:

. Enter a pattern [question mark (?) for one character; asterisk (*) for zero or
more characters] and press Enter.

. Leave the Name field blank and press Enter.

. Select Start line/label field from the various pop-ups and press Enter.

Figure 59 illustrates the Selection List - Data Names pop-up. The selection list
pop-ups are the same except for the type of list displayed.

Figure 59 » Selection List - Data Names Pop-up

Selection List - Data Names
Command ===> Scroll ===> CSR

S Data name

ABEND-CODE
ADDRESS1
AREA-CODE
AVG-AMT (DEAD)
BILLING-DAYS
CHECK-CODE (DEAD)
CITY

CLIENT-ID
CONSOLE
CUR-PREFIX
CURRENT-ZIP-DATA
CUSTOMER-ID
DBA-DEPT-CODE
DEBUG-PARM
DET-ADDRESS
DET-AREA-CODE
DET-BILLING-DAYS

2  Select a dataname by typing S in the line command and press Enter. The selected
name is placed in the name field of the Logic Order Search pop-up.

Use the LOCATE primary command to can scroll through the list of names.
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Logic Order Search - Trace IN-Clause Option Pop-up

Fields

To restrict the source lines considered for a trace

1 From the Logic Order Search pop-up, specify Action 3 - Trace (single-step) from
starting point to reference(s) and the Trace IN-clause option, and press Enter. The
Logic Order Search - Trace IN-Clause Option pop-up, shown in Figure 60, displays.

Figure 60 » Logic Order Search - Trace IN-Clause Options Pop-up

Logic Order Search - Trace IN-Clause Option

To restrict the source lines to be considered for a Trace, type one
or more IN-Clause selections. Then press Enter. For a selection
list, type a pattern (e.g. ABC*) in the appropriate input area.

Perform range . .
User MARK name

2. Uses only 2. Previous IN-clause...
3. Mods only 3. Forward (all)
4. Backward (all)

Action

3 1. Show data name reference (s)
2. Show execution path(s) from starting point to reference (s)
3. Trace (single-step) from starting point to reference (s)

2 Type the perform range or user mark name to search and press Enter.

To display the Selection List pop-up for the Perform range or the User MARK name
fields, follow this step:

» Enter a pattern with wildcard characters [question mark (?) for one character; asterisk
(*) for zero or more characters] and press Enter.

Field Description

Perform range Specifies the perform range to search.

User MARK name Specifies the name of the mark to search.
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Task

This chapter describes items on the Insight Task menu and contains these sections:

Topic Page

Task Pull-down 122
Automated Task - Modify Program Output Pop-up 123
Modify Output Task - Output Selection Pop-up 124
Modify Output Task - Statement Selection Pop-up 126
Modify Output Task - Data Name Selection Pop-up 127
Automated Task - Modify a Computation Pop-up 129
Automated Task - Debug a Program Abend pop-up 134
Automated Task - Result Options Pop-up 137
Options - COPY/Include Libraries Pop-up 138

The Task facility automates program maintenance and enhancement tasks, such as
finding the incorrect output source, enhancing computations, and finding the abends
source.

Insight shows tasks results in Source View or an edit session.

Note:
See the ASG-Insight User’s Guide for more information.
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Task Pull-down

To access the selection pop-ups used to automate common program maintenance and
enhancement tasks, follow this step:

P Select Task on the action bar and press Enter. The Task pull-down, shown in Figure 61,
displays.

Figure 61 » Task Pull-down

File WUiew 3Zearch Logic Task List Options Help

A=sE- | _ 1. Hodify output...
ComMand ===F _____________ 2. Hadify computation... | ____.
3. Debug abend...
Hetetolototeteteteiok 4. Eee task results in AEG-EHartEdit...
Hepdotok: depoiobok detetetetok Hettokok
etetcdok detetcdok  dedotetetek Hetettok
shetededok shetededok ebtelob debobetck etk
Hetstobok Hetstobok detstobbk hobetetok ek
setetstok
setededok

copyright Allen systeds Group, INC., an unpublished work.
A proprietary product of ASG, InC. Use pestricted to authorized 1icensess.
Vizit the AEG Zupport Mebk Zite at www.asg.cod

Actions

1. Modify Output Displays the Automated Task - Modify Program Output
pop-up used to begin selecting output names for the Modify
Program Output task or to review previous selections.

2. Modify Computation Displays the Automated Task - Modify a Computation pop-up
used to begin selecting datanames for the Modify Computation
task or to review previous selections.

3. Debug Abend Displays the Automated Task - Debug a Program Abend
pop-up used to begin the Debug Abend task or to review
previous selections.

4. See Task Results in  Displays the Edit Options pop-up used to specify and/or verify
the Editor options for the editor.

If SmartEdit is installed, this action displays the Edit Options
screen for SmartEdit.
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Automated Task - Modify Program Output Pop-up

Options

To begin modifying, correcting, or understanding statements involved in outputting a line
on a report or a record on a file, follow this step:

» Select Task » Modify and press Enter. The Automated Task - Modify Program Output
pop-up, shown in Figure 62, displays.

Figure 62 » Automated Task - Modify Program Output Pop-up

Automated Task - Modify Program Output

This "task" automates the process of finding all program statements
involved in building a field on a report, display screen, file or
database. The "task results" can facilitate modifications or
uncover the reasons for erroneous program output.

The following selection screens quickly narrow the search to an
output type, a statement and a field name. The final screen offers
a choice of "view" options for the task results.

1 1. Begin selections
2. Review previous selections

Options Description

Begin selections Displays the Modify Output Task - Output Selection pop-up
used to select the incorrect output to be examined in the Task
facility. This is the default.

Review previous Displays the Modify Output Task - Output Selection pop-up
selections with the previously selected output name highlighted.
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Modify Output Task - Output Selection Pop-up

Fields

124

To select the output to examine, follow this step:

» Select option 1 or 2 on the Automated Task - Modify Program Output pop-up and press
Enter. The Modify Output Task - Output Selection pop-up, shown in Figure 63,
displays.

Figure 63 « Modify Output Task - Output Selection Pop-up

Modify Output Task - Output Selection
Command ===> Scroll ===> CSR

The names listed below are the output "files" in the program. Select the
"file" to be investigated. Then press Enter. (Type 'S' to select, 'U' to
un-select, or 'V' to view in Source View.)

Is output performed in CALLed programs (Y/N)? NO

S Output Name Type
_ CONSOLE DD Name
_ MASTER-RPT FD
SYSOUT DD Name
Tk ok Kok ok ok ok ok ok kK ok ok K ok BOTTOM OF DATA LR EEEE RS EEEE S

A message indicates the number of files producing program output when this pop-up first
displays.

Field Description

Is Output Performed  Specifies whether all CALL statements display. Type YES to
in CALLed Programs display all CALL statements for selection. NO is the default

Line command area  Refers to the area to the left of the Output Name field, which
accepts these line commands:

S Selects the output name and displays the Modify Output
Task - Statement Selection pop-up to select the statement
producing the incorrect output.

U Deselects a previously-selected output name. The name is
no longer highlighted.

V  Displays the Source View screen with a shortened action
bar, showing the source statement selected for viewing
positioned in the middle of the screen, to see the statement
in context. The statement is highlighted and tagged to the
right with LINE RNG. Use the END command to return to
the Modify Output Task - Output Selection pop-up.
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Field Description

Output name Specifies the file names the program produces output for. When
viewing previous selections, the selected name is highlighted.

Type Indicates the type of output. These are the valid values:

FD - File description

RD - Report description

SD - Sort description

DD Name - SYSOUT or CONSOLE output
CICS - CICS output

IMS - CBLTDLI CALL statement

CALL - Non-CBLTDLI CALL statement

SQL TABLE SQL TABLE declared and/or created in the
program

SQL VIEW - SQL VIEW declared and/or created in the
program

IDMS RECORDS - IDMS records referenced in the
program
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Modify Output Task - Statement Selection Pop-up

Fields

126

To select the statement producing the incorrect output, follow this step:

P Select an output name on the Modify Output Task - Output Selection pop-up and press
Enter. The Modify Output Task - Statement Selection pop-up, shown in Figure 64,
displays.

Figure 64 « Modify Output Task - Statement Selection Pop-up

Modify Output Task - Statement Selection
Command ===> Scroll ===> CSR

The statements listed below "write" to the selected "file". Select the
statement to be investigated. Then press Enter. (Type 'S' to select, 'U'
to un-select, or 'V' to view in Source View.)

Selected output: MASTER-RPT

S Line Output statement

000352 WRITE MAST-RPT FROM DETAIL-LINEI.
000357 WRITE MAST-RPT FROM DETAIL-LINE2.
000365 WRITE MAST-RPT FROM DETAIL-LINE3.
000372 WRITE MAST-RPT FROM DETAIL-LINE4.
000424 WRITE MAST-RPT FROM SUB-PRINT.
000434 WRITE MAST-RPT FROM RPT-HDG-LINE1.
000435 WRITE MAST-RPT FROM RPT-HDG-LINE2.
000454 WRITE MAST-RPT FROM TOTAL-PRT

Kk KKK KKK KK KKKk KXk Kk kX kkkkxkkkx BOTTOM OF DATA ¥ * ok % % kK %k k K o % % ok ok % % K % & % &k % %

*

The selection list contains all statements that write to the previously-selected output
name.

Field Description

Selected output Specifies the output name that was selected on the Modify Output
Task - Output Selection pop-up.

Line command Specifies the area to the left of the Line field, which accepts these line
area commands:

S Selects the statement and displays the Modify Output Task - Data
Name Selection pop-up to select the dataname producing the
incorrect output.

U Unselects a previously-selected statement. The statement is no
longer highlighted.

V Displays the Source View screen with a shortened action bar,
showing the source statement selected for viewing positioned in
the middle of the screen, to see the statement in context. The
statement is highlighted and tagged to the right with LINE RNG.
Use the END command to return to the Modify Output
Task - Statement Selection pop-up.
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Field Description

Line Specifies the Source View line number.
Output Specifies the statements corresponding to the selected output. When
statement viewing previous selections, the selected statements is highlighted.

Modify Output Task - Data Name Selection Pop-up

To select the dataname responsible for the incorrect output, follow this step:

P Select a statement on the Modify Output Task - Statement Selection pop-up and press

Enter. The Modify Output Task - Data Name Selection pop-up, shown in Figure 65,
displays.

Figure 65 « Modify Output Task - Data Name Selection Pop-up

Modify Output Task - Data Name Selection
Command ===> Scroll ===> CSR

The names listed below are data items that are output by the "write"
statement selected. Select the item to be investigated. Then press Enter.
(Type 'S' to select, 'U' to un-select, or 'V' to view in Source View.)
Selected statement: 000352 WRITE MAST-RPT FROM DETAIL-LINEL.

S Data name

The selection list contains all datanames referenced on the selected write statement.
When this screen first displays a message indicates the number of datanames found.
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Fields

Usage Notes
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Field Description

Selected Specifies the statement selected on the Modify Output
statement Task - Statement Selection pop-up.

Line command  Specifies the area to the left of the Line field, which accepts these line
area commands:

S Selects the dataname and displays the Automated Task - Result
Option pop-up to choose how to display the results of the Task
facility.

U Unselects a previously-selected dataname. The name is no longer
highlighted.

V  View Source. Displays the Source View screen with a shortened
action bar, showing the source statement selected for viewing
positioned in the middle of the screen, to see the statement in
context. The statement is highlighted and tagged to the right with
LINE RNG. Use the END command to return to the Modify
Output Task - Data Name Selection pop-up.

Data name Specifies the datanames contained in the selected statement. When
viewing previous selections, the selected dataname is highlighted.

The Modify Output Task - Data Name Selection pop-up is the last Modify Output Task
selection pop-up. After you select a dataname, the Automated Task - Result Options
pop-up displays, allowing you to see the results in Source View, modify the results in the
editor, or return to the first selection pop-up to review the selections.

See "Automated Task - Result Options Pop-up" on page 137 for more information.
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Automated Task - Modify a Computation Pop-up

Options

To begin modifying, correcting, or understanding the statements involved in computing
or assigning a dataname, follow this step:

» Select Task » Modify computation and press Enter. The Automated Task - Modify a
Computation pop-up, shown in Figure 66, displays.

Figure 66 » Automated Task - Modify a Computation Pop-up

Automated Task - Modify a Computation

This "task" automates the process of finding all program statements
involved in the computation (or assignment) of a data variable. The
"task results" can facilitate modifications or uncover the reasons

for erroneous calculations.

The following selection screens quickly narrow the search to a data
name and a computation statement. The final screen offers a choice
of "view" options for the task results.

1 1. Begin selections
2. Review previous selections

Option Description

Begin Selections  Displays the Modify Computation Task - Data Name Entry pop-up
used to enter the dataname to be examined. This is the default.

Review Previous  Displays the Modify Computation Task - Data Name Selection
Selections pop-up with previously selected dataname highlighted.
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Modify Computation Task - Data Name Entry Pop-up

To enter a dataname for examination or to access the Modify Computation Task - Data
Name Selection pop-up, follow this step:

» Select option 1 on the Automated Task - Modify a Computation pop-up and press
Enter. The Modify Computation Task - Data Name Entry pop-up, shown in Figure 67,
displays.

Figure 67 « Modify Computation Task - Data Name Entry Pop-up

Modify Computation Task - Data Name Entry
Type the data name being computed or assigned. Then press Enter.
For a data name selection list, type a pattern (e.g. ABC*) in the
data name area.

Data name

Field

Field Description

Dataname Specifies a COBOL dataname or qualified COBOL dataname. The
Modify Computation Task - Statement Selection pop-up displays to
specify the statement to examine. Dataname refers to any valid COBOL
reference for a data element.

To display the Modify Computation Task - Data Name Selection pop-up,
leave this field blank or enter a pattern with wildcard characters [question
mark (?) for one character; asterisk (*) for zero or more characters].
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Modify Computation Task - Data Name Selection Pop-up

To select the dataname to examine, follow this step:

» Enter a pattern in the Data Name field on the Modify Computation Task - Data Name
Entry pop-up and press Enter. The Modify Computation Task - Data Name Selection
pop-up, shown in Figure 68, displays.

Figure 68 « Modify Computation Task - Data Name Selection Pop-up

Modify Computation Task - Data Name Selection
Command ===> Scroll ===> CSR

The data names listed below are assigned value in this program. Select the
name to be investigated. Then press Enter. (Type 'S' to select, 'U' to
un-select, or 'V' to view in Source View.)

Pattern *

S Data name Qualification

_ ABEND-CODE
ADDRESS1 01 MASTER-IN

~ AREA-CODE 05 PHONE, 01 MASTER-IN

: BILLING-DAYS 05 LOAN-INFORMATION, 01 MASTER-IN

_ CITY 01 MASTER-IN

_ CLIENT-ID 01 MASTER-IN

_ CUR-PREFIX 01 CURRENT-ZIP-DATA
CURRENT-ZIP-DATA

: CUSTOMER-ID 05 CLIENT-ID, 01 MASTER-IN

The selection list contains all datanames computed or assigned a value in the program for
the specified pattern. A message indicates the number of datanames found when this
pop-up first displays.

Field Description

Pattern Specifies the pattern that was used to obtain the list of
datanames.

Fields

Line command area  Specifies the area to the left of the Line field, which accepts these
line commands:

S Selects the dataname and displays the Modify Computation
Task - Statement Selection pop-up to select a statement for
examination.

U Unselects a previously-selected dataname. The name is no
longer highlighted.

V  View Source. Displays the Source View screen as a pop-up
with a shortened action bar, showing the source statement
selected for viewing positioned in the middle of the screen to
see the statement in context. The statement is highlighted
and tagged to the right with LINE RNG. Use the END
command to return to the Modify Computation Task - Data
Name Selection pop-up.
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Field Description

Data name Specifies the datanames included in the pattern that are assigned

value in the program. When viewing previous selections, the
selected dataname is highlighted.

Qualification Specifies the parent(s) of the data variable name. The qualifying

parent name includes the level number and the dataname.

Modify Computation Task - Statement Selection Pop-up

132

To select a statement for examination and display a list of statements that
compute the selected dataname

1

Select a dataname on the Modify Computation Task - Data Name Selection pop-up.
Or

Enter a dataname on the Modify Computation Task - Data Name Entry pop-up.

Press Enter to display the Modify Computation Task - Statement Selection pop-up
shown in Figure 69.

Figure 69 « Modify Computation Task - Statement Selection

Modify Computation Task - Statement Selection
Command ===> Scroll ===> CSR

The statements listed below assign value to the selected data name.
Select the statement to be investigated. Then press Enter. (Type 'S'
to select, 'U' to un-select, or 'V' to view in Source View.)

Selected name: ABEND-CODE

S Line Computation/assignment statement

000059 77 ABEND-CODE PIC S9(4) COMP VALUE +0.
000493 MOVE +999 TO ABEND-CODE.

000494 CALL 'ABENDPGM' USING ABEND-CODE.

FhAK KK kXK K kXK K KXk k kX kkkkxkkkx*x BOTTOM OF DATAK * % k% ok % % % o % % % % sk k % % % % k % % % % * %




Fields

Usage Notes

6 Task

Selected name

Specifies the dataname that you entered on the Modify
Computation Task - Data Name Entry pop-up or selected
on the Modify Computation Task - Data Name Selection

pop-up.

Line command area

Specifies the area to the left of the Line field, which accepts
these line commands:

S

Selects the statement and displays the Automated
Task - Result Options pop-up that allows you to choose
how the results of the Task facility display.

Unselects a previously - selected statement. The name
is no longer highlighted.

View Source. Displays the Source View screen as a
pop-up with a shortened action bar, showing the source
statement selected for viewing positioned in the middle
of the screen to see the statement in context. The
statement is highlighted and tagged to the right with
LINE RNG. Use the END command to return to the
Modify Computation Task - Statement Selection

pop-up.

Line

Specifies the Source View line number.

Computation/assignment

statement

Specifies the statements that compute or assign value to the
selected dataname. When viewing previous selections, the
selected statements is highlighted.

The Modify Computation Task - Statement Selection pop-up is the last Modity
Computation Task selection pop-up. After you select a statement, the Automated

Task - Result Options pop-up displays, allowing you to see the results in Source View,
modify the results in the editor, or return to the first selection pop-up to review the

selections.

See "Automated Task - Result Options Pop-up" on page 137 for more information.
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Automated Task - Debug a Program Abend pop-up

Options

To begin debugging a data-related abend in a program, follow this step:

» Select Task » Debug and press Enter. The Automated Task - Debug a Program Abend
pop-up, shown in Figure 70, displays.

Figure 70 * Automated Task - Debug a Program Abend

Automated Task - Debug a Program Abend

This "task" automates the process of finding all program statements
that build data variables for a statement that is causing an abend.
The "task results" help uncover the reasons for the failure.

The following selection screens quickly narrow the search to the
statement causing the abend. The final screen offers a choice of
"view" options for the task results.

1 1. Begin selections
2. Review previous selections

The task isolates the statements that compute or assigns values to the data variables in an
abending statement.

Option Description

Begin selections  Displays the Debug Abend Task - Line Number Entry pop-up used
to enter the Source View line number or range of lines where the
program abend occurred. This is the default.

Review previous  Displays the Debug Abend Task - Line Number Entry pop-up that
selections allows you to review the line number(s) entered.

Debug Abend Task - Line Number Entry Pop-up

134

To enter the Source View line number, or range of lines, where the program
abend occurred

1 Select Task P Debug abend and press Enter. The Automated Task - Debug a Program
Abend pop-up displays.

2 Select option 1 or 2 and press Enter. The Debug Abend Task - Line Number Entry
pop-up, shown in Figure 71 on page 135, displays.
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3  Enter the beginning and ending line where the abend occurred and press Enter. The
statements in the range of lines displays.

Figure 71 « Debug Abend Task - Line Number Entry Pop-up

Debug Abend Task - Line Number Entry

Type the (Source View) line number or the line number range

containing the abending program statement. Then press Enter.
Beginning line number . . 000355
Ending line number . . . (if any)

Fields

Field Description

Beginning line number Required. Specifies the Source View line number where the
abend occurred, or the beginning line number in a range of
lines where the abend occurred.

Ending line number Specifies the last Source View line number in a range of
lines where the abend occurred.

Debug Abend Task - Statement Selection Pop-up

To select a statement for further examination and to display a list of statements that
reference one or more data variables in the specified range of lines, follow this step:

» Enter a line number on the Debug Abend Task - Line Number Entry pop-up. The
Debug Abend Task - Statement Selection pop-up, shown in Figure 72, displays.

Figure 72 « Debug Abend Task Statement Selection Pop-up

Debug Abend Task - Statement Selection
Command ===> Scroll ===> CSR

The statements listed below are in the selected range and reference one or
more data variables. Select the statement to be investigated. Then press
Enter. (Type 'S' to select, 'U' to un-select, or 'V' to view in Source
View.)

Selected lines: 355 -

000355 MOVE YEAR-TO-DATE-INTEREST TO DET-YTD-INT.

Fhok Kk ok kX kkkkkk kX kkkkkkkkxkkkxkk BOTTOM OF DATA X% % % kK ok % x & ok % % %k & % % % &k & % k & & % % &
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Fields

Field Description

Selected lines Specifies the Source View line number(s) entered on the Debug
Abend Task - Line Number Entry pop-up.

Line command area Specifies the area to the left of the Line field, which accepts
these line commands:

S Selects the statement and displays the Automated
Task - Result Options pop-up to choose how to display the
results of the Task facility.

U Unselects a previously selected statement. The name is no
longer highlighted.

V Displays the Source View screen as a pop-up with a
shortened action bar, showing the source statement selected
for viewing positioned in the middle of the screen to see the
statement in context. The statement is highlighted and
tagged to the right with LINE RNG. Use the END command
to return to the Modify Computation Task - Statement
Selection pop-up.

Line Specifies the Source View line number.

Statements containing Specifies the statements in the specified range of lines that
variables reference data variables. When viewing previous selections, the
selected statements is highlighted.

Usage Notes

The Debug Abend Task - Statement Selection pop-up is the last Debug Abend Task
selection pop-up. After you select a statement, the Automated Task - Result Options
pop-up displays, allowing you to see the results in Source View, modify the results in the
editor, or return to the first selection pop-up to review the selections.

See "Automated Task - Result Options Pop-up" on page 137 for more information.
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Automated Task - Result Options Pop-up

Options

To choose how the Task facility results display, follow this step:

P Select dataname (for Modify Program Output Task) or statement (for Modify
Computation Task or Debug Abend Task). The Automated Task - Result Options
pop-up, shown in Figure 73 on page 137, displays.

Figure 73 « Automated Task - Result Options Pop-up

Automated Task - Result Options

The selections are complete for this "task™. All program statements that
relate to these selections are available for viewing. Select the desired
option. Then press Enter.

1 1. Source View - See the task results in Source View**
2. Editor - Modify the results in your editor
3. Review - Return to first selection screen

** Source View tags:

START - Selected starting statement
T - Intermediate target
TARGET - Statement that initialize component variables

TARGET-U - Target with an uninitialized variable
TARGET-U? - Target with possible uninitialized variable

Option Description

Source View Redisplays the Source View screen with the statements highlighted
and tagged. All other lines are excluded from the display. This is the
default option.

Editor Displays the Options - COPY/Include Libraries pop-up used to access
your editor.If SmartEdit is installed, displays the
Options - COPY/Include Libraries pop-up for SmartEdit.

Review Redisplays the first selection list pop-up to review the selections.
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Options - COPY/Include Libraries Pop-up
To specify a source manager for the editor, follow this step:

» Select Task P> See task results in the editor or select Editor on the Automated
Task - Result Options pop-up. The Options - COPY/Include Libraries pop-up, shown

in Figure 74, displays.

Figure 74 « Options - COPY/Include Libraries Pop-up

File COBOL SourceManager Options
Options - COPY/Include Libraries
Command ===> Scroll ===> PAGE

Specify Source Manager, COBOL Version and COPY/Include Libraries.

Source Manager . . : PDS/Sequential COBOL Version . : COBOL 74
COPY List:
Data Set Name
Member . . . . . :
Description :
Copy/Include Data Set Name (s) Type VolSer Unit Password
/ '"VIAUSER.TESTDOO1.CNTL' PDS

Hokkok ok kkkokkkkkokkkkkkkkkkxkkkxkkk BOTTOM OF DATA ** kk %k ok &k Xk k % % Kk %k % Xk k % %k % & %k %k % % %k

Field

Field Description

Source Manager  Specifies the abbreviation of the source manager that contains your
program. These are the valid values:

1. PDS/Sequential
2. Librarian

3. Panvalet

4. SCLM

5. Other (User)

138



List

This chapter describes items on the Insight List menu and contains these sections:

Topic Page

List Pull-down 140
List - CALL Statements Pop-up 141
List - Equates Pop-up 142
List - User Marks Pop-up 143
List - Perform Range Names Pop-up 145
List - Program/Subprogram Names Pop-up 146
List - COBOL Subset Names Pop-up 147
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List Pull-down

To access pop-ups that list information about CALLSs, equates, marks, PERFORMs,
programs, and subsets, follow this step:

» Select List on the action bar and press Enter. The List pull-down, shown in Figure 75,
displays.

Figure 75  List Pull-down

File Uiew 3earch Logic Task List Options Help

AZG-EZM - _ 1. galls...
CoHHand === ___________________ 2. Equates...
3. Harks...
ettt ok d. PEFFOFHS ... | deicktsebisibiscticteg
B e D L R e Su Proqrans... | deeekickieiickiice
Hedetetk Hedetek G SUbZEtS... Hedetetk
btk Hetek
Hefrioich Hefrioich defrietiok eieokk Hefek
Hefetotch Hefetotch defobtstok etttk Hefok
Hepotedoh:
edetetch

Copyright ALlen Systens Group, Inc., an unpublished wark.
A proprietary product of ASG, Inc. Use pestricted to authorized licensees.
Vizit the ASG Support Web Zite at wuM,asg.cod

Actions

1. Calls Displays the List - CALL Statements pop-up that lists programs CALLed
by the active program.

2. Equates  Displays the List - Equates pop-up that lists all equates for the active
program.

3. Marks Displays the List - User Marks pop-up that lists all existing marks and is
used to change comments, merge sets, and copy, delete, or rename sets or
paths.

4. Performs  Displays the List - Perform Range Names pop-up that lists all COBOL
perform ranges in the active program.

5. Programs Displays the List - Program/Subprogram Names pop-up that lists the
internal subprograms defined within a COBOL II Release 3 or later
program.

6. Subsets  Displays the List - COBOL Subset Names pop-up that lists the subsets
along with a brief description of each.
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List - CALL Statements Pop-up

To display programs CALLed by the current program, follow this step:

» Select List » Calls, or type LIST CALLS on any screen, and press Enter. The
List - CALL Statements pop-up, shown in Figure 76, displays.

Figure 76 » List - CALL Statements Pop-up

List - CALL Statements
Command ===> Scroll ===> CSR

Select the program CALL(s) to be viewed. Then press Enter.

S Called program Mode
_ 'ABENDPGM' STATIC
_ 'DBACLSEL" STATIC
_ 'DBACLSE2" STATIC
_ 'DBAOPENL1" STATIC
_ 'DBAOPEN2"' STATIC
_ 'DBAREADL' STATIC
_ 'DBAREAD2' STATIC
_ 'VIAIDEM1' STATIC
*

hokkkokkkkkkkkkkkxkkkkkkkkkkk* BOTTOM OF DATA ¥k ko %ok ok k& ko % & k ok o % % Kk ok ok % k ok %k ok ok % %

A message indicates the number of CALLs listed when this pop-up first displays.

You can copy the CALLed subprograms list to the List file by typing LPRINT * on this
pop-up.

Field Description

S (line command Specifies the area to the left of the CALLed program field, which

area) accepts the S line command that selects a CALLed subprogram
for viewing. The screen where you requested the List - CALL
Statements pop-up redisplays with the related CALL statements

Fields

highlighted and tagged.
Called program Specifies the name of the CALLed module.
Mode Specifies the type of CALL. These are the valid types:

STATIC The object of the CALL is a literal and the
associated program is link-edited into the same
load module as the CALLing program.

DYNAMIC The object of the CALL is an identifier and is
determined at run time. Programs referenced may
or may not be link-edited into the same load
module as the CALLing program.

INTERNAL A CALL to a nested source subprogram.
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List - Equates Pop-up

Fields
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To display all existing equates for the active program, follow this step:

» Select List » Equates, or type LIST EQUATES on any screen, and press Enter. The
List - Equates pop-up, shown as Figure 77, displays.

Figure 77 » List - Equates Pop-up

List - Equates

Command ===> SCROLL ===> CSR
Name Program Substitution String Columns 001-052

MSTR VIAIDEMO MASTER-IN + MASTERIN

PARAS VIAIDEMO PROGRAM-INIT + P0O05-VAL-PARM THRU POOS5-EXIT

ZIPDATA VIAIDEMO ZIP-CODE + HLD-ZIP + DET-ZIP-CODE

KKK KKK Kk KXk ok kX kk kX kkkxkkkxx* BOTTOM OF DATA ** % % kK sk % k K ok sk % %k K ok % &k o % % k& % % % &k % % %

You can copy the Equates list to the List file by typing LPRINT * on this pop-up.

Field Description

Name Specifies the name assigned to the equate.

Program Specifies the name of the program containing the equate.

Substitution  Specifies the actual data the NAME represents. Prior to execution, this

String string is substituted into any command that uses the equate name. This
field is left and right scrollable so you can view the entire string.The
right-most column contains a greater than (>) symbol when the
substitution string extends past the screen column capability. To change
the substitution string, type over it.

Type blanks over the substitution string to delete the equate.




List - User Marks Pop-up

Use the List - User Marks pop-up to perform these functions:

Display a directory or list of all existing marks
Change comments

Merge sets

Copy sets or paths

Delete sets or paths

Rename sets or paths

To display the List - User Marks pop-up, follow this step:

» Select List » Marks, or type LIST MARKS on any screen, and press Enter. The

List - User Marks pop-up, shown in Figure 78, displays.

Figure 78 » List - User Marks Pop-up

List - User Marks

Command ===> Scroll ===> CSR
C : Copy set/path 1 to set/path 2. D : Delete existing set/path 1.
M : Merge set/path 1 with set 2. R : Rename set/path 1 to set/path 2.

S : Select the mark to be viewed.

Set/path 1 Set/path 2 Comments
_ NETWORK PATH FLOW FROM LINE 231 TO 2 TARGET(S) OF 'EXITS'
_ SUBNET1 PATH FROM LINE 231 TO TARGET (S) ON LINE 494
_ SUBNET2 PATH FROM LINE 231 TO TARGET(S) ON LINE 251
TRACK PATH TRACE FROM 231 TO TARGET (S) OF ENTRY

TRk ok ok kKK KKk K kK ok Kk K K K K K K K K KK BOTTOM OF DATA * % % % k% s % % o % % %k % % % % & o % % k& & % k &

7 List

You can copy the Equates list to the List file by typing LPRINT * on this pop-up.
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Fields

Field Description

Line command Specifies the area to the left of the Set/Path 1 field, which accepts these
area line commands:

C Copies a set or path. Type the target of the copy in the Set/path 2
field.

M Merges sets. Type the target of the merge in the Set/path 2 field.

S Selects an item for viewing. The screen where you requested the
List - User Marks pop-up redisplays with the marks highlighted
and tagged.

D Deletes an existing set or path.

R Renames a set or path. Type the new name in the Set/path 2 field.

Set/path 1 Specifies the name of the set or path.

Type Specifies the type field, between the Set/path 1 field and the Set/path
2 field, identifies the item as a set or path.

Set/path 2 Specifies the appropriate mark name. This field is required if you enter
the C, M, or R line command.

Comments Specifies comment space. Change existing comments by typing over
them.
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List - Perform Range Names Pop-up

To display all COBOL perform ranges in the active program, follow this step:

» Select List » Performs, or type LIST PERFORMS on any screen, and press Enter. The
List - Perform Range Names pop-up, shown in Figure 79, displays.

Figure 79 » List - Perform Range Names Pop-up

List - Perform Range Names
Command ===> SCROLL ===> CSR

Select the perform range to be viewed. Then press Enter.
Perform range name

PROGRAM-INIT

POOO-NEXT THRU POOO-EXIT
PO05-VAL-PARM THRU POO5-EXIT
PO010-OPEN THRU PO19-EXIT

P100-PRINT THRU P119-EXIT

P120-READ THRU P129-EXIT
P150-SUBTOT THRU P169-EXIT
P155-CL-SUBTOT THRU P159-EXIT
P160-HDG THRU P169-EXIT
P999-ABEND-PROGRAM OF ABEND-PROGRAM

Fok KK K kK K Kk Kk Kk Kk Kk Rk Kk Kk Kk KK BOTTOM OF DATA * % % % % o s % % % s % % % % % % k % o % % &k % % % & %

A message indicates the number of CALLSs listed when this pop-up first displays.

Field Description

S (line command area) Specifies the area to the left of the Perform range name field,
which accepts the S line command to select a perform range for
viewing. The screen where you requested the List - Perform
Range Names pop-up redisplays with the perform ranges
highlighted and tagged.

Fields

Perform range name  Specifies the perform label name.

Usage Notes

Scroll down to view the rest of the list.

You can copy the CALLed subprograms list to the List file by typing LPRINT * on this
pop-up.
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List - Program/Subprogram Names Pop-up

Fields
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To display the internal subprograms defined within a COBOL II Release 3 or later
program, follow this step:

» Select List » Programs, or type LIST PROGRAMS on any screen, and press Enter. The
List - Program/Subprogram Names pop-up, shown in Figure 80, displays.

Figure 80 » List - Program/Subprogram Names Pop-up

List - Program/Subprogram Names
Command ===> Scroll ===> CSR

Select the program name to be viewed. Then press Enter.
Program name

_ VIAIDEMO
KKK KKK KKK KKK KKK KKK KKK KKK A KK xk* BOTTOM OF DATA * % % % %k Kk & ok k ok o % ok ok K ok ok ok ok ok Kok ok Kk

Internal subprograms are indented in relation to their hierarchy.
When this pop-up first displays a message indicates the number of CALLSs listed.

You can copy the CALLed subprograms list to the List file by typing LPRINT * on this
pop-up.

Field Description

S (line command area) Specifies the area to the left of the Perform range name field,
which accepts the S line command to select a subprogram for
viewing. The screen where you requested the
List - Program/Subprogram Names pop-up redisplays with the
subprograms highlighted and tagged.

Program name Specifies the program or subprogram ID.
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List - COBOL Subset Names Pop-up

To display the subsets along with a brief description of each, follow this step:

» Select List » Subsets, or type LIST SUBSETS on any screen, and press Enter. The
List - COBOL Subset Names pop-up, shown in Figure 81, displays.

Figure 81 ¢ List - COBOL Subset Names Pop-up

List - COBOL Subset Names
Command ===> Scroll ===> CSR

Select the subset to be viewed. Then press Enter.

S Subset Description
_ ASsignment - COBOL: ACCEPT, ADD, SUBTRACT, MULTIPLY, DIVIDE,
BY, COMPUTE, MOVE, FROM, INSPECT, EXAMINE,
STRING, UNSTRING, SET, SEARCH, TRANSFORM;
IDMS: ACCEPT, CHECK, ERASE, GET, INQUIRE, LOAD,
PUT, RETURN;
SQL: FETCH, SELECT INTO, SET.
_ Call - COBOL: CALL, CANCEL, ENTRY, intrinsic function
calls;
CICS: LINK, XCTL;
IDMS: ATTACH, LINK, XCTL.

_ CIcs - EXEC CICS, EXEC DLI commands.

_ COBOLIT - CALL (COBOLII), PERFORM (COBOLII), CONTINUE, SET,
SERVICE LABEL, EVALUATE, INITIALIZE, end verbs.

_ COBOL370 - Statements and clauses unique to COBOL/370, such as

intrinsic function calls, procedure pointers and

Fields

S (line command area) Specifies the area to the left of the Perform range name field,
which accepts the S line command to select a subset for
viewing. The screen where you requested the List - COBOL
Subset Names pop-up redisplays with the subsets highlighted
and tagged.

Subset Specifies the subset name. See the ASG-Insight User’s Guide
for a description of each subset type.

Description Specifies the description of the subset.

Usage Notes

Scroll to view the rest of the list.

You can copy the CALLed subprograms list to the List file by typing LPRINT * on this
pop-up.
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Options

This chapter describes items on the Insight Options menu and contains these sections:

Topic Page

Options Pull-down 149
Options - Product Parameters Pop-up 151
Options - Product Allocations Pop-up 152
Options - Log/List/Punch Definition Pop-up 154
Options - Script File Allocations Pop-up 157
Options - PF Key Definition Pop-up 158
Options - Processing Modes Pop-up 160
Options - Scratchpad Pop-up 161

Options Pull-down

You use the Options pull-down to set parameters and options, and to define PF keys. This
pull-down also provides access to the scratchpad, and is used to refresh the Source View
display. This section describes the actions available on the Options pull-down.
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Actions
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Figure 82, displays.

To display the Options pull-down, follow this step:

» Select Options on the action bar and press Enter. The Options pull-down, shown in

Figure 82 ¢ Options Pull-down

File Uiew =Zearch Logic Task List Options Help

AZG-ESM - Progra | _ 1. Product paraneters...
ConRand ===l 2. Product allocations... _
. Log<listspunch...
setetetetststsioototetstsototetstoh d. Zcript file allocations...
Hok 5. PF keys...
Hetobotok debobotok etok B. Hodes...
Hetetobok Hebebobok deteick T. Ecratchpad...
3. Refresh
Hetcdetok: Hetcdetok: Hetetoketk etetetok Heteke
tetetoiok tetetoiok debtstokk debokotk etk
Hetfetok
shetettok

Copwright ALlen $wstens Group, Inc., an unpublished work.
A proprietary product of ASG, Inc. Use restricted to authorized licensees.
Vigit the AG Support Web Site at wuw.asg.coH

1. Product Parameters

Displays the Options - Product Parameters pop-up used to
set parameters that affect the online operation of Insight.

2. Product Allocations

Displays the Options - Product Allocations pop-up used to
specify DASD volumes for the Log, List, Punch, and Work
files, and to specify space for the Work file.

3. Log/List/Punch

Displays the Options - Log/List/Punch Definition pop-up
used to set values for allocating, formatting, and processing
the Insight Log, List, and Punch files.

4. Script File Allocations

Displays the Options - Script File Allocations pop-up used
to modify the default script file dataset names for your
session.

5. PF Keys Displays the Options - PF Key Definition pop-up used to
display or change PF key values.
6. Modes Displays the Options - Processing Modes pop-up used to

enable and disable Insight processing modes.
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Action Description

7. Scratchpad Displays the Options - Scratchpad pop-up used to select
options for equates and marks.

8. Refresh Updates the CALL summaries for programs CALLed by
the active program.

Options - Product Parameters Pop-up

To set the Insight online operation parameters, follow this step:

» Select Options » Product parameters, or type PARMDEF on any screen, and press Enter.
The Options - Product Parameters pop-up, shown in Figure 83, displays.

Figure 83 « Options - Product Parameters Pop-up

Options - Product Parameters
Command ===>

Type the desired parameters below to customize the operation of
the product. Then press Enter.

Alarm . . . . . . . YES (Yes or No)
Save Equates . . . . NO (Yes or No)
Save Marks . . . . . NO (Yes or No)
Cursor character . . % (token substitution character)
Fields
Field Description
Alarm Controls the audible alarm on the terminal. Type YES for the alarm to
sound when an error message displays. Type NO for no alarm. The
default is YES.
Save Equates Saves equates at the end of a Source View session. Type NO if you do

not want to save equates. This value can be overridden when using the
END, GOBACK, PROGRAM, RETURN, and SAVE commands.
The default is YES.

See "EQUATE Command" on page 201 for more information about

equates.
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Field Description

Save Marks Saves marks at the end of a Source View session. Type NO if you do
not want to save marks. This value can be overridden when using the
END, GOBACK, PROGRAM, RETURN, and SAVE commands.
The default is YES.

See the "MARK Command" on page 264 for more information about
user marks.

Cursor Sets the cursor token substitution character. The default is %. Cursor

Character substitution saves time by allowing you to use this character in a
command and then place the cursor under the token in the source
code.

See "Cursor Substitution Character" on page 183 for more
information.

Options - Product Allocations Pop-up
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To specify the DASD volumes for the Log, List, Punch, and Work files; and to specify
Work file space, follow this step:

» Select Options » Product allocations, or type ALLOCDEF on any screen, and press
Enter. The Options - Product Allocations pop-up, shown in Figure 84, displays.

Figure 84 « Options - Product Allocations Pop-up

Options - Product Allocations
Command ===>
Log file:
Management Class MGMT1 Generic unit . . . SYSDA
Storage Class . . STOR1 Volume serial
List file:
Management Class MGMT1 Generic unit . . . SYSDA
Storage Class . . STOR1 Volume serial
Punch file:
Management Class MGMT1 Generic unit . . . SYSDA
Storage Class . . STOR1 Volume serial
Work file:
Management Class MGMT1 Generic unit . . . SYSDA
Storage Class . . STOR1 Volume serial
Data Class . . . . DATAl Space units . . . CYLS
Primary space . . 1
Secondary space 1




Fields
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Log File

Specifies the SMS classes or the device type and volume serial
number for the Insight Log file. The Log file is used for error
messages and log commands. The file characteristics are specified on
the Options - Log/List/Punch Definition pop-up. The log file name is
useridINSnnnnn.VIALOG. If the TSO prefix is different from
the user ID, the dataset name is preceded by the prefix value.

List File

Specifies the SMS classes or the device type and the volume serial
number for the List file, that is allocated the first time you type
LPRINT. The List file is used for LPRINT output. The file
characteristics are specified on the Options - Log/List/Punch
Definition pop-up. The list file name is
useridINSnnnnn.VIALIST. If the TSO prefix is different from
the user ID, the dataset name is preceded by the prefix value.

Punch File

Specifies the SMS classes or the device type and the volume serial
number for the Punch file, that is allocated the first time you type
LPUNCH. The Punch file is used for LPUNCH output. The file
characteristics are specified on the Options Log/List/Punch
Definition pop-up. The punch file name is
useridINSnnnnn.VIAPUNCH. If the TSO prefix is different
from the user ID, the dataset name is preceded by the prefix value.

Work File

Specifies the SMS classes or the device type, volume serial number,
and space requirements for the Work file space that is allocated upon
entry into Insight. The Work file is a temporary file. Space
requirements for it depend on the size of the COBOL programs you
work with. Approximately one cylinder is required for a 5,000 line
program on a 3380 device.
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Options - Log/List/Punch Definition Pop-up

To set values for allocating, formatting, and processing the Insight Log, List, and Punch
files, follow this step:

P Select Options » Log/list/punch, or type PRINTLOG or PRINTLST on any screen, and
press Enter. The Options - Log/List/Punch Definition pop-up, shown in Figure 85,
displays.

Figure 85 » Options - Log/List/Punch Definition Pop-up

Options - Log/List/Punch Definition
Command ===>

1 - Process LOG File 2 - Process LIST File 3 - Process PUNCH File

Options LOG LIST PUNCH
Process Option . . . . . . PD PD PK
Primary tracks J e 1 1
Secondary tracks .. 2 5 5
Lines per page . . . . . . 56 56 56
Sysout class . . . . . . . * * *

Process Options: PK (Print/Keep), PD (Print/Delete), K, or D.
LOG FILE IS ALLOCATED

Job Statement Information:

/ /NAME JOB (ACCOUNT) , NAME

// MSGCLASS=A

/* INSERT '/*ROUTE PRINT NODE.USER' HERE IF NEEDED.
//*

An internal error allocates the Log file. The List file is allocated the first time you type
LPRINT. The Punch file is allocated the first time you type LPUNCH.

The Options - Product Allocations pop-up specifies the Log, List, and Punch file
volumes.
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Options

Option Description

1 - Process LOG File Verify or change the Options for the Log file and type 1 to
process the Log file. If the PK or PD Process Option is
specified, type the required Job statement information prior
to selecting this option. The Log file is processed when you
press Enter. You do not need to exit Insight to print the Log
file. By default, the log file name is
userid. INSnnnnn. VIALOG. If the TSO prefix is different
from the user ID, the dataset name is preceded by the prefix
value.

2 - Process LIST File Verify or change the Options for the List file and type 2 to
process the List file. If the PK or PD Process Option is
specified, type the required Job statement information prior
to selecting this option. The List file is processed when you
press Enter. You do not need to exit Insight to print the List
file. The list file name is userid.INSnnnnn.VIALIST. If
the TSO prefix is different from the user ID, the dataset name
is preceded by the prefix value.

3 - Process PUNCH File Either verify or change the Options for the Punch file and
type 3 to process the Punch file. If the PK or PD Process
Option is specified, type the required Job statement
information prior to selecting this option. The Punch file is
processed when you press Enter. You do not need to exit
Insight to process the Punch file. Notice that the allocation of
the Punch file is used by the Browse facility for determining
the space used by the temporary file created during a Browse
session. The punch file name is
userid.INSnnnnn.VIAPUNCH. If the TSO prefix is
different from the user ID, the dataset name is preceded by
the prefix value.

Field Description

Process Option Specifies one of the valid processing options. The default is PD for
the Log and List files, and PK for the Punch file.

Fields

Primary tracks Specifies the number of primary tracks to allocate. A size change
does not take effect until the next allocation occurs. The default is 1.

Secondary tracks  Specifies the number of secondary tracks to allocate. A size change
does not take effect until the next allocation occurs. These are the
defaults: 2 for the Log file, 5 for the List and Punch files.
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Field Description

Lines per page Specifies the number of lines to print per page. Standard maximum
values are 60 for 6 lines per inch and 80 for 8 lines per inch. The
default is 56.

Sysout class Specifies the SYSOUT class value. The default is *, that sends the

SYSOUT to the destination identified in the MSGCLASS parameter
on the JOB statement.

Process Options  Lists the options available for the Log, List, and Punch files. These
are the valid values:

PK Print and keep

K Keep without printing
PD Print and delete

D Delete without printing

XxXxXXFILEIS  Displays when the Log, List, or Punch file is properly allocated. If

ALLOCATED the message does not appear, check the assignments on the
Options - Product Allocations pop-up. XXXXX is LOG, LIST, or
PUNCH depending on the file that was allocated.

Job Statement Specifies the correct job statement information for your installation.
Information These JCL statements are required if the PK or PD process option is
specified.
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Fields

Usage Notes

8 Options

Script File Allocations Pop-up

To display and/or modify the default script file concatenation sequence for your session,
follow this step:

» Select Options » Script file allocations and press Enter. The Options - Script File
Allocations pop-up, shown in Figure 86, displays.

Figure 86 » Options - Script File Allocations Pop-up

File View Search Logic Task List Options Help
Options - Script File Allocations
Command ===>

R - Restore default Script allocations
Enter desired Script file concatenation.

Script file data set names:

'ASG.UTIL.SCRIPT'

Field Description

Restore default Script Allocations  Restores the defaults set during the install process.

Script File Data Set Names Specifies the dataset names for the desired default
script files. The files are concatenated in the order
entered.

Note:

When initializing for defaults, the lines fill from the bottom to allow concatenation.

Default script files are specified for your site when Insight is installed. You can use the
Options - Script File Allocations pop-up to modify the default dataset names or the
concatenation sequence for the script files. The changes are maintained in your profile.
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Options - PF Key Definition Pop-up

To display and/or redefine PF key values, follow this step:

» Select Options » PF keys, or type KEYS on any Insight screen. The Options - PF Key
Definition pop-up, shown in Figure 87, displays.

PF keys 1 through 12 initially display. A similar screen exists for PF keys 13 through 24,
that displays by pressing Enter. Any command or data value can be assigned to a PF key.

Figure 87 » Options - PF Key Definition Pop-up

Command ===>

Options - PF Key (01-12) Definition

PFO1 HELP
PF02 SPLIT
PF03 END
PF04 RPREF
PFO5 RFIND
PF06 FX %
PFO7 UP
PF08 DOWN
PF09 SWAP
PF10 BRANCH
PF11 BRANCH BACKUP
PF12 RECALL

Press Enter to process changes and/or to display alternate keys.
Press PF3/15 (END) to exit.

Number of PF keys:

Terminal type: 3278

Fields

Field Description

Number of PF Keys

Specifies the number of PF keys supported.

Terminal Type

Indicates the type of terminal being used. Insight supports
these 3270 type terminals:

. Model 2 (24 lines x 80 columns)
. Model 3 (27 lines x 80 columns)
. Model 4 (43 lines x 80 columns)

. Model 5 (27 lines x 133 columns)

PFO1 through PF12 or
PF13 through PF24

Specifies the values assigned to the PF keys, that you can

change by typing over the number. To reset a PF key to its
default value, delete the entry and press Enter. To set a PF
key to have no value (i.e., to turn off a PF key) type NOP.
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8 Options

When Insight is installed, PFO1 through PF12 and PF13 through PF24 are set to the

default values for the primary PF keys. These are the default values:

Value Description

PF01/13 HELP
PF07/19 UP
PF02/14 SPLIT
PF08/20 DOWN
PF03/15 END
PF09/21 SWAP
PF04/16 RPREF
PF10/22 BRANCH
PFO05/17 RFIND
PF11/23 BRANCH BACKUP
PF06/18 FX %
PF12/24 RECALL
Note:

The alternate PF keys may be PFO1 through PF12 or PF13 through PF24, depending on

your site's specifications.
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Options - Processing Modes Pop-up

To set processing modes

1 Select Options » Modes and press Enter. The Options - Processing Modes pop-up,
shown in Figure 88, displays.

2 Change the settings by typing over them.

You can also change the setting using the SET command, for example, by typing
SET LEARN ON. See "SET Command" on page 311 for more information.

Figure 88 « Options - Processing Modes Pop-up

Options - Processing Modes
Command ===> Scroll ===> CSR

Type option settings. Then press PF3/15 (END) to save options and exit.

Option Set Description

LEARN OFF Display internally generated Primary Commands
SCRIPT OFF Script facility is disabled

XMODE OFF Exclude all lines before executing Primary Commands

Fields

Field Description

Option The processing mode to be enabled or disabled.

LEARN When LEARN is ON, all primary commands generated
internally when actions from the pull-downs are executed
display on the LEARN Mode - Generated Command pop-up.
See the "SET Command" on page 311 for more information.
The default for this option is OFF.

SCRIPT When SCRIPT is ON, a script file is allocated. From that point
on, all Insight primary commands are captured in this file.
When SCRIPT is OFF, the file is closed and saved. The script
file name is userid.INSnnnnn.VIASCRIP. If the TSO
profile prefix is not the same as the user ID, then this name is
preceded by a prefix value.

XMODE When XMODE is ON, all lines are excluded from the screen
before a primary command is executed. The default is OFF.
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Field Description

Set Displays current setting for each mode. You can change the settings by
typing over them. Values not set to the default status are shown in bold.

Description Provides descriptions of the options. The Script facility description also
indicates whether it is enabled or disabled.

Options - Scratchpad Pop-up

Options

Use the Options - Scratchpad pop-up to define equates and to create, copy, delete, merge,
or rename marks.

To display the Options - Scratchpad pop-up, follow this step:

» Select Options P Scratchpad and press Enter. The Options - Scratchpad pop-up, shown
in Figure 89, displays.

Figure 89 » Options - Scratchpad Pop-up

Options - Scratchpad

Select the desired option to create or modify
Equates and Marks. Then press Enter.

Options

1 1. Equate...
Mark. ..
Copy...
Delete...
Merge...
Rename. ..

o Ul W N

Option Description

Equate Displays the Options - Scratchpad Equate pop-up used to define a
unique name representing a character string or group of data items. See
"Options - Scratchpad Equate Pop-up" on page 162 for more
information.

Mark Displays the Options - Scratchpad Mark pop-up used to save the
requested target as a mark set or path. See "Options - Scratchpad Mark
Pop-up" on page 164 for more information.
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Option Description

Copy Displays the Options - Scratchpad Copy pop-up used to copy a mark
set or path. See "Options - Scratchpad Copy Pop-up" on page 165 for
more information.

Delete Displays the Options - Scratchpad Delete pop-up used to delete a mark
set or a path. See "Options - Scratchpad Delete Pop-up" on page 167
for more information.

Merge Displays the Options - Scratchpad Merge pop-up used to add the lines

from the specified target to the specified mark name. See "Options -
Scratchpad Merge Pop-up" on page 168 for more information.

Rename Displays the Options - Scratchpad Rename pop-up used to change the
name of a mark path or a set of lines. See "Options - Scratchpad

Rename Pop-up" on page 169 for more information.

Options - Scratchpad Equate Pop-up
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To define a character string name, follow this step:

» Select Equate on the Options - Scratchpad pop-up and press Enter. The
Options - Scratchpad Equate pop-up, shown in Figure 90, displays.

Figure 90 » Options - Scratchpad Equate Pop-up

Options - Scratchpad Equate
To create an equate, type a name and string. Then press Enter.
Equate name

Equated string
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Fields

Fields Description

Equate name Specifies the name that you want to assign to the character
string. Names must conform to these standards:

. 1 to 10 alphanumeric characters

. First character must be alphabetic or a period

* A hyphen is the only special character allowed
. May be 1 to 4 DBCS characters

Equated string Specifies a character string to be substituted by the equate.
A character string can be a long command, pattern,
dataname, or concatenated dataname, etc. You can specify
literals and blanks in the character string if desired. The
string may be a DBCS string. If the equated string is not
entered, the equate name is deleted.
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Options - Scratchpad Mark Pop-up

To save the requested target as a mark set or path, follow this step:

» Select Options » Mark and press Enter. The Options - Scratchpad Mark pop-up, shown
in Figure 91, displays.

Figure 91 « Options - Scratchpad Mark Pop-up

Options - Scratchpad Mark
To create a mark, type a name and a target. Then press Enter. For a
name selection list for a target type, type a pattern (e.g. ABC*) in
the target name area.

Mark name . .

Target name .

Target type

1 1. Mark name
2. Perfrange name
3. Program name
4. Subset name
5. Line range
6. Label name
Comments . .

Fields

Field Description

Mark name Specifies the name you want to assign to the set of lines or path. The
name must be 1 to 10 alphanumeric characters.

Target name Specifies the name of the target you want to save.
Target type Specifies the type of target you want to save.
Mark name A 1 to 10 alphanumeric character name given to a set or path using

the COPY, MARK, MERGE, or RENAME commands, or one of
these system-generated paths:

System generated path: Created by:
TRACK | TRK A TRACE command.
NETWORK | NET A FLOW command.

SUBNETR | SUBnR A path created by the FLOW command that
reaches from the beginning of the
NETWORK to one of the results (nth
result).
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Field Description

Note:

The TRACK, NETWORK, and SUBNET paths can also be created
using the Logic Order Search pop-ups (see "Logic Pull-down" on

page 101).
Perfrange The name specified in a PERFORM statement including all
Name statements executed as a result of a PERFORM statement, or the

name of any section contained in the Declaratives.

Program Name The name of the main program or any nested program representing
all the code contained in the program. This includes all the programs
physically nested inside the specified program.

Subset Name A predefined COBOL language subset. See the ASG-Insight User’s
Guide for a list of each subset and its description.

Line Range A single line number or range of lines. Line numbers display in
columns 1 through 6 of Source View.

Label Name Any PROCEDURE DIVISION paragraph name or section name.
The PROCEDURE and PROC literals can also be specified.

Comments Provides a description or other comments for the mark.

Options - Scratchpad Copy Pop-up

To copy the contents of a path or set of lines to a mark, follow this step:

»

Select Copy on the Options - Scratchpad pop-up and press Enter. The
Options - Scratchpad Copy pop-up, shown in Figure 92, displays.

Figure 92 » Options - Scratchpad Copy Pop-up

To create a mark, type a name and a target. Then press Enter. For a
name selection list for a target type, type a pattern (e.g. ABC*) in
the target name area.

Mark name . .

Target name .

Target type

1 1. Mark name
2. Perfrange name
3. Program name
4. Subset name
5. Line range
6. Label name
Comments

Options - Scratchpad Copy
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Fields
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Mark name

Specifies the name you want to assign to the set of lines or path. The
name must be 1 to 10 alphanumeric characters.

Target name

Specifies the name of the target you want to save.

Target type

Specifies the type of target you want to save.

Mark name

Specifies a 1 to 10 alphanumeric character name given to a set or path
using the COPY, MARK, MERGE, or RENAME commands, or one of
these system-generated paths:

System generated path:  Created by:
TRACK | TRK A TRACE command.

NETWORK | NET A FLOW command.

SUBNETn | SUBn A path created by the FLOW command that
reaches from the beginning of the
NETWORK to one of the results (nth
result).

Note:

The TRACK, NETWORK, and SUBNET paths can also be created
using the Logic Order Search pop-ups (see "Logic Pull-down" on

page 101).

Perfrange
name

Specifies the name in a PERFORM statement, including all of the
statements executed as a result of a PERFORM statement, or the name
of any section contained in the Declaratives.

Program
name

Specifies the name of the main program or of any nested program
representing all of the code contained in the program. This includes all
of the programs physically nested inside the specified program.

Subset
name

Specifies a predefined COBOL language subset. See the ASG-Insight
User’s Guide for a list of each subset and its description.

Line range

Label name

Specifies a single line number or a range of lines. Line numbers display
in columns 1 through 6 of Source View.

Specifies any PROCEDURE DIVISION paragraph name or section
name. You can also specify the PROCEDURE and PROC literals.

Comments

Provides a description or other comments for the mark.
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Usage Notes

You can also copy paths and sets using the COPY command. See the "COPY Command"
on page 194 for more information.

Options - Scratchpad Delete Pop-up

To delete a mark set or path, follow this step:

» Select Delete on the Options - Scratchpad pop-up and press Enter. The
Options - Scratchpad Delete pop-up, shown in Figure 93, displays.

Figure 93 « Options - Scratchpad Delete Pop-up

Options - Scratchpad Delete
To delete a mark, type the mark name. Then press Enter.

Mark name . .

Field

Field Description

Mark name  Specifies the name of the mark you want to delete.

Usage Notes

You can also delete marks using the DELETE command. See the "DELETE Command"
on page 198 for more information.
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Options - Scratchpad Merge Pop-up

To add the lines from the specified target to the specified mark name, follow this step:

P Select Merge on the Options - Scratchpad pop-up and press Enter. The

Options - Scratchpad Merge pop-up, shown in Figure 94, displays.

Figure 94 « Options - Scratchpad Merge Pop-up

Options - Scratchpad Merge

name selection list for a target type,
the target name area.

Mark name . .

Target name .

To expand a mark, type the name and target.
type a pattern (e.g. ABC*) in

Then press Enter. For a

Target type

1 . Mark name
Perfrange name
Program name
Subset name
Line range
Label name

o) Ul s W N

Comments

Fields

Field Description

Mark name

Specifies the name you want to assign to the new set of lines or path. The

name must be 1 to 10 alphanumeric characters.

Target name Specifies the name of the target you want to add.

Target type Specifies the type of target you want to add.

Mark name A 1 to 10 alphanumeric character name given to a set or path using the
COPY, MARK, MERGE, or RENAME commands, or one of these

system-generated paths:

System generated path: Created by:

TRACK | TRK
NETWORK | NET
SUBNETn | SUBn

A TRACE command.
A FLOW command.

A path created by the FLOW command that
reaches from the beginning of the NETWORK
to one of the results (nth result).

Note:

The TRACK, NETWORK, and SUBNET paths can be created using
the Logic Order Search pop-ups (see "Logic Pull-down" on page 101.
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Field Description

Perfrange = The name specified in a PERFORM statement, including all statements
name executed as a result of a PERFORM statement, or the name of any
section contained in the Declaratives.

Program The name of the main program or of any nested program representing all
name of the code contained in the program. This includes all of the programs
physically nested inside the specified program.

Subset A predefined COBOL language subset. See the ASG-Insight User’s
name Guide for a list of each subset and its description.

Line range A single line number or a range of lines. Line numbers display in
columns 1 through 6 of Source View.

Label Any PROCEDURE DIVISION paragraph name or section name. You
Name can also specify the PROCEDURE and PROC literals.
Comments Provides a description or other comments for the mark.

Usage Notes

You can also merge marks using the MERGE command. See the "MERGE Command"
on page 267 for more information.

Options - Scratchpad Rename Pop-up
To change the name of a mark path or set of lines, follow this step:

» Select Rename on the Options - Scratchpad pop-up and press Enter. The
Options - Scratchpad Rename pop-up, shown in Figure 95, displays.

Figure 95 ¢ Options - Scratchpad Rename Pop-up

Options - Scratchpad Rename

To rename a mark, type the old and new
name. Then press Enter.

0ld mark name

New mark name
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Fields

Field Description

Old mark name Specifies the mark name that you want to change.

New mark name  Specifies the new name that you want to assign to the mark. The
name must be 1 to 10 alphanumeric characters.

Usage Notes

Marks can also be renamed with the RENAME command. See the "RENAME
Command" on page 289 for more information.
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This chapter describes items on the Insight Help menu options and contains these
sections:

Topic Page

Help Pull-down 172
Help - Specific ASG Command Pop-up 174
Help - Specific ASG Message Number Pop-up 175
Help - About Pop-up 175
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Help Pull-down

Actions

172

To access the online help facility, follow this step:

» Select Help on the action bar and press Enter. The Help pull-down, shown in Figure 96,
displays.

Figure 96 « Help Pull-down
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1. Current Screen Displays help for the screen or pop-up that is currently displayed.

2. Current Message  Displays help for the message that is currently displayed.

3. All Commands Displays a complete list of all Insight primary commands, where
specific command information displays by selecting the
appropriate number.

4. Specific Command Displays the Help - Specific ASG Command pop-up used to
obtain help about a specific Insight primary command.

5. Specific Message  Displays the Help - Specific ASG Message Number pop-up used
to obtain help about a specific message number.

6. Common Abends  Displays the Abends screen, where you can display information
about a specific abend by selecting the appropriate number.
Select topic 2 on this screen to display the ASG Abend Codes
screen, that lists all the user abends and their explanations.
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Action Description

7. Table of Contents  Displays the Help Table of Contents used to request help for
general information. See the "Help Facility" on page 391 for
more information and an example of the online Help Table of
Contents.

8. Index Displays the Help Index used to request help for specific
information. See the "Help Facility" on page 391 for more
information and an example of the online Help Index.

9. Action Bar Displays the Action Bar help pop-up that contains general
information about the action bar and selections to help for each
of the pull-downs.

10. About Displays the Help - About pop-up that lists information about the
currently installed levels of Insight and Center.

Usage Notes

You can also use the HELP command to access help. See the "HELP Command" on
page 234 for more information.
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Help - Specific ASG Command Pop-up
To obtain help about a specific Insight primary command, follow this step:

» Select Help » Specific ASG Command and press Enter. The Help - Specific ASG
Command pop-up, shown in Figure 97, displays.

Figure 97 « Help - Specific ASG Command Pop-up

Help - Specific ASG Command
To display a message that describes a ASG
command, type the command below. Then press
Enter.

Command .

To display additional command information, enter
the HELP command (PF1/13) from the screen that
displays the command message.

Field Description

Command Specifies a primary command. The Help Tutorial for that command
displays. See the "Help Facility" on page 391 for more information.

Fields
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Help - Specific ASG Message Number Pop-up

To display help for a specific messageASG, follow this step:

» Select Help » Specific ASG Message Number and press Enter. The Help - Specific
ASG Message Number pop-up, shown in Figure 98, displays.

Figure 98 « Help - Specific ASG Message Number Pop-up

Help - Specific ASG Message Number

To display the description of a message, type
the message number below. Then press Enter.

Message . . . .

Fields

Field Description

Message Specifies a message number. The HELP Explanation and Action
Panel for that message displays. See the "Help Facility" on page 391
for more information.

Help - About Pop-up

To display information about the currently installed releases of Insight and Center, follow
this step:

» Select Help » About and press Enter. The Help - About pop-up, shown in Figure 99,
displays.

Figure 99  Help - About Pop-up

Help - About

The following is release information for this
ASG product.

Product name . . . . . . . : ASG-Insight
Release number . . . . . @ X.X
Maintenance level . . . . : nnn

ASG-Center release number : X.X
Maintenance level . . . . : nnn

Operating system . . . . . : MVS(ESA)
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Fields

Field Description

Product name Specifies Insight or the name of the ESW product you are
currently running.

Release number Specifies the currently installed release number of Insight.
Maintenance level Specifies the currently installed Insight PRS number.
ASG-Center release Specifies the currently installed release number of Center.
number
Maintenance level Specifies the currently installed Center PTF number.
Operating system Specifies the operating system you are running.

Note:

This information is requested when you contact the ASG
Service Desk for assistance. You can also display this
information by typing PRODLVL on any screen.
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Commands

This chapter describes Insight commands and contains these sections:

Topic Page

Command Processing 180
Recalling/Repeating Commands 181
Cursor Position 182
Cursor Substitution Character 183
Command Diagrams 183
& (Retain) Command 186
ALLOCDEF Command 187
ANALYZE Command 188
BRANCH Command 189
CALL Command 192
CANCEL Command 193
COPY Command 194
CURRENT Command 197
DELETE Command 198
END Command 200
EQUATE Command 201
EXCLUDE Command 203
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Topic Page

EXECUTE Command 209
FIND Command 212
FINDXTND Command 216
FLOW Command 228
GOBACK Command 233
HELP Command 234
HIGH Command 235
JUMP Command 242
KEYS Command 243
LEVELS Command 245
LIST Command 246
LOCATE Command 248
LPRINT Command 250
LPUNCH Command 257
MARK Command 264
MERGE Command 267
PARMDEF Command 270
PREF Command 271
PRINTLOG Command 274
PRINTLST Command 275
PROCESS Command 276
PRODLVL Command 280
PROGRAM Command 281
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QUALIFY Command 282
RECALL Command 283
REDO Command 286
REFRESH Command 288
RENAME Command 289
REPEAT Command 290
RESET Command 291
RETURN Command 292
RFIND Command 293
RHIGH Command 294
RPREF Command 295
RSCROLL Command 296
RSTRUCTURE-VIEW Command 297
RTRACE Command 298
RTREEVW Command 301
SAVE Command 302
SCROLL Command 303
SELECT Command 310
SET Command 311
SOURCEVIEW Command 312
STRUCTURE-VIEW Command 313
TRACE Command 15

TREEVIEW Command 321
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VIEW Command 323
ZOOMIN/ZOOMOUT Commands 324
Line Commands 325

In addition to processing requests from pull-downs and pop-ups, Insight accepts the
primary and line commands that you enter in the same manner as ISPF commands. You
can enter primary commands on screens and pop-ups that contain a command input area;
line commands are entered in a selection column field or in the prefix area over the line
numbers in Source View. Insight supports all ISPF system commands on the appropriate
screens. All Insight commands are described in this chapter.

Some of the most frequently used commands have been assigned to PF keys. The KEY'S
command can be entered from any command input area to change the PF key
assignments. See the online help for detailed information about PF key assignments.

Command Processing

Insight line commands process before primary commands. Commands you enter by
pressing a PF key are handled as if you entered them in the command input area. If you
enter a command by pressing a PF key and there is a command in the command input
area, the contents of the command input area append to the PF key command. The
combined commands then execute as a whole. Multiple commands entered in the
command input area are separated by a semicolon (;) and process in a left-to-right
sequence. Command results display when one of these conditions occur:

. The last command processes and all commands in the sequence complete
successfully.

. A command is not successfully processed. If an error occurs in the sequence,
processing stops and an error message displays. Results display for the commands
that successfully completed. The command causing the error and all remaining
commands in the sequence display in the command input area.

Each command in a command sequence is recognized separately for use with the
RECALL command.
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10 Commands - Command Processing

Insight remembers the last twenty primary commands entered. These methods can be

used to repeat commands:

Type RECALL to display the last command entered in the command input area.
After the recalled command displays, it can be modified, deleted, or executed again.
Enter the RECALL command repeatedly to display the commands in reverse
sequence without executing them. To execute a recalled command, press Enter
while the command displays in the command input area.

Type REPEAT to execute the last stacked primary command again (if it is a

repeatable command).

These are the Insight primary commands that can be repeated:

BRANCH
CANCEL
COPY
DELETE
EQUATE
EXCLUDE
EXECUTE
FIND
FINDXTND
FLOW
HIGH
LIST
LPRINT
LPUNCH
MARK

MERGE

PREF
REFRESH
RENAME
RESET

RPREF
SCROLL
SELECT

SET
SOURCEVIEW
STRUCTURE-VIEW
TRACE
TREEVIEW
ZOOMIN
Z0OMOUT
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These methods can be used to repeat the last primary command entered:

Use the & (Retain) command preceding a primary command to keep the command
displayed in the command input area after execution. This is the quickest way to
repeat a command when minor changes are required before execution.

Use the REDO command to re-execute the last FIND, FINDXTND, HIGH, PREF,

SCROLL, or TRACE command (see "REDO Command" on page 286 for more
information).

Use the RFIND command to repeat the last FIND or FINDXTND command from
the cursor position. PF05/17 is the default PF key for the RFIND command.

Use the RHIGH command to repeat the last HIGH command from the cursor
position.

Use the RPREF command to display the last View - Paragraph Cross Reference
pop-up or to function as a PREF command with the cursor location as the target and
default direction (see "RPREF Command" on page 295 for more information).
PF04/16 is the default PF key for the RPREF command.

Use the RSCROLL command to repeat the last SCROLL command from the cursor
position.

Use the RTRACE command to continue the last TRACE command from where it
stopped (see "RTRACE Command" on page 298 for more information). PF06/18 is
the default PF key for the RTRACE command.

Cursor Position

182

The result of the command depends on the starting point of the search. You can specify a
starting point by entering a line number or a label name, or by using the cursor as the
starting point. These are the rules if the cursor is used as the starting point:

Command input area In the first column of the first source line on the screen
Line command area From the first column on that line
Program source From the cursor position
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Cursor Substitution Character

The cursor character is a token substitution character that you can use in any primary
command on the Source View screen. A token is a contiguous set of characters preceded
by and followed by a blank, period, comma, or parenthesis. You define the cursor
substitution character on the Options - Product Parameters pop-up. You may choose any
character, but it should be one that is unique and rarely used in commands. The default is
percent (%).

The cursor substitution character saves you time and typing effort when you are working
with commands. Type the cursor substitution character anywhere on the command line,
then place the screen cursor on the token that is to replace it in the command. For
example, to find all occurrences of HLD-ZIP-PREFIX, type FINDXTND in the command
input area:

FX %

Then place the screen cursor anywhere on HLD-ZIP-PREFIX in the source code. The
command FX HLD-ZIP-PREFIX executes when you press Enter. Notice that the cursor
substitution character must have a space before and after it.

You can use multiple cursor tokens to specify consecutive tokens in the source code. For
example:

FX % % %

If you then place the screen cursor on HLD-ZIP-PREFIX, the next two tokens are picked
up in the command, resulting in the command FX HLD-ZIP-PREFIX OF HLD-ZIP. The
first token is HLD-ZIP-PREFIX, the second token is OF, and the third token is HLD-ZIP.
The tokens must be consecutive.

Command Diagrams

These are the notational conventions and symbols used to describe command syntax:

Item Description

ABBREViations Illustrates the command abbreviation, which is shown in
uppercase letters. Lowercase letters in the command are optional.

lowercase Indicates user-supplied variable information.

UPPERCASE Indicates commands or keywords.
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Item Description

Bold Indicates operands that are available only if Insight is installed and
a Insight analysis has been run on the COBOL program being
tested.

Underline Specifies the default value of an operand.

| Separates synonymous commands or operands.
5 Indicates that the command syntax is continued on the next line.
Indicates the command syntax is continued from the previous line.
-
o Indicates the end of the command syntax.
__ required — Indicates that the operand or keyword appearing on the main
quired o -
command line is required.
choice1 Indicates that one operand is required.
—EchoiceZ
choice3
Cootionar] Indicates that an operand or keyword appearing below the main
optiona command line is optional.
, Indicates that operands are optional.
tch0|ce1—
choice2—
S E— Indicates that more than one operand can be chosen.
I:choice1—
choice2—

VAR

I:choice1—
choice2—

Indicates that operands can be concatenated by placing a plus sign
(+) between them.
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Figure 100 illustrates a syntax diagram for the LPUNCH command. LPUNCH or a
minimum of LPU can be entered. You must enter LPUNCH with a target operand as
indicated by the name variable on the main path of the line. If the path is followed down
the first or second vertical line, you can specify any of the target operands or an asterisk
(*). If you specify more than one operand, separate each with a space. Operands that can
be concatenated are indicated by a returning arrow that includes a plus sign (+) in the line.
Dataname operands (Ref, Use, etc.) pertain to all datanames in a concatenated series.

Continuation lines are numbered 1 and 2 with 1 being the main path of the line.
Continuation line 2 shows that the asterisk (*) operand is entered with no other values
since the line from it extends to the end of the path, bypassing the direction and intarget
operands. The direction and intarget operands are optional since they are below the main
path of the line.

Figure 100 « Command Syntax Diagram
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& (Retain) Command

A\ 4
A

&any primary command

Function

The Retain command executes the specified primary command and keeps it displayed in
the command input area for repeated use or modification.

Operands

Ampersand (&) must be followed by a primary command.

Usage Notes
The Retain command is useful if you want to repeatedly execute the same primary
command or make minor changes to a command.

For example, after you execute the FINDXTND command for a data item, you may
desire to execute an LPRINT command on the same data item. You could perform this
function quickly and easily by using the retain command.

Example

To find the EOF-FLAG and keep &FINDXTND EOF-FLAG displayed in the command
input area, type this command:

&FINDXTND EOF-FLAG
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ALLOCDEF Command

Y
A

ALLOCDEF | ADEF

Function
The ALLOCDEF command displays the Options - Product Allocations pop-up used to
specify the DASD volumes for the Log, List, Punch, and Work files; and to specify space
for the Work file.

Operands
None.

Usage Notes

The Options - Product Allocations pop-up can also be displayed by selecting Options P
Product allocations and pressing Enter.

You can enter the ALLOCDEF command on any screen.
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ANALYZE Command

ANalyze

Function

Operands

Usage Notes

188

A\
A

The ANALYZE command displays the File - Analyze Submit pop-up used to submit a
compile/analyze job without ending the current Insight function. A program must be
analyzed before it can be used in Insight.

None.

The File-Analyze Submit pop-up can also be displayed by selecting File » Analyze and
pressing Enter.

You can use the ANALYZE command on any Insight screen. If viewing a program in
Source View and a program is encountered that has not been analyzed, perform these
steps:

To analyze a program

1 Type ANALYZE in the command input area.

2 Submit the analyze job for the program.

3 Type END in the command input area.

TSO displays a message when the analyze job has completed. Use the CALL, VIEW, or
PROGRAM command to view the program.

Note:

See "Analyze" on page 339 for additional information about submitting an analyze job.
See the online help for more information about the File - Analyze Submit pop-up.
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BRANCH Command

Branch

I

name—
—PERFRANGE—
—PROGRAM——
—LABEL
—PARAGRAPH—
—BACKup————————
—PREVIOUS

Function
The BRANCH command is used to position the cursor at the specified target. This
command is used to scroll from a statement such as a PERFORM, to the paragraph being
performed. Use the BACKUP operand to return to the statement where the BRANCH
occurred.
Operands
Blank No operand is required if the cursor is positioned on a GO TO or
PERFORM statement. The BRANCH command automatically
locates the target of the GO TO, PERFORM, or internal CALL
statement. Internal CALL statements are the CALLs in a COBOL
I Release 3 program that call programs located in the same source
module. If the cursor is positioned on any other statement, the
BRANCH command locates the next sequential statement to be
executed. The PROCEDURE DIVISION label is located if the
cursor is positioned outside the PROCEDURE DIVISION.
PERFRANGE Locates the specified PERFORM range. If the specified name is
name not fully qualified and there are multiple PERFORM ranges with

the specified name, the cursor is positioned on the first PERFORM
range found. A message displays indicating the number of
PERFORM ranges found.

PROGRAM name Locates the specified nested program. For COBOL II Release 3 or
later programs, a data item, label, or program name that may be
ambiguous or used multiple times can be qualified by using OF
followed by the program name. For example, if the label
P120-READ exists in another program and also in the program
VIAIDEMI, it can be qualified as P120-READ OF VIAIDEMI.
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Usage Notes
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LABEL name Locates the specified paragraph or section name. If the specified
name is not fully qualified and there are multiple paragraphs or
sections with the specified name, the cursor is positioned on the
first paragraph or section found. A message displays indicating the
number of paragraphs or sections found.

PARAGRAPH Locates the specified paragraph name. If the specified name is not

name fully qualified and there are multiple paragraphs with the specified
name, the cursor is positioned on the first paragraph found. A
message displays indicating the number of paragraphs found.

BACKup Positions the cursor where the Branch occurred.

PREVious Works in conjunction with the current cursor location to position
the cursor at the GO TO, PERFORM, or CALL statement where a
target was reached.

Note:

If more than one statement transfers control to the specified branch location (or cursor
position), the Branch Previous Options pop-up displays.

The Branch function can also be initiated from the Search - Branch Request pop-up. To
display the Search - Branch Request pop-up select Search » Branch and press Enter. See
the online help for more information.

The BRANCH command is very helpful when you are tracking branching logic. This
command can be used to track branching logic several levels deep into PERFORMed
code, then return to each PERFORM statement. An effective way to use the BRANCH
command is to position the cursor on a PERFORM or GO TO statement, then press
PF10/22. (BRANCH is the default setting for the PF10/22 key; BRANCH BACKUP is
the default for the PF11/23 key.) The screen position is saved for use with the BACKUP
operand based on these conditions:

. A PERFORM range or LABEL name is entered on the command line.
. The cursor is placed on a GO TO or PERFORM statement.
The PROCEDURE DIVISION label displays when you enter the BRANCH command

with no operands and the cursor is positioned in a part of the program other than the
PROCEDURE DIVISION.

If a PROGRAM EXIT or STOP RUN is encountered, a pause occurs and a message
displays indicating that a logical end is reached. Press PF10/22 to continue the BRANCH
command.
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Example 1. This example assumes that the cursor is positioned on PERFORM
READ-ALL. The screen is scrolled and the cursor is positioned on the READ-ALL
paragraph.

BRANCH

Example 2. This example assumes that the cursor is positioned on the READ-ALL
paragraph. The screen is scrolled and the cursor is positioned on the PERFORM
READ-ALL statement.

BRANCH PREVIOUS

Example 3. The screen is scrolled and the cursor is positioned on the P120-READ
paragraph.

B P120-READ

Example 4. The screen is scrolled and the cursor is positioned on the PROGRAM-INIT
paragraph.

B PROGRAM-INIT

Example 5. The screen is scrolled and the cursor is positioned at the location from
where the B PROGRAM-INIT command was entered.

B BACKUP
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pgm

The CALL command is used to start a Source View session for another program without
ending the current session. The GOBACK or END command can be used to return to the
original program.

Operand Description

Blank Displays the AKR Program Selection pop-up for selection of a program.
See the online help for more information.

pgm Specifies a COBOL program or entry point name. If the specified
program or entry point is not available in the current AKR, an error
message displays.

The CALL command provides you a means of following logic paths across CALLed
programs. CALL remembers the location within the CALLing program and displays the
CALLed program. When finished with the CALLed program, use the GOBACK
command to return to the location in the CALLing program. See the "GOBACK

1

Command" on page 233 and the "PROGRAM Command" on page 281 for additional
information.

Example 1. In this example the current Source View program is VIAIDEMO, this
command calls the VIAIDEM1 program:

CALL VIAIDEMI1

Example 2. Returns to the VIAIDEMO Source View session without saving marks or
equates that you created in VIAIDEM 1:

GOBACK VIAIDEMO NOSAVE
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CANCEL Command

CANcel »<
Function
The CANCEL command terminates the current function without saving changes to marks
and equates made during the session.
Operands

None.

Usage Notes

CANCEL is the equivalent of an END NOSAVE command. It terminates the function
without saving new marks or equates, or changes to existing marks or equates.
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\a mark-

Copy —LABEL reme 7o name LNOTEﬁ
—MARK comment

—PERFRANGE—
—PROGRAM—
—SUBSET

N T e
—LINE
—4|—name—
| PARAGRAPH

X

Function
The COPY command is used to copy the contents of a path or set of lines to a mark. This
allows you to save the same information under a different name for additional use. You
can also include a new description if desired.

Operands

Operand Description

LABEL name  Specifies a PROCEDURE DIVISION paragraph name or section
name, or the literals PROCEDURE and PROC. All transfers of
control to the label name are included.

MARK name  Specifies a 1 to 10 alphanumeric character name given to a set or path
using the COPY, MARK, MERGE, or RENAME commands, or one
of these system-generated paths:

System generated path:  Created by:

TRACK | TRK A TRACE command.
NETWORK | NET A FLOW command.
SUBNETn | SUBn A path created by the FLOW command

that reaches from the beginning of the
NETWORK to one of the results (nth
result).

Note:

The TRACK, NETWORK, and SUBNET paths can also be created
using the Logic Order Search pop-ups (see "Logic Pull-down" on

page 101).
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PERFRANGE  Specifies the name in a PERFORM statement including all statements
name executed as a result of a PERFORM statement, or the name of any
section contained in the Declaratives.

PROGRAM Specifies the name of either the main program or any nested program.
name All code contained in the specified program is used.

SUBSET name Specifies a predefined COBOL language subset. See the ASG-Insight
User’s Guide for a list of each subset and its description.

LINE range Specifies a single line number or range of lines. Line numbers display
in columns 1 through 6 of Source View.

PARAGRAPH  Specifies a PROCEDURE DIVISION paragraph name or section
name name, or the literals PROCEDURE and PROC. The entire paragraph
or section is included.

TO Specifies an optional keyword indicating the mark name that follows
is where the target is copied.

mark-name Specifies a name assigned to a path or set of lines using the MARK
command or the Options - Scratchpad Mark pop-up. The name you
specify must meet these requirements:

. A maximum of 10 alphanumeric characters, including hyphens.
Names longer than 10 characters truncate.

. Must begin with an alphabetic character.

. This name is assigned to the new path or set

NOTE comment Provides an optional description about the name. Comment text can
be a maximum of 50 alphanumeric or 23 DBCS characters. If you do
not enter NOTE comment, the existing comment is copied to the new
mark name. If you enter NOTE with no comment text, the existing
comment is not copied to the new mark name.

Usage Notes

You can also use the Options - Scratchpad Copy pop-up to copy paths and sets. See the
online help for more information.

The same path or set of lines can be copied to different names. The TO mark-name you

specify must be unique. If you specify an existing mark-name, an error message
displays and the copy function is not performed.
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To concatenate targets, place a plus sign (+) between the target names. For example,
IO+CALL. You can use a concatenated set name wherever a set name is valid. These sets
can be concatenated:

. LABEL . LINE

. MARK . PROGRAM

. PERFRANGE . PARAGRAPH
. SUBSET

For COBOL II Release 3 or later programs, you can qualify a data item, label, or program
name that may be ambiguous or used multiple times by using OF followed by the
program name. For example, if the label P120-READ exists in another program and also
in the program VIAIDEM]1, you can qualify it as P120-READ OF VIAIDEMI.

Example 1. This command copies the contents of TRACK into FICA:
COPY TRACK TO FICA
Example 2. This command copies all highlighted lines to MYSET:

COPY HI TO MYSET
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CURRENT Command

CURRent

Function

Operands

Usage Notes

Y
A

The CURRENT command is used to save the current location of the cursor. The
LOCATE &CURRENT command can then be used to reposition the screen to the saved
location.

Only one CURRENT command can be in effect. A new CURRENT command replaces
the prior one.

Note:
The CURRENT command is valid only on the Source View screen.

None.

The CURRENT and LOCATE &CURRENT commands increase the ability to control
the position in the source during script processing.

Use the CURRENT command to save your current location while you browse related
data items.
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DELete = —————markname1 ]
——markname2 C IN T markname3

—LABEL —hame—— FROM

—PERFRANGE —

—PROGRAM——

—SUBSET

—PARAGRAPH—

Cone— T e
L LINE

X

Function

The DELETE command is used to delete a mark name and its contents. This command is
also used to delete a mark name, path, or a set of lines from an existing mark name.

Operand Description

Operands

marknamel, Specifies a name assigned to a path or set of lines using the COPY,
markname?2, MERGE, MARK, or RENAME commands, or one of these
markname3 system-generated paths:

System generated path:  Created by:

TRACK | TRK A TRACE command.
NETWORK | NET A FLOW command.
Note:

The TRACK and NETWORK paths can also be created using the
Logic Order Search pop-ups (see "Logic Pull-down" on

page 101).

LABEL name Specifies a PROCEDURE DIVISION paragraph name or section
name, or the literals PROCEDURE and PROC. All transfers of
control to the label name are also deleted.

PERFRANGE Specifies the name in a PERFORM statement including all
name statements executed as a result of a PERFORM statement, or the
name of any section contained in the Declaratives.

PROGRAM name  Specifies the name of the main program or any nested program
representing all the code contained in the program. This includes
all the programs physically nested inside the specified program.

SUBSET name Specifies a predefined COBOL language subset. See the
ASG-Insight User’s Guide for a description of each subset.
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PARAGRAPH Specifies a PROCEDURE DIVISION paragraph name or section
name name, or the literals PROCEDURE and PROC. The entire
paragraph or section is deleted.

LINE range Specifies a single line number or range of lines. Line numbers
display in columns 1 through 6 of Source View.

IN/FROM Deletes the specified mark name, path, or set of lines from the
markname3 existing markname3.

You can delete mark names that you no longer need by using the DELETE command. If
you attempt to delete a mark name that does not exist, an error message displays. You can
also delete the NETWORK and TRACK system-generated paths. SUBNETS are
automatically deleted when you delete the corresponding NETWORK.

Note:
To delete a mark name and its contents, select Options P Scratchpad, then select Delete
from the Options - Scratchpad pop-up. See the online help for more information about the
Options - Scratchpad pop-up.

The set of lines in one mark name can be deleted from another mark name. In addition, a
path or line range can be deleted from an existing mark name.

Example 1. This command deletes the mark name FICA and its contents:
DELETE FICA

Example 2. This command deletes line 17 from the mark name FICA:
DELETE 17 FROM FICA

Example 3. This command deletes the set of lines in the mark name FICA from the
mark name WITHHOLD:

DELETE FICA FROM WITHHOLD
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X

Save:‘
Nosav

The END command is used to terminate the current function and to redisplay the previous
screen.

Operand Description

Blank If you enter the END command with no operands, the values specified on
the Options - Product Parameters pop-up are used to determine if marks
and equates are to be saved.

Save Saves marks and equates created for this program in the AKR. This
operand overrides the values set on the Options - Product Parameters
pop-up.

Nosave Specifies that the marks and equates created for this program are not

saved. This operand overrides the values set on the Options - Product
Parameters pop-up.

The END command (default PF03/15) terminates any Insight function. While in Source
View, you can enter the command and the desired operand in the command input area, or
you can enter the operand in the command input area and press the PF key. The previous
function or screen displays.
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EQUATE Command

X

Equate ——name [
sﬂMgAJ

Function

The EQUATE command is used to define a name for a character string.

Operand  Description

name Specifies a name for the character string. Names must conform to these
standards:

Operands

. 1 to 10 alphanumeric characters
. First character must be alphabetic or a period
. A hyphen is the only special character allowed

. The name may also be 1 to 4 DBCS characters

string Specifies a character string to be substituted by the EQUATE command. A
character string can be a long command, pattern, dataname, concatenated
dataname, etc. You can specify literals and blanks in the character string if
desired. You must enclose character strings that include blanks within
single or double quotes. The string may be a DBCS string.

If you do not enter the string operand, the equated name is deleted

Usage Notes

You can define equates on the Options - Scratchpad Equate pop-up, and delete them from
both the Options - Scratchpad Equate and the Options - Scratchpad Delete pop-ups.
Change the substitution string on the List - Equates pop-up by typing over it with the new
value.

Use equated names to reduce the number of keystrokes during a Source View session.
You can use multiple equates if desired.

If you use an equated name in another EQUATE command, you must first define it. For
example:

EQ CC TOT-COST
EQ BB CC + PROD-COST
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BB now contains TOT-COST + PROD-COST

You can save the equates that you created in Source View in the AKR. See the "SAVE
Command" on page 302 for more information. To delete an equated name, type EQUATE
and the name without the string.

Note:

See the online help for more information about the Options - Scratchpad Equate pop-up,
the Options - Scratchpad Delete pop-up, and List - Equates pop-up.

Example 1. This command equates the name A to EOF-FLAG:
EQ A 'EOF-FLAG'
To find EOF-FLAG, type this command:
FIND A
Example 2. This command equates AA to TOT-COST:
EQ AA TOT-COST
To change AA to be TOT-COST * PROD-COST, type this command:
EQ AA * PROD-COST.
Example 3. This command equates BB to the FIND 'END-OF-FILE-FLAG' command:

EQ BB FIND 'END-OF-FILE-FLAG'
BB to FIND 'END-OF-FILE-FLAG'

This command deletes the BB equate:

EQ BB
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Function

Operands

\é
A

The EXCLUDE command performs a FINDXTND command on the specified target,
excluding the resulting lines.

Operand Description

LABEL name  Specifies a PROCEDURE DIVISION paragraph name or section
name, or the literals PROCEDURE and PROC. All transfers of
control to the label name are included.

MARK name  Specifies a 1 to 10 alphanumeric character name given to a set or path

using the COPY, MARK, MERGE, or RENAME commands, or one
of these system-generated paths:
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System generated path:  Created by:

TRACK | TRK A TRACE command.
NETWORK | NET A FLOW command.
SUBNETn | SUBn A path created by the FLOW command

that reaches from the beginning of the
NETWORK to one of the results (nth
result).

Note:

The TRACK, NETWORK, and SUBNET paths can also be created
using the Logic Order Search pop-ups (see "Logic Pull-down" on

page 101).

PERFRANGE  Specifies the name in a PERFORM statement including all statements
name executed as a result of a PERFORM statement, or the name of any
section contained in the Declaratives.
This operand is valid in Source View only
PROGRAM Specifies the name of the main program or any nested program
name representing all the code contained in the program. This includes all
the programs physically nested inside the specified program.
SUBSET name Specifies a predefined COBOL language subset. See the ASG-Insight
User’s Guide for a list of each subset and its description.
LINE range Specifies a single line number or range of lines. Line numbers display
in columns 1 through 6 of Source View.
PARAGRAPH Specifies a PROCEDURE DIVISION paragraph name or section
name name, or the literals PROCEDURE and PROC. The entire paragraph

or section is included.

asterisk (*)

Reuses the target of the previous search, exclude, find, highlight, or
scroll action or command.

DATA name

Specifies a COBOL dataname or qualified COBOL dataname.
Dataname refers to any valid COBOL reference for a data element.
These subordinate operands apply to the dataname and can be used to
further qualify the EXCLUDE command: REF, USE, MOD, DEF,
ALIAS,NOALIAS, DIRECT, and INDIRECT. The defaults are REF,
ALIAS, and DIRECT.

SQL name

Excludes datanames that are DB2/SQL variables only.
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IDMS name

Excludes datanames that are IDMS variables only.

. name

Excludes datanames that are COBOL variables only.

Ref

Excludes occurrences of the dataname where its value is defined,
tested, used, set, or modified. This is the default value for the DATA
name operand.

Use

Excludes occurrences of the dataname where its value is being tested
or used.

Mod

Excludes occurrences of the dataname where its value is being set or
modified.

Def

Excludes definitions of the dataname in the DATA DIVISION

AlLlas

Includes occurrences of the aliases for the dataname. These are the
valid aliases:

. Parent - higher level group item
. Child - lower level item
. Rename/Redefinition - renamed, redefined, or 88 level items

This is the default value for the DATA name operand.

NOAlias

Ignores aliases for the specified dataname.

DIRect

Excludes occurrences of the dataname (and aliases if specified) where
it is directly tested, used, set, modified, or defined (based on the REF,
USE, MOD, or DEF selection). The default for the DATA name
operand is direct; however, if you specify the SIZE, VALUE, or
LEVELS operand, INDIRECT is assumed.

INDirect

Includes any dataname indirectly affected by the specified dataname
(and aliases if specified). The indirect data item can be further
qualified using the SIZE, VALUE, and LEVELS subordinate
operands. These subordinate operands indicate the type of indirect
reference to be located. SIZE and all levels are the defaults for the
INDIRECT operand.

SIZe

Includes occurrences of datanames that could be directly or indirectly
affected if the size of the specified dataname were to be changed.
SIZE is only valid with the INDIRECT operand. This is the default for
the INDIRECT operand.
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VALue

Includes occurrences of datanames that could either be directly or
indirectly affected if the value of the specified dataname were to be
changed. The LEVELS subordinate operand is not used with
VALUE. VALUE is only valid with the INDIRECT operand.

LEVels n

Includes all of the data items affected within the specified number of
indirect levels. The VALUE subordinate operand is not used with
LEVELS. All levels is the default for the LEVELS operand. LEVELS
is only valid with the INDIRECT operand.

PATTERN

Indicates that the characters that follow are part of a string. This is an
optional keyword

string

Specifies a string of alphanumeric or DBCS characters. If the pattern
string contains blanks, it must be enclosed in single or double quotes.
You can further qualify the pattern string by using the WORD,
PREFIX, or SUFFIX subordinate operands. These subordinate
operands describe how the pattern string is to be used.

X'string'

Specifies the hexadecimal string option. Specific unprintable
characters may be specified by giving the EBCDIC hexadecimal
value. The string must be enclosed in single or double quotes.

T'string

Specifies the text string option. You may enter a character string
regardless of upper or lowercase by using the text option. The string
must be enclosed in single or double quotes.

P'string

Specifies the picture string option. A string profile may be entered
instead of exact characters. The string must be enclosed in single or
double quotes. Insight defines nine special characters for use in
picture strings. These special characters can be combined with other
characters. These are the special characters:

P'="  Any character

P'-'  Any nonblank character
P! Any nondisplay character
P'#  Any numeric character
P'-'  Any character

P'@' Any character

P'<"  Any character

P™>" Any character

P'$"  Any character
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WORD Specifies the specified pattern string preceded and followed by any
non-alphanumeric character (except a hyphen).

PREFIX Specifies a word that begins with the specified pattern string.

SUFFIX Specifies a word that ends with the specified pattern string.

Columnl Specifies the column number where the search is to begin.

Column2 Specifies the column number where the search is to end.

Blank Excludes all lines from the display.

ALL Excludes all lines from the display. The ALL operand cannot be
entered with any other operands. This is the default.

Next Searches forward from the cursor position to the next occurrence of
the requested target.

Prev Searches backward from the cursor position to the previous
occurrence of the requested target.

Flrst Searches from the top of the source file to the first occurrence of the
requested target.

LAst Searches backward from the bottom of the source file to the first
occurrence of the requested target.

All Searches for all occurrences of the requested target and displays the
number found in the short/long message field. This is the default value
for the EXCLUDE command.

IN Restricts the EXCLUDE command to the specified target type.

You can exclude lines by using the X (Exclude) and XX (Exclude Block) line commands
on the View - Exclude Request pop-up. To display the View - Exclude Request pop-up,
select View P Exclude and press Enter. You can also exclude lines by using one of the
Search pop-ups available on the Search pull-down.

The EXCLUDE command can be used to remove specific lines from the screen resulting
from a previous command. Excluded lines are represented by a line of dashes and text
stating n LINE(S) NOT DISPLAYED. The X or XX line commands can also be used to
exclude lines from the screen.
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To concatenate targets, place a plus sign (+) between the target names. For example, IO +
CALL. These rules apply to concatenation:

. A concatenated dataname can be used wherever a dataname is valid. Dataname
subordinate operands (REF, ALIAS, etc.) pertain to all datanames in a concatenated
series.

. A concatenated set name can be used wherever a set name is valid. These sets can
be concatenated:

. LABEL . LINE

. MARK . PROGRAM

. PERFRANGE . PARAGRAPH
. SUBSET . PATTERN

. The asterisk (*) operand can be concatenated once with any number of other
operands (e.g., * + IO + MYSET); however, the * operand cannot be concatenated
to itself (* + * is invalid). The * operand may appear in any order in the
concatenated list.

For COBOL II Release 3 or later programs, a data item, label, or program name that may
be ambiguous or used multiple times can be qualified by using OF followed by the
program name. For example, if the label P120-READ exists in another program and also
in the program VIAIDEM]1, then it can be qualified as P120-READ OF VIAIDEMI.

Example

This command removes all unhighlighted lines from the screen:

EXCLUDE NHI
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EXECUTE Command

EXECute (member) <
STEPQ kdsn (member)— \—PARMS parametersJ
dsn
RESUME
CANCELJ
Function
The EXECUTE command is used to read and execute the commands in a script file.
Script files can contain EXECUTE commands that execute lower level (nested) script
files. The STEP operand allows you to step through each script command.
Operands

STEP

Steps through the commands in the script file. Each command in the
script file displays in the command input area. The displayed command
can be changed or erased from the command input area. Press Enter to
execute the displayed command. Processing of the script file continues in
this manner until all commands have been displayed and/or executed.

RESUME

Executes the remaining script file commands without stepping through
each. EXECUTE RESUME is entered after a script file is executed with
the STEP operand specified.

CANCEL

Cancels the remaining script file commands. EXECUTE CANCEL can
be entered after a script file is executed with the STEP operand specified.

member

Specifies the script member in a default script file defined during product
installation. You can modify either the default script files or their
concatenation sequence for your profile by using the Script file allocation
action on the Options pull-down. The parentheses are required.

dsn(member)

Specifies the dataset and member name of a partitioned file that contains
the script commands to be executed. This member must be in card image
format (LRECL=80). The specified dataset member must be entered
following TSO usage conventions in this format:

'pds.dsn (member)'

If you omit the quotes, your TSO prefix or user ID is the high-level
qualifier.
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dsn Specifies the dataset name of a sequential file that contains the script
commands to be executed. This dataset must be in card image format
(LRECL=80). The specified dataset name must be entered following
TSO usage conventions in this format:

'sequential.dataset.name'

If the quotes are omitted, your TSO prefix or userID is the high-level
qualifier.

PARMS Specifies parameters to be passed to the script being executed.

parameters Commands within a script file may contain substitution variables

numbered &1 through &9. Parameter values are passed at execution time
to the substitution variables using the PARMS operand of the EXECUTE
command. Type the parameters values in the numerical order 1 through
9. If more than 9 parameter values are entered, the first nine are used and
the remainder are ignored. If substitution variables are included in the
script and parameters are not included in the EXECUTE command, the
substitution variable values are passed as null.

Substitution variables can be used anywhere in the executable script
commands, but are not substituted if they occur in comment lines.

Parameter values may contain any non-quoted literal without embedded
blanks or any quoted literal. Quoted literals retain their quotes after
substitution within the script file.

The EXECUTE command reads the specified dataset and executes the script contained in
the file. The script can contain EXECUTE commands that execute lower level (nested)
script files. Script files that create a loop are recognized and an error message displays.

The STEP operand provides you a means of stepping through each script command. This
allows you to modify or skip commands as desired.

Scripts must be sequential datasets or members of partitioned datasets. In both cases,
scripts must be in card image format (LRECL=80). Scripts can be used to perform these
repetitive tasks:

Initiate a test session
Set default values
Set up a test session
Execute a test
Re-execute a test

Execute a predefined command sequence
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Comments can be included in script files by typing an asterisk (*) in column one followed
by the comment text.

Script files can also be executed from the File - Execute Script pop-up. Select File »
Execute to display the File - Execute Script pop-up.

Example 1. Type this command to cause the first command in the script file to be
displayed in the command input area:

EXECUTE STEP 'USERID.INS00015.VIASCRIP'

The command is executed and the next command in the script file displays in the
command input area. You can change or bypass (erase) any command when it displays in
the command input area.

Example 2. In this EXECUTE command, all script commands in member SCRIPTO1 in
the default script datasets are sequentially executed:

EXECUTE (SCRIPTO1)

These commands can consist of any valid Insight primary command. For example,
BRANCH, FX, LPRINT.

Example 3. In this example, the program name MYPROG and the dataname
HIRE-DATE pass as parameters to the script in member SCRIPTO2 in the default script
files.

EXECUTE (SCRIPT02) PARMS MYPROG HIRE-DATE

If the script contains these commands, the parameters are substituted in the commands in
place of the substitution variables to allow flexibility in using the script:

QUALIFY &1
FX &2

These are the actual commands resulting from the parameter substitution:

QUALIFY MYPROG
FX HIRE-DATE

Note:
See "PROCESS Command" on page 276 for additional uses of EXECUTE parameters.
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FIND string »<
X 'string'——| WORD [ column | [ column ] Next—| L —
T'string—| |-PREFIX 1 2 Prev—| LIN—Y name——|
P string—| L SUFFIX First—| | MARK
* LAst—| | PERFRANGE|
Al  PROGRAM—|
| SUBSET 1
o range—
L LINE
| PARAGRAPH

Function
The FIND command searches for one or all occurrences of the specified character string.
The syntax is similar to the ISPF/PDF FIND command. To locate DBCS strings, specify
Double Byte Character Set (DBCS) identifiers or patterns with the FIND command.
Operands

string Specifies a string of alphanumeric or DBCS characters. If the string
contains blanks, it must be enclosed in single or double quotes. The
string cannot contain mixed alphanumeric and DBCS characters. You
can further qualify the string by using the WORD, PREFIX, or
SUFFIX subordinate operands. These subordinate operands describe
how the string is to be used:

X'string' Specifies the hexadecimal string option. You may specify specific
unprintable characters by giving the EBCDIC hexadecimal value. The
string must be enclosed in single or double quotes.

T'string' Specifies the text string option. You can enter a character string
regardless of upper or lowercase by using the text option. The string
must be enclosed in single or double quotes.

P'string' Specifies the picture string option. You can enter a string profile
instead of exact characters. The string must be enclosed in single or
double quotes. Insight defines nine special characters for use in picture
strings. These special characters can be combined with other
characters:

P'=" Any character

P'-'  Any nonblank character
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Operand Description

P Any nondisplay character
P#  Any numeric character
P-'  Any character

P'‘@' Any character

P'<"  Any character

P>"  Any character

P'$"  Any character

asterisk (*) Reuses the target of the previous FIND.

WORD Specifies the string preceded and followed by any non-alphanumeric
character (except a hyphen).

PREFIX Specifies a word that begins with the specified string.

SUFFIX Specifies a word that ends with the specified string.

Columnl1 Specifies the column number where the search is to begin.

Column2 Specifies the column number where the search is to end.

Next Searches forward from the cursor position to the next occurrence of the

requested target. This is the default value for the FIND command.

Prev Searches backward from the cursor position to the previous occurrence
of the requested target.
Flrst Searches from the top of the source file to the first occurrence of the

requested target.

LAst Searches backward from the bottom of the source file to the first
occurrence of the requested target.

All Searches for all occurrences of the requested target and displays the
number found in the short/long message field.

IN Restricts the FIND command to the specified target type.
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MARK name

Specifies a 1 to 10 alphanumeric character name given to a set or path
using the COPY, MARK, MERGE, or RENAME commands, or one of
these system-generated paths:

System generated path:  Created by:
TRACK | TRK A TRACE command.
NETWORK | NET A FLOW command.

SUBNETn | SUBn A path created by the FLOW command
that reaches from the beginning of the
NETWORK to one of the results (nth
result).

Note:

The TRACK, NETWORK, and SUBNET paths can also be created
using the Logic Order Search pop-ups (see "Logic Pull-down" on

page 101).

PERFRANGE
name

Specifies the name in a PERFORM statement including all statements
executed as a result of a PERFORM statement, or the name of any
section contained in the Declaratives.

PROGRAM

name

Specifies the name of the main program or of any nested program
representing all of the code contained in the program. This includes all
of the programs physically nested inside the specified program.

SUBSET

name

Specifies a predefined COBOL language subset. See the ASG-Insight
User’s Guide for a list of each subset and its description.

LINE range

Specifies a single line number or a range of lines. Line numbers display
in columns 1 through 6 of Source View.

PARAGRAPH
name

Specifies any PROCEDURE DIVISION paragraph name or section
name, or the literals PROCEDURE and PROC. The entire paragraph
or section is included.

You can also conduct a search by selecting a Search pop-up on the Search pull-down.

The search begins from the current line when the you specify the NEXT or PREV
operands. When you specify the ALL operand, all lines are searched regardless of the
current line or direction. Any excluded lines containing FIND targets are displayed and
highlighted. The IN operand restricts the FIND command to only the targets you

specified.
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To concatenate targets, place a plus sign (+) between the target names. For example, IO +
CALL. These are the rules for concatenation:

. A concatenated dataname wherever a dataname is valid. Dataname subordinate
operands (REF, ALIAS, etc.) pertain to all datanames in a concatenated series.

. A concatenated set name can be used wherever a set name is valid. These sets can
be concatenated:

. LINE . MARK
. PERFRANGE . PARAGRAPH
. PROGRAM . SUBSET

For COBOL II Release 3 or later programs, you may qualify a data item, label, or
program name that may be ambiguous or used multiple times by using OF followed by
the program name. For example, if the label P120-READ exists in another program and
also in the program VIAIDEMI, then you can qualify it as P120-READ OF VIAIDEMI.

Example 1. In this command, all occurrences of XYZ are highlighted:

FIND 'XYZ' ALL

Example 2. In this command, the FIND command searches for the DATA NAME string
without regard to case. The DATA NAME string can be uppercase, lowercase, or mixed
case:

FIND T'DATA NAME'

Example 3. In this example, the FIND command searches for two non-blank characters
separated by a blank:

FIND P'= '
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FINDXTND Command

+

FINDEtnd|FX name »
FLABEL
FMARK
rPERFRANGE-
rPROGRAM—
FSUBSET——
range—
—LINE:
name—
-PARAGRAPH-
+
\ 2 ] name:
DATA SQL— Ref DIRect—| L—ALlasﬂ
t EIDMsf Usei t NOAlias:
: Mod INDirect
* Def MJ LLEVeIan
VALue
ALIasﬂ
NOAlias:
T e L T ]
—PATTERN X 'string— ——WORD column 1 column 2
|ET'strinq' —PREFIX
P 'string— ——SUFFIX
——Next— L +
—Prev—| IN-Y name—|
——FIrst— —MARK
——LAst— —PERFRANGE—
—All —PROGRAM——
—SUBSET—
TN ] M9
—LINE
ﬁ—namef
—~PARAGRAPH

Function

The FINDXTND command performs a COBOL intelligent search of the source code for
either one or all occurrences of the specified target.

Operand Description

LABEL name  Specifies a PROCEDURE DIVISION paragraph name or section
name, or the literals PROCEDURE and PROC. All transfers of
control to the label name are included.

Operands
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MARK name

Specifies a 1 to 10 alphanumeric character name given to a set or path
using the COPY, MARK, MERGE, or RENAME commands, or one
of these system-generated paths:

System generated path: Created by:
TRACK | TRK A TRACE command.
NETWORK | NET A FLOW command.

SUBNETn | SUBn A path created by the FLOW command
that reaches from the beginning of the
NETWORK to one of the results (nth
result).

Note:

The TRACK, NETWORK, and SUBNET paths can also be created
using the Logic Order Search pop-ups (see "Logic Pull-down" on

page 101).

PERFRANGE
name

Specifies the name specified in a PERFORM statement including all
statements executed as a result of a PERFORM statement, or the name
of any section contained in the Declaratives.

This operand is valid in Source View only

PROGRAM
name

Specifies the name of the main program or any nested program
representing all the code contained in the program. This includes all
the programs physically nested inside the specified program.

SUBSET name

Specifies a predefined COBOL language subset. See the ASG-Insight
User’s Guide for a list of each subset and its description.

LINE range

Specifies a single line number or range of lines. Line numbers display
in columns 1 through 6 of Source View.

PARAGRAPH

name

Specifies a PROCEDURE DIVISION paragraph name or section
name, or the literals PROCEDURE and PROC. The entire paragraph
or section is included.

asterisk (¥*)

Reuses the target of the previous search, exclude, find, highlight, or
scroll action or command.

DATA name

Specifies a COBOL dataname or qualified COBOL dataname.
Dataname refers to any valid COBOL reference for a data element.
These subordinate operands apply to the dataname and can be used to
further qualify the EXCLUDE command: REF, USE, MOD, DEF,
ALIAS,NOALIAS, DIRECT, and INDIRECT. The defaults are REF,
ALIAS, and DIRECT.
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SQL name

Excludes datanames that are DB2/SQL variables only.

IDMS name

Excludes datanames that are IDMS variables only.

. name

Excludes datanames that are COBOL variables only.

Ref

Excludes occurrences of the dataname where its value is defined,
tested, used, set, or modified. This is the default value for the DATA
name operand.

Use

Excludes occurrences of the dataname where its value is being tested
or used.

Mod

Excludes occurrences of the dataname where its value is being set or
modified.

Def

Excludes definitions of the dataname in the DATA DIVISION

ALlas

Includes occurrences of the aliases for the dataname. These are the
valid aliases:

. Parent - higher level group item
. Child - lower level item
. Rename/Redefinition - renamed, redefined, or 88 level items

This is the default value for the DATA name operand.

NOAlias

Ignores aliases for the specified dataname.

DIRect

Excludes occurrences of the dataname (and aliases if they are
specified) where it is directly tested, used, set, modified, or defined
(based on the REF, USE, MOD, or DEF selection). The default for the
DATA name operand is direct; however, if the SIZE, VALUE, or
LEVELS operand is specified, INDIRECT is assumed.

INDirect

Includes any dataname indirectly affected by the specified dataname
(and aliases if specified). The indirect data item can be further
qualified using the SIZE, VALUE, and LEVELS subordinate
operands. These subordinate operands indicate the type of indirect
reference to be located. SIZE and all levels are the defaults for the
INDIRECT operand.

SIZe

Includes occurrences of datanames that could be directly or indirectly
affected if the size of the specified dataname were to be changed.
SIZE is only valid with the INDIRECT operand. This is the default for
the INDIRECT operand.
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VALue Includes occurrences of datanames that could be directly or indirectly
affected if the value of the specified dataname were to be changed.
The LEVELS subordinate operand is not used with VALUE. VALUE
is only valid with the INDIRECT operand.

LEVels n Includes all data items affected within the specified number of
indirect levels. The VALUE subordinate operand is not used with
LEVELS. All levels is the default for the LEVELS operand. LEVELS
is only valid with the INDIRECT operand.

PATTERN Indicates the characters that follow are part of a string.

string Specifies a string of alphanumeric or DBCS characters. If the pattern
string contains blanks, it must be enclosed in single or double quotes.
You can further qualify the pattern string by using the WORD,
PREFIX, or SUFFIX subordinate operands. These subordinate
operands describe how the pattern string is to be used.

X'string' Specifies the hexadecimal string option. You can specify specific
unprintable characters by giving the EBCDIC hexadecimal value. The
string must be enclosed in single or double quotes.

T'string Specifies the text string option. Use the text option to enter a character
string regardless of upper or lowercase. The string must be enclosed
in single or double quotes.

P'string Specifies the picture string option. You may enter a string profile
instead of exact characters. The string must be enclosed in single or
double quotes. Insight defines nine special characters for use in
picture strings. These special characters can be combined with other
characters. These are the special characters and their meanings:

p=' Any character

P Any nonblank character
P Any nondisplay character
P'# Any numeric character
p-' Any character

P'‘@'  Any character

p< Any character

P> Any character

P'§' Any character

WORD Specifies the pattern string preceded and followed by any
non-alphanumeric character (except a hyphen).
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PREFIX Specifies a word that begins with the specified pattern string.

SUFFIX Specifies a word that ends with the specified pattern string.

Columnl Specifies the column number where the search is to begin.

Column2 Specifies the column number where the search is to end.

ALL Excludes all lines from the display. You cannot enter the ALL
operand with any other operands. This is the default.

Next Searches forward from the cursor position to the next occurrence of
the requested target.

Prev Searches backward from the cursor position to the previous

occurrence of the requested target.

Flrst Searches from the top of the source file to the first occurrence of the
requested target.

LAst Searches backward from the bottom of the source file to the first
occurrence of the requested target.

All Searches for all occurrences of the requested target and displays the
number found in the short/long message field. This is the default value
for the EXCLUDE command.

IN Restricts the EXCLUDE command to the specified target type.

Usage Notes

If you are using ISPF 4.1 or later, make sure the Long Message in pop-up ISPF setting is
disabled when you execute the FX command. If this setting is not disabled, a portion of
the display screen is overlayed with the FX results formatted in a long message pop-up.
Additional problems can result when you execute the RFIND command following an FX
command.

You can also conduct a search by selecting a Search pop-up on the Search pull-down. See
the online help for more information.
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To concatenate targets, place a plus sign (+) between the target names. For example,
IO+CALL. These rules apply to concatenation:

. A concatenated dataname can be used wherever a dataname is valid. Dataname
subordinate operands (REF, ALIAS, etc.) pertain to all datanames in a concatenated
series.

. A concatenated set name can be used wherever a set name is valid. These sets can
be concatenated:

. LABEL . LINE

. MARK . PROGRAM

. PERFRANGE . PARAGRAPH
. SUBSET . PATTERN

. The asterisk (*) operand can be concatenated once with any number of other
operands (e.g., * + IO + MYSET); however, the * operand cannot be concatenated
to itself (* + * is invalid). The * operand may appear in any order in the
concatenated list.

For COBOL II Release 3 or later programs, you can qualify a data item, label, or program
name that may be ambiguous or used multiple times by using OF followed by the
program name. For example, if the label P120-READ exists in another program and also
in the program VIAIDEM]1, then it can be qualified as P120-READ OF VIAIDEMI.

Highlighting is used to indicate the occurrences found. Lines already highlighted are
reset, so that only the results of the current command are highlighted. If you exclude lines
containing targets, they redisplay on the screen. Tags are placed on the source code lines
indicating the type of target found. These tags are placed in columns 73 through 80:

LABEL name LABELREF

MARK name TRACK
NETWORK
MARK SUBNET

PERFRANGE name PERF RNG

PROGRAM name PROGRAM PGM tag
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Tag Description

SUBSET name Specifies a predefined COBOL subset name. These are the
valid subsets:
ASsignment  DEBug 10
CAll DEFinition LABel
Clcs DIRective MAINIine
COBOLII DIVision MATH
COBOL/370  DL/1| DL/1 Output
COMment DML PARagraph
CONditional  ENtry PERform
COPy EXIt|PGM  ExitRETurn
DB2/SQL FALLthrough SECtion
DDL GOto SORTMerge
DEAD IDMS STructure
DEADCode INClude TESted
DEADData Input UNTested

SUBSET name - HIGH

SCREEN NONHIGH
EXCLUDE
NONX

SUBSET name - DECISION

TRACE tags OPTION
START
TARGET

LINE range LINE RNG

PARAGRAPH name PARAGRAP

DATA name DATA REF
DATA USE
DATA MOD

DATA DEF
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PATTERN string

Specifies the pattern string. The NEXT and PREV operands
start the search from the current position and locate the
closest occurrence. If you specify ALL, all lines are searched
regardless of the current line or direction. A message
displays indicating the number of targets found.

When you enter an unqualified dataname and more than one
occurrence of the specified dataname exists, all occurrences
are found. This allows you to see all like datanames but under
different group level names, then allows you to select the
appropriate dataname. A message displays if you enter an
invalid qualification.

When you enter a dataname with the REF operand, the screen
is positioned to show the first occurrence of the dataname in
the PROCEDURE DIVISION. DEF information in the
DATA DIVISION is also highlighted.

FX INDIRECT

Locates the specified indirect dataname. A dataname can
impact other datanames in source statements. These
datanames can be subsequently propagated indirectly
through other statements, and referenced at each level. For
example, consider this code:

MOVE ATOB
MOVEBTO C
MOVE CTOD

When the dataname of interest is A, the first statement
contains a direct reference to A. The direct reference to a
dataname is level 1. The last two statements contain indirect
references to A, based on the propagation of the dataname A
by moving its value to B, then to C, then to D. The second
statement is a level 2 reference to dataname A, and the last
statement is a level 3 reference to dataname A.

All levels of the indirect impact to a dataname display, or you
can view one level at a time using the LEVELS operand. For
example, to locate all datanames that could be indirectly
affected by a change in the size of the specified dataname,
use the command FX A SIZE. Because the LEVELS operand
is not specified, the default of ALL LEVELS is used. This
results in a complete list of all datanames that must be
reviewed (for a size change of the specified dataname). If the
LEVELS operand is specified (e.g., FX A SIZE LEVELS 2),
only the results of that many levels are highlighted. The
ripple effect can be more clearly identified by starting with
LEVELS 1, then increasing the number of levels to be
searched.
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Tag Description

When using INDIRECT SIZE, any occurrence of an affected
dataname in the USING clause of a CALL statement is
tagged as a MOD. The CALLed subprogram must be
examined for other datanames affected as a result of the
CALL. IN target can be used to restrict the search to the
specified IN target.

When the REF operand is specified or used by default, all
appropriate references are highlighted. If the reference is a
DEfinition, USE, or MODification, the line is tagged
accordingly. If the line contains a USE and a MODification,
it is tagged as a REFerence.

DBCS strings The FINDXTND command supports DBCS strings. See

'FIND Command" on page 212 for detailed information.

Examples

Example 1. This FINDXTND command searches backward for the previous occurrence
of a use of DATE-CODE or its aliases:

FINDXTND DATE-CODE USE PREV

Example 2. In this command, the definition of DATE-CODE (without any aliasing) in
the DATA DIVISION is highlighted:

FX DATE-CODE DEF NOALIAS

Example 3. In this command, all occurrences of the SWITCH field used in conditional
statements are highlighted:

FX SWITCH IN COND

Example 4.

01 A.
05 B PIC X.
05 C.
10 D PIC X.
10 E PIC X.
01 Z REDEFINES A.
05 Z1 PIC XXX.
66 L RENAMES 7Z.
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These statements apply if you enter a FINDXTND command for C with ALIAS
specified:

. A is the parent.

. D and E are the children.
. Z is a redefine/rename.

. Z1 is a redefine/rename.

o L is a rename.

Example 5.

000010 READ INFILE INTO A.
000020 MOVE A TO B.

000030 MOVE B TO C.

000040 WRITE OUTFILE FROM C.

The MOD operand is used to locate only those places where B is directly or indirectly set
or modified. The fields in lines 10 and 20 are highlighted since B is modified by A on line
20, and A is modified by the READ statement on line 10.

This FINDXTND command shows the possible origin of the data value:

FX B MOD INDIRECT VALUE

The USE operand is used to locate every place B is directly or indirectly used. The fields
in lines 30 and 40 are highlighted because both statements use B. The FINDXTND
command below shows that the value of B is used to modify C on line 30. On line 40, the
value of C that was received from B is used. This FINDXTND command shows all
possible destinations of a data field:

FX B USE INDIRECT VALUE

Example 6.

000010 01 A.
000020 05 B. PIC XX.

000070 01 cC.

000080 05 D PIC XX.
001010 MOVE B TO X.

001020 MOVE C TO A.

001030 MOVE SPACES TO D.
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The FINDXTND command below is used to locate all groups whose definitions might
have to be changed every time the definition for B changes. The results are lines 10, 20,
70, 80, 1010, and 1020. Any change in the size of B is a change in the size of A as well.
This means the definition for C should be changed since A now has a different record
layout, and the statement on line 1020 would not execute as intended. D is also shown as
a result because it is at the same offset within C as B is within A, and is the same size

as B.

FX B REF INDIRECT

Note:

The number of results from FX INDIRECT REF depends greatly on the target name. For
best results, select a target that is the smallest group item whose subfields are to be
modified.

Example 7. These examples use this code to illustrate the LEVELS, VALUE, and SIZE
operands:

000010 MOVE A TO B.
000020 MOVE X TO B.

000080 MOVE Y TO X.
000100 MOVE Y TO A.

This command identifies the datanames in the program directly affected by a change in
A. This list consists of only dataname A and its related aliases.

FX A INDIRECT LEVELS 0
This command identifies the statement (move of size from A to B) that shows B might be
affected by this move. This statement (line 10) and the definitions of A and B are
highlighted.

FX A INDIRECT LEVELS 1

This command highlights the definitions of A, B, and X, plus the statements on lines 10
and 20.

FX A INDIRECT LEVELS 2
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This command identifies all direct and indirect uses of the value of A. The statement on
line 10 would be highlighted.

FX A USE INDIRECT VALUE

This command identifies all direct and indirect modifications to the value of A. The
statement on line 100 would be highlighted.

FX A MOD INDIRECT VALUE

This command identifies where A is affected by a change in the size of the target
dataname. The statements on line 20 and 100 would be highlighted.

FX A USE INDIRECT SIZE
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FLOW Command

_+

FLow B [ ] Y name »<
FROMfﬁnumber TO —MARK Next—
—LINE —PERFRANGE— Prev—j
—4|7name —PROGRAM— Flrst—]
—LABEL —SUBSET—— LAst—
—’—range— All
—LINE
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Function

Operands
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The FLOW command follows all possible execution paths from a given point in a
program searching for the specified target(s). The identified paths are stored with mark
names of NETWORK and SUBNETn.

Operand Description

FROM Specifies an optional keyword that is entered with a line number or
label to indicate where the FLOW command is to begin.

LINE number Specifies the line number where the FLOW command is to begin.

LABEL name  Specifies the paragraph or section name of the PROCEDURE
DIVISION or the literals PROCEDURE or PROC where the FLOW
command is to begin.

TO Specifies an optional keyword that is followed by a target for the
FLOW command.

MARK name  Specifies a 1 to 10 alphanumeric character name given to a set or path
using the COPY, MARK, MERGE, or RENAME commands, or one
of these system-generated paths:

System generated path: ~ Created by:

TRACK | TRK A TRACE command.
NETWORK | NET A FLOW command.
SUBNETn | SUBn A path created by the FLOW command

that reaches from the beginning of the
NETWORK to one of the results (nth
result).
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Operand Description

Note:

The TRACK, NETWORK, and SUBNET paths can also be created
using the Logic Order Search pop-ups (see "Logic Pull-down" on

page 101).

PERFRANGE  Specifies the name in a PERFORM statement including all statements
name executed as a result of a PERFORM statement, or the name of any
section contained in the Declaratives.

This operand is valid in Source View only

PROGRAM Specifies the name of the main program or any nested program
name representing all the code contained in the program. This includes all
the programs physically nested inside the specified program.

SUBSET name Specifies a predefined subset. These are the valid subsets:

ASsignment  DEBug 10

CAll DEFinition LABel

Clcs DIRective MAINIline
COBOLII DIVision MATH
COBOL/370 DL/I|DL/1  Output
COMment DML PARagraph
CONditional ~ ENtry PERform
COPy EXIt|PGM  ExitRETurn
DB2/SQL FALLthrough SECtion
DDL GOto SORTMerge
DEAD IDMS STructure
DEADCode  INClude TESted
DEADData Input UNTested

A screen subset:

Highlighted | HI
NONHighlighted | NHI
Excluded | X
NONExcluded | NX
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Tagged lines subsets of tags in columns 73 through 80.

Note:
See the ASG-Insight User’s Guide for a description of each subset

LINE range

Specifies a single line number or range of lines. Line numbers display
in columns 1 through 6 of Source View.

LABEL name

Specifies any PROCEDURE DIVISION paragraph name or section
name, or the literals PROCEDURE and PROC. All transfers of
control to the label name are included.

DATA name

Specifies a COBOL dataname or qualified COBOL dataname.
Dataname refers to any valid COBOL reference for a data element.
These subordinate operands apply to the dataname and can be used to
further qualify the EXCLUDE command: REF, USE, MOD, DEF,
ALIAS,NOALIAS, DIRECT, and INDIRECT. The defaults are REF,
ALIAS, and DIRECT.

Ref

Excludes occurrences of the dataname where its value is defined,
tested, used, set, or modified. This is the default value for the DATA
name operand.

Use

Excludes occurrences of the dataname where its value is being tested
or used.

Mod

Excludes occurrences of the dataname where its value is being set or
modified.

Next

Searches forward from the cursor position to the next occurrence of
the requested target.

Prev

Searches backward from the cursor position to the previous
occurrence of the requested target.

Forward

Flows forward from the current cursor position to all occurrences.

Backward

Flows backward from the current cursor position to all occurrences.

You can also identify execution paths in a program by using the Logic Order Search
pop-ups that can create paths with mark names of NETWORK and SUBNETn. See
Chapter 5, "Logic," on page 99 for more information about the Logic Order Search

pop-ups.
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The FLOW command is used to determine the execution flow of a program and indicates
if the specified targets can be reached from a given point. A path of the executable
statements that are followed is captured and called NETWORK. You can save the
NETWORK and use it for additional analysis. Display a NETWORK by using the
FINDXTND NET command.

To concatenate targets, place a plus sign (+) between the target names. For example,
IO+CALL. These rules apply to concatenation:

. A concatenated dataname can be used wherever a dataname is valid. Dataname
subordinate operands (REF, USE, MOD) pertain to all datanames in a concatenated
series.

. A concatenated set name can be used wherever a set name is valid. These sets can
be concatenated:

. LABEL . LINE
. MARK . PROGRAM
. PERFRANGE . SUBSET

For COBOL II Release 3 or later programs, you can qualify a data item, label, or program
name that may be ambiguous or used multiple times by using OF followed by the
program name. For example, if the label P120-READ exists in another program and also
in the program VIAIDEM]1, then it can be qualified as P120-READ OF VIAIDEMI.

The FROM operand is used as the starting point for the FLOW command. If you do not
specify a FROM operand, the cursor position is used as the starting point.

If you position the cursor on an executable COBOL statement, the starting point of the
search is based on the location of the cursor as well as the target and direction specified in
the FLOW command. For example:

FLOW data-name forward
If the cursor is before the statement, the statement is included.
FLOW data-name backward

If you place the cursor is after the last character of the statement, the statement is
included.

If the starting point is an inexecutable COBOL statement, these general rules apply:

. Comment lines and compiler directives occurring at the end of an executable code
block are considered part of the paragraph or section that follows. The search
begins at the paragraph or section name that follows.
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Special Conditions

A line followed by one or more executable statements prior to the succeeding
section, or a line that is part of the last section, is considered part of the preceding
section and the search begins at the end of the statement, before the comment or
directive.

Blank lines that occur at the end of an executable code block, and that are not
preceded by a comment or compiler directive, are considered part of the preceding
paragraph or section. The search begins at the end of the last executable statement
in the preceding paragraph.

A blank line that follows all executable statements of the preceding paragraph, and
that is preceded by a comment or compiler directive, is considered part of this
paragraph. The search begins at the paragraph or section name in this paragraph.

A blank line that is followed by one or more executable statements, or that is part of
the last paragraph or section of the program, is considered part of the preceding
paragraph. The search begins at the end of the preceding paragraph.

If you specify a dataname with USE NEXT or USE PREV, special conditions are
considered. When the FLOW command searches for the next use, the value currently in
the dataname is the target of the search. If a modification of that variable is encountered
along a path, that portion of the execution path is not reflected in the result. The same is
true for PREV. FLOW locates all uses occurring before a modification of the dataname.
For example:

Example

MOVE ZIP-CODE TO OUT-ZIP-CODE (ZIP-CODE = 46201)
MOVE HOLD-ZIP TO ZIP-CODE (HOLD-ZIP = 93721)
MOVE ZIP-CODE TO OUT-ZIP-CODE (ZIP-CODE = 93721)

If you enter the FLOW USE PREV command on the last line, the first line would
not be shown as a result because the value of ZIP-CODE is modified between the
starting and ending points.

The FLOW command below flows to the previous uses of LOAN-AMT where the same

value

was used.

FLOW LOAN-AMT USE PREV

To show the network produced by the FLOW command, type this command:
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GOBACK Command

GOback

Function

Operands

Usage Notes

Example

Y
A

prgnTAJ thavei;j
Nosav!

The GOBACK command is used to reverse a CALL or VIEW command and return to a
Source View session.

Operand Description

Blank Specifies that the program where the last CALL or VIEW was executed is
returned to the Source View. Marks and equates are saved or not saved,
depending on the values specified on the Options - Product Parameters

pop-up.

pgm Specifies a program or entry point in the AKR. A Source View session must
currently be active for this program.

Save Saves marks and equates created for this program in the AKR. This operand
overrides the values on the Options - Product Parameters pop-up.

Nosave  Specifies that marks and equates created for this program are not saved. This
operand overrides the values on the Options - Product Parameters pop-up.

The GOBACK command ends the current Source View session and returns to the Source
View session where a CALL or VIEW command was entered. Specifying a program
name returns to a particular program in the calling chain.

The current program is VIAIDEMO. To display the VIAIDEM1 program on the Source
View screen, type

CALL VIAIDEMI1

After the above command finishes executing, type GOBACK to return to the VIAIDEMO
Source View session.
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HELP Command

Help | ?

Function

Operands
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X

——MESSAGE | MSGJ \;VIAmsg# |
msg#

——COMMANDs

——cmd

——ABENDs

—SCREEN

The HELP command displays information about the current Insight screen, pop-up,
commands, messages, or abend codes.

Blank

Displays the Help Tutorial for the current screen or pop-up, that
describes all the fields on the screen or pop-up, and any special
processing considerations. If a message displays, type HELP with
no operands to display the Help Explanation and Action Panel for
the current message.

MESSAGE | MSG

Displays the Help Explanation and Action Panel, that shows the
specified short and long message, an explanation of the current
message, and any actions to be performed.

ASGmsg# | msg#

Specifies the message number where the Help Explanation and
Action Panel screen is to be displayed. This number consists of 1 to
4 digits. It is not necessary to enter leading zeros.

COMMANDs

Displays a list of all Insight primary commands. Information for a
particular command can then be displayed by selecting the
appropriate number.

cmd

Specifies an Insight primary command. When help is requested for
a command, a long message displays giving a brief description of
that command. Requesting help again then displays more detailed
information about the command.

ABENDs

Displays the Abends screen that lists the types of abend codes.

SCREEN

Displays help for the current screen or pop-up, that describes all
fields on the screen or pop-up, and any special processing
considerations.
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HIGH Command

+

HIGH name
rLABEL
FMARK
+PERFRANGE -
rPROGRAM—
FSUBSET—

v

{-range—

~LINE
—name—|

L PARAGRAPH-

+
r name

DATAJ SQL— Ref DIRect— ALIasﬂ
IDMS— Use NOAlias
: Mod INDirect

Def SIZeJ LLEVeIs nJ

VALue
ALIasﬂ
NOAlias

string
7PATTERNJ |EX'strinq' —WORD Lcolumn1J Lcoluman

*

T 'string'— —PREFIX
P 'string'— “——SUFFIX

» »<
——Next— L ]
—Prev— IN-Y name—|
——Flrst—y —MARK
——LAst— —PERFRANGE —

—All —PROGRAM—
—SUBSET—
T Rl
—LINE
o name—
—PARAGRAPH

Function

The HIGH command highlights source code lines containing the specified targets. Lines
already highlighted are not reset.

Operand Description

LABEL name  Specifies the paragraph or section name of the PROCEDURE
DIVISION or the literals PROCEDURE or PROC where the FLOW
command is to begin.

Operands

MARK name  Specifies a 1 to 10 alphanumeric character name given to a set or path
using the COPY, MARK, MERGE, or RENAME commands, or one
of these system-generated paths:
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System generated path:  Created by:

TRACK | TRK A TRACE command.
NETWORK | NET A FLOW command.
SUBNETn | SUBn A path created by the FLOW command

that reaches from the beginning of the
NETWORK to one of the results (nth
result).

Note:

The TRACK, NETWORK, and SUBNET paths can also be created
using the Logic Order Search pop-ups (see "Logic Pull-down" on

page 101).

PERFRANGE  Specifies the name in a PERFORM statement including all of the
name statements executed as a result of a PERFORM statement, or the name
of any section contained in the Declaratives.

This operand is valid in Source View only

PROGRAM Specifies the name of the main program or of any nested program
name representing all of the code contained in the program. This includes
all of the programs physically nested inside the specified program.

SUBSET name Specifies a predefined subset name. These are the valid subsets:

ASsignment  DEBug 10

CAll DEFinition LABel

Clcs DIRective MAINIine
COBOLII DIVision MATH
COBOL/370  DL/1|DL/1 Output
COMment DML PARagraph
CONditional ~ ENtry PERform
COPy EXIt|PGM  ExitRETurn
DB2/SQL FALLthrough SECtion
DDL GOto SORTMerge
DEAD IDMS STructure
DEADCode  INClude TESted
DEADData Input UNTested
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A screen subset:

Highlighted | HI
NONHighlighted | NHI
Excluded | X
NONExcluded | NX

Tagged lines subsets of tags in columns 73 through 80.

Note:
See the ASG-Insight User’s Guide for a description of each subset

LINE range Specifies a single line number or range of lines. Line numbers display
in columns 1 through 6 of Source View.

PARAGRAPH  Specifies a PROCEDURE DIVISION paragraph name or section

name name, or the literals PROCEDURE and PROC. The entire paragraph

or section is included.

asterisk (¥)

Reuses the target of the previous HIGH command.

DATA name

Specifies a COBOL dataname or qualified COBOL dataname.
Dataname refers to any valid COBOL reference for a data element.
These subordinate operands apply to the dataname and can be used to
further qualify the EXCLUDE command: REF, USE, MOD, DEF,
ALIAS,NOALIAS, DIRECT, and INDIRECT. The defaults are REF,
ALIAS, and DIRECT.

Ref

Excludes occurrences of the dataname where its value is defined,
tested, used, set, or modified. This is the default value for the DATA
name operand.

SQL name

Includes datanames that are DB2/SQL variables only.

IDMS name

Includes datanames that are IDMS variables only.

. name

Includes datanames that are COBOL variables only.

Ref

Includes occurrences of the dataname where its value is defined,
tested, used, set, or modified. This is the default value for the DATA
name operand.

Use

Excludes occurrences of the dataname where its value is being tested
or used.
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Mod Excludes occurrences of the dataname where its value is being set or
modified.

Def Includes definitions of the dataname in the DATA DIVISION

AlLlas Searches backward from the cursor position to the previous

occurrence of the requested target.

Includes occurrences of the aliases for the dataname. These are the
valid aliases:

. Parent - higher level group item
. Child - lower level item
. Rename/Redefinition - renamed, redefined, or 88 level items

This is the default value for the DATA name operand.

NOAlias Ignores aliases for the specified dataname.

DIRect Includes occurrences of the dataname (and aliases if specified) where
it is directly tested, used, set, modified, or defined (based on the REF,
USE, MOD, or DEF selection). The default for the DATA name
operand is direct; however, if you specify the SIZE, VALUE, or
LEVELS operand, INDIRECT is assumed.

INDirect Includes any dataname indirectly affected by the specified dataname
(and aliases if specified). You can further qualify the indirect data
item by using the SIZE, VALUE, and LEVELS subordinate operands.
These subordinate operands indicate the type of indirect reference to
be located. SIZE and all levels are the defaults for the INDIRECT
operand.

SiZe Includes datanames that could be directly or indirectly affected if the
size of the specified dataname were to be changed. SIZE is only valid
with the INDIRECT operand. This is the default for the INDIRECT
operand.

VALue Includes occurrences of datanames that could be directly or indirectly
affected by a change if the value of the specified dataname were to be
changed. The LEVELS subordinate operand is not used with
VALUE. VALUE is only valid with the INDIRECT operand.

LEVels n Includes all data items affected within the specified number of
indirect levels. The VALUE subordinate operand is not used with
LEVELS. All levels is the default for the LEVELS operand. LEVELS
is only valid with the INDIRECT operand.
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PATTERN Indicates the characters that follow are part of a string.

string Specifies a string of alphanumeric or DBCS characters. If the pattern
string contains blanks, it must be enclosed in single or double quotes.
The pattern string can be further qualified by using the WORD,
PREFIX, or SUFFIX subordinate operands. These subordinate
operands describe how the pattern string is to be used.

X'string' Specifies the hexadecimal string option. You can specify specific
unprintable characters by giving the EBCDIC hexadecimal value. The
string must be enclosed in single or double quotes.

T'string Specifies the text string option. A character string may be entered
regardless of upper or lowercase by using the text option. The string
must be enclosed in single or double quotes.

P'string Specifies the picture string option. A string profile may be entered
instead of exact characters. The string must be enclosed in single or
double quotes. Insight defines nine special characters for use in
picture strings. These special characters can be combined with other
characters.

These are the special characters:

p=' Any character

P Any nonblank character
P Any nondisplay character
P'# Any numeric character
P Any character

P'@  Any character

p< Any character

P> Any character

P'$' Any character

WORD Specifies the specified pattern string preceded and followed by any
non-alphanumeric character (except a hyphen).

PREFIX Specifies a word that begins with the specified pattern string.

SUFFIX Specifies a word that ends with the specified pattern string.

Columnl Specifies the column number where the search is to begin.

Column2 Specifies the column number where the search is to end.
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Next Searches forward from the current cursor position to the next
occurrence of the requested target.

Prev Searches backward from the current cursor position to the previous
occurrence of the requested target.

Flrst Searches from the top of the source file to the first occurrence of the
requested target.

LAst Searches backward from the bottom of the source file to the first
occurrence of the requested target.

All Searches for all occurrences of the requested target and displays the
number found in the short/long message field. This is the default value
for the HIGH command.

IN Restricts the HIGH command to the specified target type.

Usage Notes

Source code lines can also be highlighted by selecting a Search pop-up on the Search
pull-down. See the online help for more information.

To concatenate targets, place a plus sign (+) between the target names. For example,
10 + CALL. These rules apply to concatenation:

. A concatenated dataname can be used wherever a dataname is valid. Dataname
subordinate operands (REF, ALIAS, etc.) pertain to all datanames in a concatenated
series.

. A concatenated set name can be used wherever a set name is valid. These sets can
be concatenated:

. LABEL . LINE

. MARK . PROGRAM

. PERFRANGE . PARAGRAPH
. SUBSET . PATTERN

. The asterisk (*) operand can be concatenated once with any number of other
operands (e.g., * + IE + MYSET); however, the * operand cannot be concatenated
to itself (* + * is invalid). The * operand may appear in any order in the
concatenated list.
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For COBOL II Release 3 or later programs, you can qualify a data item, label, or program
name that may be ambiguous or used multiple times by using OF followed by the
program name. For example, if the label P120-READ exists in another program and also
in the program VIAIDEM]1, then it can be qualified as P120-READ OF VIAIDEMI.

Lines can be added to a highlighted set. For example, to see all PERFORM statements,

then to add the conditional statements related to one of the PERFORM statements, use
FINDXTND PERFORM, then use HIGH CONDITIONAL to add the additional lines.

To step through all IO statements, type HIGH IO NEXT. Keep repeating the
command until the end of the program is located.

The H or HH line commands can also be used to highlight source code lines during a
Source View session.

All lines containing 1O statements are highlighted. Existing highlighted lines are not reset
when this command is issued.

HIGH IOPF15
Next, type this command
FX LAB IN HI

Only labels within the highlighted lines are highlighted. All other highlighted lines are
reset.
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JUMP Command

Y
A

JuMP
Function
The JUMP command is used to return to the Source View screen at the location
corresponding to the cursor position on the Tree View screen.
Operands

None.

Usage Notes

The JUMP command is used in conjunction with the cursor position. Type JUMP in the
command input area, position the cursor to the line containing the target of the jump, and
press Enter.

The J line command can also be used to return to the Source View screen from the Tree
View screen.
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KEYS Command

KEYS SAVE d >
sn
\—dsn (member)y——
LOAD dsn
\—dsn (member)y——
PFnn. ] string
Function

The KEYS command, entered with no operands, displays the Options - PF Key
Definition pop-up. This screen is used to display and/or modify the current Insight PF key
assignments.

The KEYS command may also save, restore, or modify the PF key assignments without
displaying the Options - PF Key Definition pop-up.

Operand Description

SAVE Saves the current PF Key definitions in a sequential or partitioned
dataset. If you do not specify a dataset name, this is the default name:

TSOuserid PPPnnnnn VIAPFKEY

Operands

where nnnnn is a unique, system-generated number.

LOAD Restores the PF Key definitions from the specified sequential or
partitioned dataset. A dataset name must be specified for the LOAD
operand.

dsn Specifies a sequential dataset name. If you include quotes, the dataset

name is used as is. If you do not include quotes, your TSO prefix or
userID is appended to the front of the dataset name and VIAPFKEY is
appended to the end of the dataset name. For example, if you type this
command:

SAVE TESTI1

the generated dataset name would be TSOuserid.TEST1.VIAPFKEY.
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Usage Notes

244

dsn(member)  Specifies a partitioned dataset and member name. If you include quotes,
the dataset name and member name are used as is. If you do not use
quotes, your TSO prefix or userID is appended to the front of the
dataset name. If the PDS member already exists, it is overwritten.

PFnn Provides a command line update to the PF key definition. For example,
this command assigns the text RESET EXCLUDED to PF key 21:

KEYS PF21 RESET EXCLUDED

If the text to be assigned begins with an equals sign (=), you must enter
two equal symbols separated by a space.If a null string is entered for the
PFnn operand, the PF Key assignment reverts to the default value for
the current ESW product.

The script facility verifies that the PF Key number is valid.

You can enter the KEYS command without operands on any Insight screen to display
and/or modify the current PF key assignments. Values assigned to the Insight PF keys
have no effect on other ISPF applications.

Use the SAVE and LOAD operands to save or restore PF Key settings. This feature
allows you to use the KEYS command in scripts to set PF Key assignments as desired.
This also provides a mechanism for multiple users to share a set of PF Key definitions.

The PFnn operand allows you to use the KEYS command in a script file to modify PF
Key settings during script file execution.

You can also display the Options - PF Key Definition pop-up by selecting PF Keys on the
Options pull-down. See the online help for more information about PF key assignments,
the Options - PF Key Definition pop-up, and the Options pull-down.
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LEVELS Command

LEVELs L&ﬁbm

Function

The LEVELS command redisplays the current Tree View or Structure View screen to the
specified level of program hierarchy depth.

Operand Description

Operands

number Redisplays the current screen to the level depth specified.
MAX Redisplays the current screen to the maximum number of levels in the
program.

Usage Notes

You can also change levels from the View - Levels Request pop-up. To display the
View - Levels Request pop-up, select View » Level and press Enter.

The LEVELS command redisplays the current screen to the level specified. If there are
less levels than the number specified, they expand to the requested level. If there are
levels greater than the number specified, they are removed. The LEVELS command is
only valid on the Tree View and Structure View screens.
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LIST Command

List

Function

Operands

246

—Calls
—Equates
—Marks
—Performs
—PRograms | PGms—
L—Subsets

The LIST command is used to display the specified pop-up. List pop-ups are available for
each operand shown above.

Operands Description

Blank Displays the List Menu pop-up that allows you to select one of the
other List pop-ups.

Calls Displays the List - CALL Statements pop-up that shows all of the
COBOL statements containing CALLs to other programs in the
active program. This pop-up also classifies the CALLs into
internal, static, and dynamic.

Equates Displays the List - Equates pop-up that shows all of the equates for
the active program.

Marks Displays the List - User Marks pop-up that shows the marks for the
active program.

Performs Displays the List - Perform Range Names pop-up that shows all of

the COBOL PERFORM ranges in the active program.

PRograms | PGms

Displays the List - Program/Subprogram Names pop-up, that
shows the nested program hierarchy structure.

For COBOL II Release 3 or later programs, you can qualify a data
item, label, or program name that may be ambiguous or used
multiple times by using OF followed by the program name. For
example, if the label P120-READ exists in another program and
also in the program VIAIDEMI, then it can be qualified as
P120-READ OF VIAIDEMI.

Subsets

Displays the List - COBOL Subset Names pop-up that shows all
subsets along with a brief description of each. Valid in Source
View.
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Usage Notes

You can also access these pop-ups by selecting an action on the List pull-down.

List Menu Pop-up

The List Menu pop-up is used to select the specified pop-up that displays pertinent
information about the program being viewed. A screen similar to Figure 101 displays
when you type LI ST without operands.

Figure 101 « LIst Menu Pop-up

List Henu
Felect the list fo be displayed. Then press Enter.

% Keyward Dezcription

CALLE List CALLed prograMs and their Aode
EQUATEE List EQUATEZ for the curtent prograd

HARK S List HARKS for the current prograd
PERFORHE Li=t PERFORH ranges

PROGRAAE LisT PROGRARE and subPROGRAME

EUBZETE List COBOL SUBSETE and their descriptions

| I T N T I

Select any item on this pop-up by typing S to the left of the desired keyword. The pop-up
for the selected option displays.
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LOCATE Command

Locate string »<
. Iabeli‘
&CURRent:

Function
The LOCATE command scrolls to the selectable label or entry that most closely matches
the specified string. LOCATE is valid on the Source View screen, the File - AKR
Directory pop-up, the File - AKR Program Selection pop-up, all List pop-ups except the
List -Program/Subprogram Names pop-up, and the Trace Decision Options pop-up.
Operands

Operands Description

string Specifies an alphanumeric or DBCS character string that locates a particular
item on a list or directory type screen.

.label Locates a line label entered in the line command area (columns 1 through 6)
on the Source View screen.

&CURRent Positions the Source View screen to the last location marked by the
CURRENT command. If no CURRENT command has preceded the
LOCATE &CURRENT command, the message § CURRENT NOT AVAIL
displays and the screen is not repositioned. The &CURRENT operand is
only valid on the Source View screen.

Usage Notes

You can specify a character string when an exact program name or list item is not known.
The LOCATE command displays the item that most closely matches the specified
character string. Matching is done alphabetically.
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Examples

Example 1. This command displays the line containing an item that matches or
follows S:

LOCATE S

Example 2. This command positions the display to the location marked by the most
recent CURRENT command.

LOCATE &CURRENT
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LPRINT Command

LPrint

Function

Operands
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| PERFRANGE-]
- PROGRAM—
| SUBSET—|

name

range—

“PARAGRAPH-

name—

+

name ‘

] string
—PATTERN X 'string’
|ET 'string* |E
P 'string"

Lcolumn 1J Lcolumn 2J

v

v
N

+

\—NOTE commentJ

Ln\-

—MARK:

—PERFRANGE—
—PROGRAM—
—SUBSET——

I Rk
LLINE
ﬁ—name—
L PARAGRAPH

LABEL name

A4
A

The LPRINT command is used to copy lines containing the specified target to the List
file. The List file is processed on the Options - Log/List/Punch Definition pop-up.

Operand Description

Specifies the paragraph or section name of the PROCEDURE

DIVISION or the literals PROCEDURE or the PROC where the

FLOW command is to begin.
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Operand Description

MARK name  Specifies a 1 to 10 alphanumeric character name given to a set or path
using the COPY, MARK, MERGE, or RENAME commands, or one

of these system-generated paths:

System generated path: Created by:
TRACK | TRK A TRACE command.
NETWORK | NET A FLOW command.

SUBNETn | SUBn A path created by the FLOW command
that reaches from the beginning of the
NETWORK to one of the results (nth
result).

Note:

The TRACK, NETWORK, and SUBNET paths can also be created
using the Logic Order Search pop-ups (see "Logic Pull-down" on

page 101).

PERFRANGE  Specifies the name in a PERFORM statement including all statements
name executed as a result of a PERFORM statement, or the name of any
section contained in the Declaratives.

This operand is valid in Source View only

PROGRAM Specifies the name of the main program or any nested program
name representing all the code contained in the program. This includes all
the programs physically nested inside the specified program.

SUBSET name Specifies a predefined subset. These are the valid subsets:

ASsignment  DEBug
CAll DEFinition
Clcs DIRective
COBOLII DIVision
COBOL/370  DL/1|DL/1
COMment DML

(0]

LABel
MAINIine
MATH
Output
PARagraph
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CONditional  ENtry PERform
COPy EXIt|PGM  ExitRETurn
DB2/SQL FALLthrough SECtion
DDL GOto SORTMerge
DEAD IDMS STructure
DEADCode  INClude TESted
DEADData Input UNTested

A screen subset:

Highlighted | HI
NONHighlighted | NHI
Excluded | X
NONExcluded | NX

Tagged lines subsets of tags in columns 73 through 80.

Note:
See the ASG-Insight User’s Guide for a description of each subset

LINE range Specifies a single line number or range of lines. Line numbers display
in columns 1 through 6 of Source View.

PARAGRAPH  Specifies a PROCEDURE DIVISION paragraph name or section

name name, or the literals PROCEDURE and PROC. The entire paragraph
or section is included.

DATA name Specifies a COBOL dataname or qualified COBOL dataname.
Dataname refers to any valid COBOL reference for a data element.
These subordinate operands apply to the dataname and can be used to
further qualify the EXCLUDE command: REF, USE, MOD, DEF,
ALIAS,NOALIAS, DIRECT, and INDIRECT. The defaults are REF,
ALIAS, and DIRECT.

SQL name Includes datanames that are DB2/SQL variables only.

IDMS name Includes datanames that are IDMS variables only.

: name Includes datanames that are COBOL variables only.

Ref Includes occurrences of the dataname where its value is defined,

tested, used, set, or modified. This is the default value for the DATA
name operand.
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Use

Excludes occurrences of the dataname where its value is being tested
or used.

Mod

Excludes occurrences of the dataname where its value is being set or
modified.

Def

Includes definitions of the dataname in the DATA DIVISION

AlLlas

Searches backward from the cursor position to the previous
occurrence of the requested target.

Includes occurrences of the aliases for the dataname. These are the
valid aliases:

. Parent - higher level group item
. Child - lower level item
. Rename/Redefinition - renamed, redefined, or 88 level items

This is the default value for the DATA name operand.

NOAlias

Ignores aliases for the specified dataname.

DIRect

Includes occurrences of the dataname (and aliases if specified) where
it is directly tested, used, set, modified, or defined (based on the REF,
USE, MOD, or DEF selection). The default for the DATA name
operand is direct; however, if you specify the SIZE, VALUE, or
LEVELS operand, INDIRECT is assumed.

INDirect

Includes any dataname indirectly affected by the specified dataname
(and aliases if specified). You can further qualify the indirect data
item using the SIZE, VALUE, and LEVELS subordinate operands.
These subordinate operands indicate the type of indirect reference to
be located. SIZE and all levels are the defaults for the INDIRECT
operand.

SIZe

Includes datanames that could be directly or indirectly affected if the
size of the specified dataname were to be changed. SIZE is only valid
with the INDIRECT operand. This is the default for the INDIRECT
operand.

VALue

Includes occurrences of datanames that could be directly or indirectly
affected by a change if the value of the specified dataname were to be
changed. The LEVELS subordinate operand is not used with
VALUE. VALUE is only valid with the INDIRECT operand.
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LEVels n

Includes all data items affected within the specified number of
indirect levels. The VALUE subordinate operand is not used with
LEVELS. All levels is the default for the LEVELS operand. LEVELS
is only valid with the INDIRECT operand.

PATTERN

Indicates the characters that follow are part of a string.

string

Specifies a string of alphanumeric or DBCS characters. If the pattern
string contains blanks, it must be enclosed in single or double quotes.
The pattern string can be further qualified using the WORD, PREFIX,
or SUFFIX subordinate operands. These subordinate operands
describe how the pattern string is to be used.

X'string'

Specifies the hexadecimal string option. Specific unprintable
characters may be specified by giving the EBCDIC hexadecimal
value. The string must be enclosed in single or double quotes.

T'string

Specifies the text string option. A character string may be entered
regardless of upper or lowercase by using the text option. The string
must be enclosed in single or double quotes.

P'string

Specifies the picture string option. You can enter a string profile
instead of exact characters. The string must be enclosed in single or
double quotes. Insight defines nine special characters for use in
picture strings. These special characters can be combined with other
characters.

These are the special characters:
pP=' Any character

P Any nonblank character
P Any nondisplay character
P'# Any numeric character
p-' Any character

P'‘@'  Any character

p< Any character

P> Any character

P'§' Any character

WORD

Specifies the specified pattern string preceded and followed by any
non-alphanumeric character (except a hyphen).

PREFIX

Specifies a word that begins with the specified pattern string.
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10 Commands - LPRINT Command

SUFFIX Specifies a word that ends with the specified pattern string.
Columnl1 Specifies the column number where the search is to begin.
Column2 Specifies the column number where the search is to end.
asterisk (*) Causes the entire virtual screen (all data that can be viewed by

scrolling forward and backward) to be copied to the List file. All
excluded lines are copied to the List file as excluded lines (as they
appear on the screen at the time the LPRINT * command is entered).

Next Searches forward from the current cursor position to the next
occurrence of the requested target.

Prev Searches backward from the current cursor position to the previous
occurrence of the requested target.

Flrst Searches from the top of the source file to the first occurrence of the
requested target.

LAst Searches backward from the bottom of the source file to the first
occurrence of the requested target.

All Searches for all occurrences of the requested target and displays the
number found in the short/long message field. This is the default value
for the HIGH command.

IN Restricts the HIGH command to the specified target type.

NOTE comment Places descriptive comment lines in the List file. These comments are
included in the printed output from the List file. Text of the comment
may be a maximum of 50 alphanumeric or 23 DBCS characters.

Lines can also be copied to the List file by selecting a Search pop-up on the Search
pull-down. See the online help for more information.

To concatenate targets, place a plus sign (*) between the target names. For example, 10 +
CALL. These rules apply to concatenation:

. A concatenated dataname can be used wherever a dataname is valid. Dataname
subordinate operands (REF, ALIAS, etc.) pertain to all datanames in a concatenated
series.
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. A concatenated set name can be used wherever a set name is valid. These sets can
be concatenated:

. LABEL . LINE

. MARK . PROGRAM

. PERFRANGE . PARAGRAPH
. SUBSET

For COBOL II Release 3 or later programs, you can qualify a data item, label, or program
name that may be ambiguous or used multiple times by using OF followed by the
program name. For example, if the label P120-READ exists in another program and also
in the program VIAIDEM]1, then it can be qualified as P120-READ OF VIAIDEMI.

LPRINT copies the specified target to the List file for subsequent printing.

LPRINT * can be entered on these pop-ups and the Tree View and Source View screen to
copy them to the List file:

. List - CALL Statements

. List - Equates

. List - User Marks

. List - Perform Range Names

. List - Program/Subprogram Names
. List - COBOL Subset Names

. View - Paragraph Cross Reference

Example 1. To copy all lines containing the characters ZIP for subsequent printing, type
this command:

LPRINT ZIP
Example 2. To copy the entire source file to the List file, type this command:

LPRINT *
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10 Commands - LPUNCH Command

\4
-

LPUnch name
- LABEL
L MARK
- PERFRANGE
- PROGRAM—|
L SUBSET—|
range—
LLINE
name—
L PARAGRAPH-
’ \
name
_pata] [saL—| Ref DIRect— tALIasﬂ
IDMS— Use NOAlias
: Mod INDirect
Def SIZeJ LLEVeIs nJ
VALue
ALIasﬂ
NOAlias
string
7PATTERNJ X 'string' WORD Lcolumn 1J Lcolumn ZJ
T 'string’ PREFIX
P 'string’ SUFFIX
L« > 2
1) »<
Next— +
Prev—- IN name—
First—| - MARK
Last— - PERFRANGE
Al - PROGRAM—
- SUBSET—
Ne T e
- LINE
ﬁ—namef
L PARAGRAPH
2>
Function
The LPUNCH command is used to copy lines containing the specified target to the Punch
file for subsequent processing. The Punch file is processed on the
Options - Log/List/Punch Definition pop-up.
Operands

Operand Description

LABEL name  Specifies the paragraph or section name of the PROCEDURE
DIVISION or the literals PROCEDURE or PROC where the FLOW
command is to begin.

MARK name  Specifies a 1 to 10 alphanumeric character name given to a set or path

using the COPY, MARK, MERGE, or RENAME commands, or one

of these system-generated paths:
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System generated path:  Created by:
TRACK | TRK A TRACE command.
NETWORK | NET A FLOW command.

SUBNETn | SUBn

A path created by the FLOW command

that reaches from the beginning of the
NETWORK to one of the results (nth
result).

Note:

The TRACK, NETWORK, and SUBNET paths can also be created
using the Logic Order Search pop-ups (see "Logic Pull-down" on

page 101).

PERFRANGE

name

Specifies the name in a PERFORM statement including all statements
executed as a result of a PERFORM statement, or the name of any
section contained in the Declaratives.

This operand is valid in Source View only

PROGRAM
name

Specifies the name of the main program or any nested program
representing all the code contained in the program. This includes all
the programs physically nested inside the specified program.

SUBSET name
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Specifies a predefined subset. These are the valid subsets:

ASsignment  DEBug
CAll DEFinition
Clcs DIRective
COBOLII DIVision
COBOL/370  DL/1|DL/1
COMment DML
CONditional ~ ENtry
COPy EXIt | PGM
DB2/SQL FALLthrough
DDL GOto
DEAD IDMS
DEADCode  INClude
DEADData Input

(0]

LABel
MAINIine
MATH
Output
PARagraph
PERform
ExitRETurn
SECtion
SORTMerge
STructure
TESted
UNTested
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A screen subset:

Highlighted | HI
NONHighlighted | NHI
Excluded | X
NONExcluded | NX

Tagged lines subsets of tags in columns 73 through 80.

Note:
See the ASG-Insight User’s Guide for a description of each subset

LINE range Specifies a single line number or range of lines. Line numbers display
in columns 1 through 6 of Source View.

PARAGRAPH  Specifies a PROCEDURE DIVISION paragraph name or section

name name, or the literals PROCEDURE and PROC. The entire paragraph
or section is included.

DATA name Specifies a COBOL dataname or qualified COBOL dataname.
Dataname refers to any valid COBOL reference for a data element.
These subordinate operands apply to the dataname and can be used to
further qualify the EXCLUDE command: REF, USE, MOD, DEF,
ALIAS,NOALIAS, DIRECT, and INDIRECT. The defaults are REF,
ALIAS, and DIRECT.

SQL name Includes datanames that are DB2/SQL variables only.

IDMS name Includes datanames that are IDMS variables only.

: name Includes datanames that are COBOL variables only.

Ref Includes occurrences of the dataname where its value is defined,
tested, used, set, or modified. This is the default value for the DATA
name operand.

Use Excludes occurrences of the dataname where its value is being tested
or used.

Mod Excludes occurrences of the dataname where its value is being set or
modified.

Def Includes definitions of the dataname in the DATA DIVISION
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ALlas

Searches backward from the cursor position to the previous
occurrence of the requested target.

Includes occurrences of the aliases for the dataname. These are the
valid aliases:

. Parent - higher level group item
. Child - lower level item
. Rename/Redefinition - renamed, redefined, or 88 level items

This is the default value for the DATA name operand.

NOAlias

Ignores aliases for the specified dataname.

DIRect

Includes occurrences of the dataname (and aliases if specified) where
it is directly tested, used, set, modified, or defined (based on the REF,
USE, MOD, or DEF selection). The default for the DATA name
operand is direct; however, if you specify the SIZE, VALUE, or
LEVELS operand, INDIRECT is assumed.

INDirect

Includes any dataname indirectly affected by the specified dataname
(and aliases if specified). You can further qualify the indirect data
item using the SIZE, VALUE, and LEVELS subordinate operands.
These subordinate operands indicate the type of indirect reference to
be located. SIZE and all levels are the defaults for the INDIRECT
operand.

SIZe

Includes datanames that could be directly or indirectly affected if the
size of the specified dataname were to be changed. SIZE is only valid
with the INDIRECT operand. This is the default for the INDIRECT
operand.

VALue

Includes occurrences of datanames that could be directly or indirectly
affected by a change if the value of the specified dataname were to be
changed. The LEVELS subordinate operand is not used with
VALUE. VALUE is only valid with the INDIRECT operand.

LEVels n

Includes all data items affected within the specified number of
indirect levels. The VALUE subordinate operand is not used with
LEVELS. All levels is the default for the LEVELS operand. LEVELS
is only valid with the INDIRECT operand.

PATTERN

Indicates the characters that follow are part of a string.
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string Specifies a string of alphanumeric or DBCS characters. If the pattern
string contains blanks, it must be enclosed in single or double quotes.
You can further qualify the pattern string using the WORD, PREFIX,
or SUFFIX subordinate operands. These subordinate operands
describe how the pattern string is to be used:

X'string' Specifies the hexadecimal string option. You can specify specific
unprintable characters by giving the EBCDIC hexadecimal value. The
string must be enclosed in single or double quotes.

T'string Specifies the text string option. Use the text option to enter a character
string regardless of upper or lowercase. The string must be enclosed
in single or double quotes.

P'string Specifies the picture string option. You can enter a string profile
instead of exact characters. The string must be enclosed in single or
double quotes. Insight defines nine special characters for use in
picture strings, and you can combine these special characters with
other characters.

These are the special characters:

p=' Any character

P Any nonblank character
P Any nondisplay character
P'# Any numeric character
p-' Any character

P'‘@'  Any character

p< Any character

P> Any character

P'§' Any character

WORD Specifies the specified pattern string preceded and followed by any
non-alphanumeric character (except a hyphen).

PREFIX Specifies a word that begins with the specified pattern string.

SUFFIX Specifies a word that ends with the specified pattern string.

Columnl Specifies the column number where the search is to begin.

Column2 Specifies the column number where the search is to end.
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asterisk (*) Causes the entire virtual screen (all data that can be viewed by
scrolling forward and backward) to be copied to the List file. All
excluded lines are copied to the List file as excluded lines (as they
appear on the screen at the time the LPRINT * command is entered).

Next Searches forward from the current cursor position to the next
occurrence of the requested target.

Prev Searches backward from the current cursor position to the previous
occurrence of the requested target.

Flrst Searches from the top of the source file to the first occurrence of the
requested target.

LAst Searches backward from the bottom of the source file to the first
occurrence of the requested target.

All Searches for all occurrences of the requested target and displays the
number found in the short/long message field. This is the default value
for the HIGH command.

IN Restricts the HIGH command to the specified target type.

Usage Notes
You can also copy lines to the Punch file by selecting a Search pop-up on the Search
pull-down. See the online help for more information.
LPUNCH copies the specified targets to the Punch file for subsequent processing.
To concatenate targets, place a plus sign (+) between the target names. For example, 10 +
CALL. These rules apply to concatenation:

. A concatenated dataname can be used wherever a dataname is valid. Dataname
subordinate operands (REF, ALIAS, etc.) pertain to all datanames in a concatenated
series.

. A concatenated set name can be used wherever a set name is valid. These sets can
be concatenated:

. LABEL . LINE

. MARK . PROGRAM

. PERFRANGE . PARAGRAPH
. SUBSET
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For COBOL II Release 3 or later programs, a data item, label, or program name that may
be ambiguous or used multiple times can be qualified by using OF followed by the
program name. For example, if the label P120-READ exists in another program and also
in the program VIAIDEM]1, then it can be qualified as P120-READ OF VIAIDEMI.

LPUNCH * can be entered on Tree View and Source View screens.

This command copies all the input and output statements of the current program into the
Punch file.

LPUNCH IO
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MARK Command

Mark

Function

A

+

mark-

Operands
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rLABEL
rMARK
rPERFRANGE-|
rPROGRAM—
FSUBSET—

FLINE

name

range—|

L PARAGRAPH-

name—

[_pg] name LNOTEﬁ
comment

The MARK command is used to save the requested target as a mark set or path. An
optional description can be included if desired.

Operand Description

LABEL name

Specifies the paragraph or section name of the PROCEDURE
DIVISION or the literals PROCEDURE or PROC where the FLOW
command is to begin.

MARK name

Specifies a 1 to 10 alphanumeric character name given to a set or path
using the COPY, MARK, MERGE, or RENAME commands, or one
of these system-generated paths:

System generated path: ~ Created by:
TRACK | TRK A TRACE command.
NETWORK | NET A FLOW command.

SUBNETn | SUBn A path created by the FLOW command
that reaches from the beginning of the
NETWORK to one of the results (nth
result).

Note:

The TRACK, NETWORK, and SUBNET paths can also be created
using the Logic Order Search pop-ups (see "Logic Pull-down" on

page 101).

PERFRANGE

name

Specifies the name specified in a PERFORM statement including all
statements executed as a result of a PERFORM statement, or the name
of any section contained in the Declaratives.

This operand is valid in Source View only
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Operand Description

PROGRAM
name

Specifies the name of the main program or any nested program
representing all the code contained in the program. This includes all

the programs physically nested inside the specified program.

SUBSET name Specifies a predefined subset. These are the valid subsets:

ASsignment
CAll

Clcs
COBOLII
COBOL/370
COMment
CON(ditional

COPy
DB2/SQL
DDL
DEAD
DEADCode
DEADData

A screen subset:

Highlighted | HI

DEBug
DEFinition
DIRective
DIVision
DL/T| DL/1
DML
ENtry

EXIt | PGM
FALLthrough
GOto

IDMS
INClude
Input

NONHighlighted | NHI

Excluded | X

NONExcluded | NX

10

LABel
MAINIine
MATH
Output
PARagraph
PERform

ExitRETurn
SECtion
SORTMerge
STructure
TESted
UNTested

Tagged lines subsets of tags in columns 73 through 80.

Note:

See the ASG-Insight User’s Guide for a description of each subset

LINE range Specifies a single line number or range of lines. Line numbers display
in columns 1 through 6 of Source View.

PARAGRAPH Specifies a PROCEDURE DIVISION paragraph name or section

name name, or the literals PROCEDURE and PROC. The entire paragraph

or section is included.
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AS Specifies an optional keyword indicating the mark name that follows
is the name to be assigned to the target.

mark-name A name assigned to a path or set of lines using the MARK command
or the Options - Scratchpad Mark pop-up. The specified name must
meet these requirements:

. A maximum of 10 alphanumeric characters, including hyphens.
Names longer than 10 characters truncate.

. Must begin with an alphabetic character.

NOTE comment Provides an optional description about the new mark name. Comment
text can be a maximum of 50 alphanumeric or 23 DBCS characters. If
the NOTE comment operand is not entered, the existing comment is
copied to the new mark name. If NOTE is entered without comment
text, the existing comment is not copied to the new mark name.

You can also create, copy, delete, merge, and rename mark sets and paths by selecting
one of the options on the Options - Scratchpad pop-up. See the online help for more
information.

To concatenate targets, place a plus sign (+) between the target names. For example,
IO+CALL. A concatenated set name can be used wherever a set name is valid. These sets
can be concatenated:

. LABEL . LINE

. MARK . PROGRAM

. PERFRANGE . PARAGRAPH
. SUBSET

For COBOL II Release 3 or later programs, you can qualify a data item, label, or program
name that may be ambiguous or used multiple times by using OF followed by the
program name. For example, if the label P120-READ exists in another program and also
in the program VIAIDEMI, then it can be qualified as P120-READ OF VIAIDEMI.

The target of a MARK command can be saved multiple times under different names.

This command captures the system-generated path called TRACK and is named FICA
(both paths exist).

MARK TRACK AS FICA
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MERGE Command

—+
mark-

MErge —Y name »<
-LABEL Lwith)  name LNOTEﬁ
FMARK comment

- PERFRANGE
- PROGRAM—|
- SUBSET—

range—
~LINE

name—

L PARAGRAPH-

Function
The MERGE command adds the lines from the specified target to the specified mark
name. If the specified mark name does not exist, it is created. A comment included with
the MERGE command replaces an existing one.

Operands

Operand Description

LABEL name  Specifies the paragraph or section name of the PROCEDURE
DIVISION or the literals PROCEDURE or PROC where the FLOW
command is to begin.

MARK name  Specifies a 1 to 10 alphanumeric character name given to a set or path
using the COPY, MARK, MERGE, or RENAME commands, or one
of these system-generated paths:

System generated path:  Created by:

TRACK | TRK A TRACE command.
NETWORK | NET A FLOW command.
SUBNETn | SUBn A path created by the FLOW command

that reaches from the beginning of the
NETWORK to one of the results (nth
result).

Note:

The TRACK, NETWORK, and SUBNET paths can also be created
using the Logic Order Search pop-ups (see "Logic Pull-down" on

page 101).
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Operand Description

PERFRANGE  The name specified in a PERFORM statement including all

name statements executed as a result of a PERFORM statement, or the name
of any section contained in the Declaratives. This operand is valid in
Source View only

PROGRAM The name of the main program or any nested program representing all
name the code contained in the program. This includes all the programs
physically nested inside the specified program.

SUBSET name Specifies a predefined subset. These are the valid subsets:

ASsignment  DEBug 10

CAll DEFinition LABel

Clcs DIRective MAINIline
COBOLII DIVision MATH
COBOL/370 DL/ |DL/1  Output
COMment DML PARagraph
CONditional ~ ENtry PERform
COPy EXIt|PGM  ExitRETurn
DB2/SQL FALLthrough SECtion
DDL GOto SORTMerge
DEAD IDMS STructure
DEADCode  INClude TESted
DEADData Input UNTested

A screen subset:

Highlighted | HI
NONHighlighted | NHI
Excluded | X
NONExcluded | NX

Tagged lines subsets of tags in columns 73 through 80.

Note:
See the ASG-Insight User’s Guide for a description of each subset

LINE range Specifies a single line number or range of lines. Line numbers display
in columns 1 through 6 of Source View.

PARAGRAPH Specifies a PROCEDURE DIVISION paragraph name or section
name name, or the literals PROCEDURE and PROC. The entire paragraph
or section is included.
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WITH Specifies an optional keyword indicating the mark name that follows
is to be merged with the specified target.

mark-name Specifies a name assigned to a path or set of lines using the MARK
command or the Options - Scratchpad Mark pop-up. The specified
name must meet these requirements:

. A maximum of 10 alphanumeric characters, including hyphens.
Names longer than 10 characters truncate.

. Must begin with an alphabetic character.

NOTE comment Provides an optional description about the name. Comment text can
be a maximum of 50 alphanumeric or 23 DBCS characters. If you do
not enter the NOTE comment operand, the existing comment is
copied to the new mark name. If you enter NOTE without comment
text, the existing comment is not copied to the new mark name.

You can also merger paths and sets on the Options - Scratchpad Merge pop-up. See the
online help for more information. A set of lines can be merged with another set of lines,
or a path can be merged to a set of lines.

To concatenate targets, place a plus sign (+) between the target names. For example,
IO+CALL. A concatenated set name can be used wherever a set name is valid. These sets
can be concatenated:

. LABEL . LINE

. MARK . PROGRAM

. PERFRANGE . PARAGRAPH
. SUBSET

For COBOL II Release 3 or later programs, you can qualify a data item, label, or program
name that may be ambiguous or used multiple times by using OF followed by the
program name. For example, if the label P120-READ exists in another program and also
in the program VIAIDEMI, then it can be qualified as P120-READ OF VIAIDEMI.

The command below merges the contents of TRACK with the set of lines called FICA.

MERGE TRACK WITH FICA
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PARMDEF Command

X

PARMDEF | PDEF

Function
The PARMDEF command displays the Options - Product Parameters pop-up. The
Options - Product Parameters pop-up is used to set parameters that affect the online
operation of Insight.

Operands

None.

Usage Notes

You can also display the Options - Product Parameters pop-up by selecting Options P
Product parameters.
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PREF Command

—+
Pref —Y

—4’*Setname* i:NeXt
—MARK Prev

v

Function

Operands

—PERFRANGE—
—PROGRAM—
—SUBSET—

TV ek
- LINE

name
7LABELq
—PARAGRAPH

name——

The PREF command is used to display the View - Paragraph Cross Reference pop-up for
the requested target. The View - Paragraph Cross Reference pop-up shows how control is
transferred to or from the target paragraphs.

Operand Description

Blank If no operand is entered, the target paragraph set is determined
by the cursor location when the PREF command is issued.

MARK setname Specifies a 1 to 10 character SBCS or a 1 to 4 character DBCS
name given to a set using the COPY, MARK, MERGE, or
RENAME commands.

PERFRANGE name  Specifies the first statement within the specified PERFORM
range.

PROGRAM name Specifies the first executable statement within the specified
program.
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Operand Description

SUBSET name Specifies a predefined subset. These are the valid subsets:
ASsignment  DEBug 10
CAll DEFinition LABel
Clcs DIRective MAINIine
COBOLII DIVision MATH
COBOL/370  DL/I | DL/1 Output
COMment DML PARagraph
CONditional ~ ENtry PERform
COPy EXIt|PGM  ExitRETurn
DB2/SQL FALLthrough SECtion
DDL GOto SORTMerge
DEAD IDMS STructure
DEADCode INClude TESted
DEADData Input UNTested

A screen subset:

Highlighted | HI
NONHighlighted | NHI
Excluded | X
NONEzxcluded | NX

Tagged lines subsets of tags in columns 73 through 80.

Note:

See the ASG-Insight User’s Guide for a description of each
subset

LINE range Specifies a single line number or range of lines. Line numbers
display in columns 1 through 6 of Source View.

LABEL name Specifies any PROCEDURE DIVISION paragraph name or
section name, or the literals PROCEDURE and PROC. All
transfers of control to the label name are included.

PARAGRAPH name Specifies a PROCEDURE DIVISION paragraph name or
section name, or the literals PROCEDURE and PROC. The
entire paragraph or section is included.
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Next Generates a list of paragraphs to where the target paragraph
transfers control.

Prev Generates a list of paragraphs that transfer control to the target
paragraph. This is the default for the PREF command.

You can also display the View - Paragraph Cross Reference pop-up by selecting View »
Paragraph X-ref and pressing Enter.

The PREF command includes all paragraphs containing the target lines. For example,
PREF IO displays every paragraph containing 1O statements.

To concatenate targets, place a plus sign (+) between the target names. For example,
IO+CALL. A concatenated set name can be used wherever a set name is valid. These sets
can be concatenated:

. LABEL . LINE

. MARK . PROGRAM

. PERFRANGE . PARAGRAPH
. SUBSET

For COBOL II Release 3 or later programs, you can qualify a data item, label, or program
name that may be ambiguous or used multiple times by using OF followed by the
program name. For example, if the label P120-READ exists in another program and also
in the program VIAIDEM]1, then it can be qualified as P120-READ OF VIAIDEMI.

When there is a blank target with the cursor located on excluded lines, these items apply:

. The first line of the excluded block is implicitly selected.

. If the selected line is not a label, then a backward search is done to locate the
previous label. This label then becomes the target.

Note:
See the online help for more information about the View - Paragraph Cross Reference
pop-up.

The command below displays the View - Paragraph Cross Reference pop-up with all
paragraphs that transfer control to the WRITE-ROUTINE paragraph.

PREF WRITE-ROUTINE
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PRINTLOG Command

PRINTLOG | PLOg

Function

The PRINTLOG command is used to display the Options - Log/List/Punch Definition
pop-up. On this pop-up the Log, List, and Punch files are processed.

Operands

None.

Usage Notes

The Options - Log/List/Punch Definition pop-up can also be displayed by selecting
Options » Log/list/punch and pressing Enter.

The PRINTLOG command can be issued on any Insight screen.
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PRINTLST Command

PRINTLST | PLIst

Function

The PRINTLST command is used to display the Options - Log/List/Punch Definition
pop-up. On this pop-up the Log, List, and Punch files can be printed.

Operands

None.

Usage Notes

The Options - Log/List/Punch Definition pop-up can also be displayed by selecting
Options » Log/list/punch and pressing Enter.

The PRINTLST command can be issued from any Insight screen.

275



ASG-Insight Reference Guide

PROCESS Command

PROCess

Function

Operands

276

‘dsn'———
'dsn (member)—

L ] (member) model command »<«
STEP |;dsn (member)—

The PROCESS command defines an action to be performed repetitively on a file of input
items.

This file may contain the results list from an ESW product, or the file can be nested by the
user. The input items, called tokens, may be any text without embedded blanks or any
text enclosed in quotes. Tokens must be separated by one or more spaces.

The PROCESS primary command process the first nine tokens in a file. Any tokens
beyond nine are ignored. Any tokens referenced in the PROCESS command but not
present in the token file are passed as null.

Tokens enclosed in quotes retain their quotes after substitution in the model statement.

This example illustrates a possible format for a record in the token file:

tokenl 'token 2' token3 token4d token5 'token 6' token7 token8 token9

Insight, Encore, SmartTest, and Alliance can produce an output file using LPRINT,
LPUNCH, or the Query Facility. This file can be edited to produce a file of tokens that
can be read by the PROCESS primary command.

STEP Steps through the commands in the script file. Each command in the
script file displays in the command input area. The displayed
command can be changed or erased from the command input area.
Press Enter to execute the displayed command. Processing of the
script file continues in this manner until all commands have been
displayed or executed.

(member) Specifies a member in the default script library (defined during
product installation) that contains tokens to be processed. The
default script libraries may be modified for your profile using the
Script file allocation action on the Options pull-down. Parentheses
are required if only the member is entered.
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dsn(member)

Specifies a partitioned dataset member that contains tokens to be
processed. This dataset must be in card image format (LRECL=80).
The specified dataset name and member must be entered following
TSO usage conventions in this format:

'pds.dataset.name (member) '

Quotes are required unless the high-level qualifier is your TSO
UserID.

dsn

Model command

Specifies a sequential dataset that contains tokens to be processed.
This dataset must be in card image format (LRECL=80). The
specified dataset must be entered following TSO usage conventions
in this format:

'sequential.dataset.name'’

Quotes are required unless the high-level qualifier is your TSO
prefix or userlID.

Specifies any ESW product command that is valid in a Script file and
that can be defined using substitution variables. Tokens from the file
are always substituted in the model command in numerical order
from 1 through 9 for the substitution variables &1 through &9.

When the PROCESS command is included in a script, the model
command may optionally reference substitution variables that were
passed to the script. This is done by specifying any of the override
substitution variables &&1 through &&9.

The PROCESS command allows automated processing of the results from any ESW
product that can produce a text file of tokens.

For example, if Alliance creates a file of records named useri d PROGDATA.TEXT
where each record contained a program name and a dataname, the file can be processed
with the command:

PROCESS PROGDATA.TEXT EXECUTE SCANPROG.SCRIPT PARMS &1 &2

This command reads each record of the file PROGDATA.TEXT in turn and substitutes
program name from the record into substitution variable &1 and dataname from the

record into substitution variable &2. It then executes the named script
(userid.SCANPROG.SCRIPT), passing the substituted variables &1 and &2.
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The script file SCANPROG.SCRIPT might contain these commands to qualify a program
for viewing and execute another script file for the program.

0 &l
EXECUTE PROGPROC.SCRIPT PARMS &2

This allows the processing of multiple programs with a single command sequence.

To accomplish this task, the PROCESS command verifies and opens the specified file.
These logic steps are repeated until an end-of-file occurs for the specified file.

To process multiple programs with a single command sequence

1 Read a record. If the record is null or contains an asterisk (*) in column 1, ignore the
record and begin again.

2 Substitute tokens from the record into the substitution variables &1 through &9.
3 Construct a command using the model statement with the variable substitution.
4  Execute the constructed command as if it were a script command.

5  Repeat step 1 and subsequent steps until you reach an end-of-file.

PROCESS commands may occur within scripts and may be nested. If PROCESS
commands are nested, they must refer to different datasets.

These examples show how you might use the PROCESS command in its most basic form
to process a dataname list and then how this basic concept could be extended to automate
the same action for a list of programs.

The third example illustrates the use of override substitution variables.

Example 1. Given a file of datanames called useri d DATANAME.LIST, you could
execute this PROCESS command:

PROCESS DATANAME.LIST HI &1
Executing this command while on the Program View screen causes the HIGHLIGHT
command (HI) to be executed repetitively for each data item in the file

userid.DATANAME.LIST.

Example 2. Given a file of program names called userid PROGRAM.LIST, you
could execute this PROCESS command:

PROCESS PROGRAM.LIST EXEC MYSCRIPT.SCRIPT PARMS &1
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Assume that userid MYSCRIPT.SCRIPT contains these commands:

* STEP 1: OPEN THE PROGRAM

QUALIFY &1

* STEP 2: POSITION TO THE PROGRAM VIEW SCREEN (SmartTest only)
FX 1

* STEP 3: PROCESS THE DATA NAME LIST

PROCESS DATANAME.LIST HI &1

* STEP 4: SAVE THE RESULTS OF THE PROCESS COMMAND

SAVE MARKS AS &1MK

* STEP 5: CLOSE THE PROGRAM

QUALIFY CANCEL

The set of commands in userid MYSCRIPT.SCRIPT execute one time for each
program in useridPROGRAM.LIST. userid MYSCRIPT.SCRIPT contains a
PROCESS command that executes the model command, HIGHLIGHT, one time for each
record in userid DATANAME.LIST.

The result is a MARK set, named pgmnameMK, for each program in
userid.PROGRAM.LIST. Each MARK set contains highlighted references to uses in
the program of all datanames in userid. DATANAME.LIST.

Example 3. This example illustrates the technique of passing override substitution
variables &&1 and &&2 to the PROCESS command contained in the script.

EXEC (MYSCRIPT) PARMS ARGl ARG2 ARG3

Assume the script in member MYSCRIPT in the default script libraries contains this
PROCESS command:

PROCESS 'PROGRAM.LIST' EXEC (PGSCRIPT) PARMS &&2 &1 &2 &&1

The parameters from the initial EXECUTE statement and the tokens from the file are
substituted in the PROCESS statement model command:

&&2 1is passed the value ARG2

&1 is passed the first token of each record read from the file
'PROGRAM.LIST'

&2 1s passed the second token of each record read from the
file 'PROGRAM.LIST'

&&1 1is passed the value ARGl
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PRODLVL Command

X

PRODLVL

Function
The PRODLVL command is used to display the current Insight and Center product level.

Operands

None.

Usage Notes

This information is requested when you contact the ASG Service Desk for assistance.
This information can also be displayed from the Help - About pop-up. To display the
Help - About pop-up, select Help » About and press Enter.

The PRODLVL command displays the product name, operating system, product release
number, and release level on the message line, in this format:

ASG15541 INSIGHT-0OS (XA) Rn.n AT Lnnn, CENTER Rn.n AT Lnnn
where:
Rn. nis the release number.

Lnnn is the release level.
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PROGRAM Command

PROgram

Function

Operands

Usage Notes

Example

L

png Save;‘
Nosavi

The PROGRAM command is used to end the current Source View session and enter a
new Source View session for the specified program. This is useful when you are viewing
a system of multiple programs.

Operand Description

Blank Displays the AKR Program Selection pop-up for selection of a program.

pgm Specifies a COBOL program or an entry point name. If the specified
program or entry point name is unavailable in the current AKR, an error
message displays.

Save Saves equates and marks for this program in the Application Knowledge
Repository. This operand overrides the values on the Options - Product
Parameters pop-up.

Nosave Specifies that equates and marks for this program are not saved. This
operand overrides the values on the Options - Product Parameters pop-up.

You can also enter a new Source View session for a new program from the File - Open
Program Request pop-up. To display the File - Open Program Request pop-up, select File
» Open and press Enter.

Using the PROGRAM command is the easiest way of switching to another program.

However, Insight does not save the calling sequence. This means the GOBACK
command cannot be issued to return to a previous program.

When current Source View program is VIAIDEMO and this command is entered:

PROGRAM VIAIDEM1 NOSAVE

The VIAIDEMI1 program displays without saving marks and equates for VIAIDEMO.
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QUALIFY Command

Qualify

Function

Operands

282

X

pgm
L CANCe'ﬁ
ALL

The QUALIFY command displays the specified program on the Source View screen for
investigation. The qualified program becomes the current program, and program
understanding commands operate on the qualified program. Additional programs can be
qualified as needed.

Operand Description

pgm Specifies the program to be displayed on the Source View screen.
CANcel Closes the current program.
ALL Closes all open programs.

AKRname pgm Specifies an AKR name. If you do not specify another AKR name,
Insight uses the profile AKR in batch.
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RECALL Command

RECall
COMmand | CMDj kNEXT—
MESsage | MSG PREV—

Function

Operands

Usage Notes

X

POPup

The RECALL command is used to display the previous primary command, message, or
pop-up. The last 20 commands executed and the last 20 messages displayed are stacked.
Use the RECALL command to redisplay these commands or messages.

Operand Description

Blank Displays the last primary command that was stacked. After you
enter the RECALL command operands, subsequently typing
RECALL with no operands reuses the same operands that were last
entered.

COMmand | CMD  Displays a stacked primary command. This is the default value.

MESsage | MSG Displays a stacked message.

NEXT Displays the next command or message in the stack.

PREV Displays the previous command or message in the stack. This is
the default value.

POPup Displays the pop-up that was most recently requested from a
pull-down.

You can enter the RECALL command repeatedly to display any of the 20 stacked
commands, messages, or pop-ups. The NEXT and PREV operands can be used to move
forward or backward through the stacked commands or messages. After the desired
command displays, you can execute it again by pressing Enter. Any command that is
recalled can be changed before you execute it. To re-execute the last saved primary
command again without modification, use the REPEAT command.
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The operands you specify for the RECALL command remain in effect until one of these
conditions occur:

A different operand is specified.

A different primary command is executed. When this occurs, the RECALL
command default operands are automatically set. A message displays that indicates
all stacked commands or messages have been shown and the stack is being
redisplayed.

These commands are not stacked for use by the RECALL command:

ANALYZE LOCATE RECALL RSCROLL
CALL PARMDEF REDO RTRACE
END PRINTLOG REPEAT RTREEVW
GOBACK PRINTLST RETURN SAVE
HELP PRODLVL RFIND UPDATE
KEYS PROGRAM RHIGH VIEW

This example assumes these seven commands were entered for the current program and
that seven messages were displayed:

1

2

7

X ALL

ZOOMIN

PREF

ZOOMOUT

FX

SCROLL

FX

To display the previous message (number 7), type RECALL MSG. The MSG operand
remains in effect until the COMMAND or CMD operand is specified.
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Therefore, typing RECALL without changing the operands displays the previous message
(number 6). For example, typing RECALL with no operands displays the previous
command (number 7). The CMD operand remains in effect until a MSG operand is
specified.

RECALL CMD

Therefore, typing RECALL without changing the operands displays the previous
command (number 6).

This command displays the next command (number 7).

RECALL MD NEXT
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REDO Command

Y
A

REDo
i:trace-dec-op
BACKu

Function

The REDO command executes the corresponding repeat command from the cursor
position, as shown below.

Last Command Command Executed

FIND RFIND
FINDXTND RFIND
HIGH RHIGH
PREF RPREF
SCROLL RSCROLL
TRACE RTRACE

Only the commands listed in the table above are re-executed when you type REDO.
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Operand Description

Blank Re-executes the last command entered. These operands are valid
only if the last command was TRACE. Otherwise, they are
ignored.

trace-dec-opt Specifies a TRACE command decision option.

BACKup Returns to the decision point where the last decision option was
entered.

REDO automatically executes the corresponding repeat command, depending on the last
command entered. For example, if the last command entered was FIND, RFIND is
executed.
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REFRESH Command

X

REFresh

Function

Updates the call summaries for programs called by the active program.

Operands

None.

Usage Notes

Call summaries can also be updated by selecting Refresh on the Options pull-down. See
the online help for more information.

REFRESH is used to update information in the active program regarding any CALLed
program whose source was analyzed since opening the program.
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RENAME Command

k- k-name »<
REName mar nameAT:;aingfnmr nam LfNOTE
comment:
Function
The RENAME command changes the name of a mark path or set of lines.
Operands

Operand Description

mark-name Specifies a name assigned to a path or set of lines using the MARK
command or the Options - Scratchpad Mark pop-up. The specified name
must meet these requirements:

. Must be a maximum of 10 alphanumeric or 4 DBCS characters
and can include hyphens.

. Names longer than 10 characters truncate.

. Name must begin with an alphabetic character.

TO Specifies an optional keyword indicating the name following is the new
mark name.

NOTE Includes an optional description about the mark name. Comment text

comment can be a maximum of 50 alphanumeric or 23 DBCS characters. If the

NOTE comment operand is not entered, the existing comment is copied
to the new mark name. If NOTE is entered without comment text, the
existing comment is not copied to the new mark name.

Usage Notes

Marks can also be renamed on the Options - Scratchpad Rename pop-up. See the online
help for more information.

An error message displays if the mark name to be renamed does not exist or the resulting
mark name already exists.

Example

When this command is entered, the mark name SETA is changed to SETB. SETA is no
longer valid as a mark name.

RENAME SETA TO SETB
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REPEAT Command

REPEat

Function

Operands

Usage Notes

Example

290

X

Executes the last stacked primary command again.

None.

Type REPEAT in the command input area to re-execute the last stacked primary
command. The command is executed from the cursor position.

To modify the command before it is re-executed, use the RECALL command.

To display the next occurrence of a highlighted line, type this command:
SCROLL HI NEXT

Instead of re-entering the same command, type this command:
REPEAT

This command executes the SCROLL HI NEXT command again from the cursor
position.
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RESet
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Function

Operands

Usage Notes

—All
—Hi
—Tag
—Excluded | X

—Lines———— ]

—line range———

—m—marknam&
MARK

The RESET command removes highlighting and tags, cancels pending line commands,
terminates message lines, and/or redisplays all excluded lines.

Operand Description

Blank Defaults to the value ALL.

All Resets all conditions indicated by each of the operands. This is the default.

Hi Removes the highlighting from any line that was highlighted as a result of
another Insight command.

Tag Erases tags in columns 73 through 80 set as a result of another Insight
command.

Excluded | X  Displays any excluded lines.

Lines Clears any pending line commands.

Message Erases short or long messages that display.

Line Resets the HI, TAG, EXCLUDED, LINES, and MESSAGE conditions
range only for the specified line or range of lines.

MARK Resets the HI, TAG, EXCLUDED, LINES, and MESSAGE conditions

markname  only for statements belonging to the mark set. The keyword MARK is not

needed if there is no ambiguity.

You can also reset Features from the View - Reset pop-up. To display the View - Reset
pop-up, select View » Reset and press Enter. Any combination of operands can be

specified for the RESET command.
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RETURN Command

RETurn

Function

Operands

Usage Notes

292

X

SaVe:‘
Nosav!

The RETURN command is used to terminate the current function and return to the first
Insight screen displayed.

Operand Description

Blank Specifies that the values specified on the Options - Product Parameters
pop-up are used to determine if marks and equates are to be saved.

Save Saves marks and equates created for this program in the AKR. This
operand overrides the values set on the Options - Product Parameters

pop-up.

Nosave Specifies that marks and equates are not saved for this program. This
operand overrides the values set on the Options - Product Parameters

pop-up.

Using the RETURN command is a quick way of ending an Insight function.
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RFIND Command

RFind »<
Function
The RFIND command is used to repeat the last FIND or FINDXTND command from the
cursor position.
Operands

None.

Usage Notes

The RFIND command is a convenient way to locate the next occurrence of the specified
target of a FIND or FINDXTND command. The search is performed in the direction
indicated in the FIND or FINDXTND command. RFIND is assigned to the PF05/17 key
as a default.

The REDO command can also be used to execute the RFIND command. See "REDO
Command" on page 286 for more information.
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RHIGH Command

RHIigh »<
Function
The RHIGH command is used to repeat the last HIGH command from the cursor
position.
Operands
None.

Usage Notes

Type RHIGH in the command input area to repeat the last HIGH command from the
cursor position.

The REDO command can also be used to execute the RHIGH command. See "REDO
Command" on page 286 for more information.
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RPREF Command

RPref

X

Function
When on the Source View screen, use the RPREF command to redisplay the last
View - Paragraph Cross Reference pop-up. When on the View - Paragraph Cross
Reference pop-up, use the RPREF to redisplay the last Source View screen.
Operands

None.

Usage Notes

The View - Paragraph Cross Reference pop-up redisplays with the exact information as
previously shown. RPREF can be used to go back and forth between the source and the
View -Paragraph Cross Reference pop-up.

When an RPREF (and no PREF) command is entered, RPREF functions as a PREF
command with the cursor position as the target and default direction.

The REDO command can also be used to execute the RPREF command. See "REDO
Command" on page 286 for more information.
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RSCROLL Command

RSCroll »<«
Function
The RSCROLL command is used to repeat the last SCROLL command from the cursor
position.
Operands
None.

Usage Notes

Type RSCROLL in the command input area to repeat the last SCROLL command from
the cursor position.

The REDO command can also be used to execute the RSCROLL command. See "REDO
Command" on page 286 for more information.
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RSTRUCTURE-VIEW Command

X

RSTRUCTure-view | RSTView

Function

The RSTRUCTURE-VIEW command is used to return to the previous Perform Structure
View screen.

Operands

None.
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RTRACE Command

RTrace
i:trace—dec—op(:‘
BACKup

Function
The RTRACE command is used to continue the last TRACE command from where it
stopped.
Operands
Blank Displays the Trace Decision Options pop-up. When RTRACE

is entered without an operand and not at a decision point, the
trace function is resumed from the stopping point.

trace-dec-opt

Specifies a TRACE command decision option.

BACKup

Returns to the decision point where the last decision option was
entered. The TRACK is reset to include only those lines that
were in it when that decision point was reached. Only one
BACKUP is allowed following an RTRACE command. A
message displays if there is no previous decision point or if
BACKUP has already been done.

Usage Notes

The RTRACE command can be used to continue a trace function without exiting the
Source View screen. Type the desired option number in the command input area and
press Enter. This process can be continued until the end of the trace function is reached. If
a different path is to be followed, type BACKUP in the command input area, press Enter,
and select the desired option.

If a trace function is interrupted and another primary command is entered, the messages
displayed by the trace function are cleared. To continue the trace function, type RTRACE.
The screen is then scrolled to the last trace location and the messages redisplay.

If a decision point prompt is unclear, the Trace Decision Options pop-up that explains the
decision point can be displayed. Type RTRACE without an operand to display the Trace
Decision Options pop-up. The Trace Decision Options pop-up shows this information:
the possible options from the decision point; the type of branch; the line number; and the
first statement of the destination. An asterisk (*) next to an option indicates that option

was traced.
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The REDO command can also be used to execute the RTRACE command. See "REDO
Command" on page 286 for more information.

Trace Decision Options Pop-up

The Trace Decision Options Pop-up (Figure 102 on page 299) displays when you type
RTRACE without an operand. This pop-up is used to list all possible options from the
decision point, the type of branch, the line number, and the first statement of the
destination. An asterisk displayed next to an option shows that you have already
TRACEd that option.

Figure 102 « Trace Decision Options Pop-up

Trace Decizion Options
Connand === Ecroll ===k IR

—-

Trace of i TESTCALL

Direction: FORMARD

Faragraph: 00015 PROCEDURE DIMVIZION.
Decisions 000015 IF WE-CHKP-COUNTER = 18

Option Info indicates TARGET's and '#' for Code already TRACE'd

Zelect one of the following decizion options: Option
% Option Info

1. TRUE [@@@81% FHOVE & TO ME-CHKP-INTERUAL AWE-CHEP-COUNTER ]
2. FALSE (000020 ELSE]

EQTTOH OF DATA

Fields

Trace of Specifies the name of the target you are tracing. For a
dataname, it also indicates the usage (USE, MOD, REF). If an
IN clause was specified, it is also displayed.

Direction Specifies the direction requested for the trace (NEXT,
PREVIOUS, FORWARD, or BACKWARD).

Paragraph Specifies the line number and name of the paragraph that
contains the decision point.

Decision Specifies the line number and statement of the decision point.

S (line command area) Specifies the line command area, to the left of the Option field,
accepts the S line command to select the option.
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Field Description

Option Specifies the all feasible options from the decision point. Each
option lists the type of branch, line number, and first statement
of the destination.

Option Info Indicates whether the option is the requested target or has
already been traced.
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RTREEVW Command

X

RTREEvw | RTV

Function

The RTREEVW command returns to the previous Tree View screen.

Operands

None.

Usage Notes

The Tree View screen is redisplayed with the exact information as previously shown. See
the online help for more information about the Tree View screen.
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SAVE Command

SAve

Function

Operands

Usage Notes

302

X

Marks
Equates—
All

The SAVE command is used to save marks and/or equates in the AKR. This command
overrides the values set on the Options - Product Parameters pop-up.

Operand Description

Blank Defaults to the value ALL.

Marks Saves all marks created or changed for the active program. This operand
overrides the values set on the Options - Product Parameters pop-up.

Equates Saves all equates entered for the active program. This operand overrides
the values set on the Options - Product Parameters pop-up.

All Saves marks and equates entered for the active program. This operand
overrides the values set on the Options - Product Parameters pop-up. This
is the default.

Marks and equates can also be saved on the File - Save pop-up, and on the File - Close
pop-up. See the online help for more information.

Save values established on the Options - Product Parameters pop-up can be overridden
using the SAVE command.
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v

SCroll A name
LLABEL
-MARK
- PERFRANGE-|
- PROGRAM—|
L SUBSET—|
range—
-LINE
name—
LPARAGRAPH-!
+
r J name
DATA sQL—| Ref DIRect— ALIasﬂ
IDMS— Use NOAlias
— Mod INDirect
* Def SIZeJ LLEVeIs nJ
VALue
ALIasﬂ
NOAlias
string
7PATTERNJ X'string'— —WORD Lcolumn 1J Lcolumn 2J
T 'string'— —PREFIX
P 'sting—| —SUFFIX
number- » 2
—BoxJ
1) »<«
——Next— L +
—Prev— IN-Y name—|
- Flrst—] L MARK
- LAst—| - PERFRANGE |
L Al— - PROGRAM—|
- SUBSET——
e ] e
LINE
ﬁ—namef
L PARAGRAPH
2»
Function
The SCROLL command is used to position the screen to the first line containing the
specified target. Highlighted lines remain unchanged.
Operands

LABEL name

Operand Description

Specifies the paragraph or section name of the PROCEDURE

DIVISION or the literals PROCEDURE or PROC where the FLOW
command is to begin.
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Operand Description

MARK name  Specifies a 1 to 10 alphanumeric character name given to a set or path
using the COPY, MARK, MERGE, or RENAME commands, or one
of these system-generated paths:

System generated path:  Created by:

TRACK | TRK A TRACE command.
NETWORK | NET A FLOW command.
SUBNETn | SUBn A path created by the FLOW command

that reaches from the beginning of the
NETWORK to one of the results (nth
result).

Note:

The TRACK, NETWORK, and SUBNET paths can also be created
using the Logic Order Search pop-ups (see "Logic Pull-down" on

page 101).

PERFRANGE  Specifies the name in a PERFORM statement including all statements

name executed as a result of a PERFORM statement, or the name of any
section contained in the Declaratives. This operand is valid in Source
View only

PROGRAM Specifies the name of the main program or any nested program

name representing all the code contained in the program. This includes all

the programs physically nested inside the specified program.

SUBSET name Specifies a predefined subset. These are the valid subsets:

ASsignment  DEBug 10

CAll DEFinition LABel
Clcs DIRective MAINIine
COBOLII DIVision MATH
COBOL/370 DL/1|DL/1 Output
COMment DML PARagraph
CONditional  ENtry PERform
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COPy EXIt| PGM  ExitRETurn
DB2/SQL FALLthrough SECtion
DDL GOto SORTMerge
DEAD IDMS STructure
DEADCode  INClude TESted
DEADData Input UNTested

A screen subset:

Highlighted | HI
NONHighlighted | NHI
Excluded | X
NONExcluded | NX

Tagged lines subsets of tags in columns 73 through 80.

Note:
See the ASG-Insight User’s Guide for a description of each subset

LINE range Specifies a single line number or range of lines. Line numbers display
in columns 1 through 6 of Source View.

PARAGRAPH  Specifies a PROCEDURE DIVISION paragraph name or section

name name, or the literals PROCEDURE and PROC. The entire paragraph

or section is included.

asterisk (¥)

Reuses the target of the previous SCROLL.

DATA name

Specifies a COBOL dataname or qualified COBOL dataname.
Dataname refers to any valid COBOL reference for a data element.

These subordinate operands apply to the dataname and can be used to
further qualify the EXCLUDE command: REF, USE, MOD, DEF,
ALIAS,NOALIAS, DIRECT, and INDIRECT. The defaults are REF,
ALIAS, and DIRECT.

SQL name

Includes datanames that are DB2/SQL variables only.

IDMS name

Includes datanames that are IDMS variables only.

. name

Includes datanames that are COBOL variables only.
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Ref

Includes occurrences of the dataname where its value is defined,
tested, used, set, or modified. This is the default value for the DATA
name operand.

Use

Excludes occurrences of the dataname where its value is being tested
or used.

Mod

Excludes occurrences of the dataname where its value is being set or
modified.

Def

Includes definitions of the dataname in the DATA DIVISION

AlLlas

Searches backward from the cursor position to the previous
occurrence of the requested target.

Includes occurrences of the aliases for the dataname. These are the
valid aliases:

. Parent - higher level group item
. Child - lower level item
. Rename/Redefinition - renamed, redefined, or 88 level items

This is the default value for the DATA name operand.

NOAlias

Ignores aliases for the specified dataname.

DIRect

Includes occurrences of the dataname (and aliases if specified) where
it is directly tested, used, set, modified, or defined (based on the REF,
USE, MOD, or DEF selection). The default for the DATA name
operand is direct; however, if the SIZE, VALUE, or LEVELS operand
is specified, INDIRECT is assumed.

INDirect

Includes any dataname indirectly affected by the specified dataname
(and aliases if specified). The indirect data item can be further
qualified using the SIZE, VALUE, and LEVELS subordinate
operands. These subordinate operands indicate the type of indirect
reference to be located. SIZE and all levels are the defaults for the
INDIRECT operand.

SIZe

Includes datanames that could be directly or indirectly affected if the
size of the specified dataname were to be changed. SIZE is only valid
with the INDIRECT operand. This is the default for the INDIRECT
operand.
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VALue

Includes occurrences of datanames that could be directly or indirectly
affected by a change if the value of the specified dataname were to be
changed. The LEVELS subordinate operand is not used with
VALUE. VALUE is only valid with the INDIRECT operand.

LEVels n

Includes all data items affected within the specified number of
indirect levels. The VALUE subordinate operand is not used with
LEVELS. All levels is the default for the LEVELS operand. LEVELS
is only valid with the INDIRECT operand.

PATTERN

Indicates the characters that follow are part of a string.

string

X'string

T'string

P'string

Specifies a string of alphanumeric or DBCS characters. If the pattern
string contains blanks, it must be enclosed in single or double quotes.
The pattern string can be further qualified using the WORD, PREFIX,
or SUFFIX subordinate operands. These subordinate operands
describe how the pattern string is to be used:

Specifies the hexadecimal string option. Specific unprintable
characters may be specified by giving the EBCDIC hexadecimal
value. The string must be enclosed in single or double quotes.

Specifies the text string option. A character string may be entered
regardless of upper or lowercase by using the text option. The string
must be enclosed in single or double quotes.

Specifies the picture string option. A string profile may be entered
instead of exact characters. The string must be enclosed in single or
double quotes. Insight defines nine special characters for use in
picture strings. These special characters can be combined with other
characters.

These are the special characters:

p'=' Any character

P! Any nonblank character
P Any nondisplay character
P'# Any numeric character
p-' Any character

P'‘@'  Any character

p< Any character

P> Any character

P'§' Any character
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WORD Specifies the pattern string preceded and followed by any
non-alphanumeric character (except a hyphen).

PREFIX Specifies a word that begins with the specified pattern string.

SUFFIX Specifies a word that ends with the specified pattern string.

Columnl Specifies the column number where the search is to begin.

Column2 Specifies the column number where the search is to end.

Next Searches forward from the current cursor position to the next

occurrence of the requested target.

Prev Searches backward from the current cursor position to the previous
occurrence of the requested target.

Flrst Searches from the top of the source file to the first occurrence of the
requested target.

LAst Searches backward from the bottom of the source file to the first
occurrence of the requested target.

All Searches for all occurrences of the requested target and displays the
number found in the short/long message field. This is the default value
for the HIGH command.

IN Restricts the HIGH command to the specified target type.

Box Number Identifies a scroll to a specific box number, rather than a line. This

operand is only available in Perform Structure View.

Usage Notes
The screen can also be scrolled by selecting a Search pop-up on the Search pull-down.
See the online help for more information.
To concatenate targets, place a plus sign (+) between the target names. For example, 10 +

CALLS. These rules apply to concatenation:

. A concatenated dataname can be used wherever a dataname is valid. Dataname
subordinate operands (REF, ALIAS, etc.) pertain to all datanames in a concatenated
series.
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. A concatenated set name can be used wherever a set name is valid. These sets can
be concatenated:

. LABEL . LINE

. MARK . PROGRAM

. PERFRANGE . PARAGRAPH
. SUBSET

The asterisk (¥*) operand can be concatenated once with any number of other operands
(e.g., ¥ + 10 + MYSET); however, the asterisk (*) operand cannot be concatenated to
itself (* + * is invalid). The * operand may appear in any order in the concatenated list.

For COBOL II Release 3 or later programs, a data item, label, or program name that may
be ambiguous or used multiple times can be qualified by using OF followed by the
program name. For example, if the label P120-READ exists in another program and also
in the program VIAIDEMI, then it can be qualified as P120-READ OF VIAIDEMI.

Example

This command displays the first occurrence of a line containing the characters ZIP.

SCROLL ZIP
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SELECT Command

Select trace-dec-opt
pam ]

Function

Operands

310

X

The SELECT command is used to select the desired option from a list. SELECT is used
on the Trace Decision Options pop-up and the AKR Program Selection pop-up. SELECT
followed by the desired option can be entered in the command input area. An S can be
entered to the left of the displayed items to select a particular item on any screen with a
selection field.

Operand Description

trace-dec-opt Specifies a TRACE command decision option.

pgm Specifies the complete program name from the AKR Program
Selection pop-up.

Note:

il

See "RTRACE Command" on page 298 for more information about the Trace Decision
Options pop-up.
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SET Command

X

SET
LEarn——— ON
SCriptﬁLi OFF
RESULTH

XMode

Function
The SET command is used to enable or disable the mode indicated by the specified
operand.
Operands
Blank Displays the Options - Processing Modes pop-up that shows the current
setting for each SET command mode.
LEarn Displays all primary commands generated internally when actions from the
pull-downs execute. The default for this operand is OFF.
SCript Allocates a script file when the SET SCRIPT ON command is issued. From

that point on, all Insight primary commands are captured in this file. When
the SCRIPT OFF command is issued, the script file is closed and saved.
The script file name is userid.INSnnnnn.VIASCRIP. If the TSO profile
prefix is not the same as the user ID, then this name is preceded by a prefix
value.

RESULT  Saves the results of primary commands as comments in the script file when
used with the SCRIPT operand.

XMode Excludes all lines from the screen before a primary command is executed
when this mode is ON. This mode affects all primary commands with the
exception of these:

. BRANCH
. LOCATE
. SCROLL

. HIGH

. RFIND

The default value for this operand is OFF.
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Usage Notes

Any modes that you either enabled or disabled with the SET command can also be
enabled or disabled on the Options - Processing Modes pop-up.

To display the Options - Processing Modes pop-up, follow this step:

» Select Options » Modes and press Enter.

Or
Type SET (with no operands) on any screen and press Enter.

See the online help for more information about the Options - Processing Modes pop-up.

LEARN Mode - Generated Command Pop-up

The LEARN Mode - Generated Command pop-up displays the internally-generated
primary command when actions are requested on pop-ups, if the LEARN mode is set to
ON with the SET command or on the Options - Processing Modes pop-up (shown in

Figure 103).

Figure 103 « LEARN Mode - Generated Command Pop-up

LEARN Mode - Generated Command

To process the generated command, press Enter. To cancel
the command, press PF3/15 (END).

Command TREEVIEW 2

Follow the instructions on the pop-up to process or cancel the command.

SOURCEVIEW Command

X

SOURCEVIEW | SView

Function

The SOURCEVIEW command is used to display the Source View screen. This screen
shows the program in source code order.

Operands

None.
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STRUCTURE-VIEW Command

STRUCTure-view | STView »<
name— h—tnumber YES
—PERFRANGE} LEVELs MAX REPetition NO
+—PROGRAM

Function

Operands

I A E—
name—

The STRUCTURE-VIEW command transfers the display of the program being viewed to
the Perform Structure View screen.

Operand Description

Blank Specifies that the defaults are used.
PERFRANGE Specifies the starting paragraph for the Perform Structure View
name screen. A name is any PROCEDURE DIVISION paragraph name

or section name.

PROGRAM name  Specifies the main program or any of the nested programs
representing all the code that is executed by entering the specified
program.

For COBOL II Release 3 or later programs, a program name that
may be ambiguous or used multiple times can be qualified by
using OF followed by the program name. For example, if the label
P120-READ exists in another program and also in the program
VIARDEMI, then it can be qualified as P120-READ OF
VIARDEMI.

ENTRY name Displays the main program structure and the structure for all
ENTRY points. If a name is specified, the structure for that entry
point displays.
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Operand Description

LEVELs Controls the amount of information displayed on entering
Perform Structure View. Specify the number of nested control
flow structures to be displayed. The default, 2, displays the first
two levels of nested performs. MAX displays the maximum
nesting level. However, if the maximum nesting level consists of
only repeated perform ranges, then the nested level is truncated to
the next higher level that does not consist exclusively of repeated
perform ranges.

REPetition Controls the display of duplicated perform range structures. If
REPETITION is YES, all duplicate perform ranges display. If
REPETITION is NO, duplicate perform range structures are only
flagged as REPEATED. The default is NO.

Usage Notes
The Perform Structure View screen can also be displayed by selecting View P Structure
and pressing Enter.

Type STRUCTURE-VIEW in the command input area to transfer the display to the
Perform Structure View screen. Use the END command to return to screen where the
STRUCTURE-VIEW command was entered.
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TRACE Command

TRace

ﬂ Next
—hame Prev
MARK Forward—
PERFRANGE Backward-
PROGRAM—
—+
4
name —|
7FROM7—4rnumber LTOJ 7SUBSETJ
—LINE j—range—
ﬁ—name —LINE
—LABEL —4|—name—
LABEL
+
\ 2 \
name
LDATA4 Ref—
Use—
Mod -

Function

Operands

Y
A

The TRACE command is used to follow the execution of a program, searching for the
specified target. The MARK and PERFRANGE operands trace the path represented by
the MARK name, PERFRANGE name, or PROGRAM name. Tracing to a SUBSET
name, LINE range, LABEL name, or DATA name traces from the starting point to the
lines represented by these targets.

Operand Description

Blank Specifies that the default direction of NEXT is used. The trace begins
at the cursor position and continues to the program exit.

FROM Indicates where the TRACE command is to begin. The MARK name,
PERFRANGE name, and PROGRAM name operands cannot be used
with this operand.

LINE number Specifies the line number where the TRACE command is to begin
when the target is a SUBSET name, LINE range, LABEL name, or
DATA name.

LABEL name  Specifies the paragraph, section, or division name where the TRACE
command is to begin when the target is a SUBSET name, LINE range,
LABEL name, or DATA name.
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TO

Specifies an optional keyword that is followed by a target to indicate
where the TRACE command is to end.

MARK name

Specifies a 1 to 10 alphanumeric character name given to a set or path
using the COPY, MARK, MERGE, or RENAME commands, or one
of these system-generated paths:

System generated path:  Created by:
TRACK | TRK A TRACE command.
NETWORK | NET A FLOW command.

SUBNETn | SUBn A path created by the FLOW command
that reaches from the beginning of the
NETWORK to one of the results (nth
result).

Note:

The TRACK, NETWORK, and SUBNET paths can also be created
using the Logic Order Search pop-ups (see "Logic Pull-down" on

page 101).

PERFRANGE
name

Specifies the name in a PERFORM statement including all statements
executed as a result of a PERFORM statement, or the name of any
section contained in the Declaratives. This operand is valid in Source
View only

PROGRAM

name

Specifies the name of the main program or any nested program
representing all the code contained in the program. This includes all
the programs physically nested inside the specified program.

SUBSET name

Specifies a predefined subset. These are the valid subsets:

ASsignment  DEBug ()

CAll DEFinition LABel
Clcs DIRective MAINIine
COBOLII DIVision MATH
COBOL/370 DL/ |DL/1 Output
COMment DML PARagraph
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CONditional  ENtry PERform
COPy EXIt|PGM  ExitRETurn
DB2/SQL FALLthrough SECtion
DDL GOto SORTMerge
DEAD IDMS STructure
DEADCode  INClude TESted
DEADData Input UNTested

A screen subset:

Highlighted | HI
NONHighlighted | NHI
Excluded | X
NONExcluded | NX

Tagged lines subsets of tags in columns 73 through 80.

Note:
See the ASG-Insight User’s Guide for a description of each subset

LINE range

Specifies a single line number or range of lines. Line numbers display
in columns 1 through 6 of Source View.

LABEL name

Specifies any PROCEDURE DIVISION paragraph name or section
name, or the literals PROCEDURE and PROC. All transfers of
control to the label name are included.

DATA name

Specifies a COBOL dataname or qualified COBOL dataname.
Dataname refers to any valid COBOL reference for a data element.

These subordinate operands apply to the dataname and can be used to
further qualify the EXCLUDE command: REF, USE, MOD, DEF,
ALIAS,NOALIAS, DIRECT, and INDIRECT. The defaults are REF,
ALIAS, and DIRECT.

Ref

Includes occurrences of the dataname where its value is defined,
tested, used, set, or modified. This is the default value for the DATA
name operand.

Use

Excludes occurrences of the dataname where its value is being tested
or used.

Mod

Excludes occurrences of the dataname where its value is being set or
modified.
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Usage Notes
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Operand Description

Next Searches forward from the current cursor position to the next
occurrence of the requested target.

Prev Searches backward from the current cursor position to the previous
occurrence of the requested target.

Forward Traces forward from the current cursor position to all occurrences
Backward Traces backward from the current cursor position to all occurrences.
IN Restricts the HIGH command to the specified target type.

Execution paths in a program can also be identified using the Logic Order Search
pop-ups, that can create a path with a mark name of TRACK. See Chapter 5, "Logic." on
page 99 for more information.

To concatenate targets, place a plus sign (+) between the target names. For example,
IO+CALL. These rules apply to concatenation:

. A concatenated dataname can be used wherever a dataname is valid. Dataname
subordinate operands (REF, USE, MOD) pertain to all datanames in a concatenated
series.

. A concatenated set name can be used wherever a set name is valid. These sets can
be concatenated.

. LABEL . LINE
. MARK . PROGRAM
. PERFRANGE . SUBSET

For COBOL II Release 3 or later programs, a data item, label, or program name that may
be ambiguous or used multiple times can be qualified by using OF followed by the
program name. For example, if the label P120-READ exists in another program and also
in the program VIAIDEMI, then it can be qualified as P120-READ OF VIAIDEMI.

When TRACE is entered with only a direction operand, this occurs:

Direction Traces to the...

Next program exit statements.

Previous PROCEDURE DIVISION statement or the program ENTRY points.
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Forward program exit statements.

Backward PROCEDURE DIVISION statement or the program ENTRY points.

The trace function can be performed on an existing path (e.g., NETWORK, SUBn), or
from a specific starting point to a target. The execution path followed during the trace
function is automatically saved into a MARK path called TRACK. This path has a single
entry and exit beginning with the line where a trace function starts and ending where the
trace function is discontinued. TRACK is valid until a new trace function is initiated.

Unconditional PERFORMSs can be included in TRACK without following a path into the
PERFORMed unit by using the BYPASS PERFORMED CODE decision option. This
method shortens the trace function without a detailed trace of the PERFORMed unit.

Using the trace function is a convenient way to view paths in logical execution order. All
executable statements on the path from the starting point to where the trace function stops
are highlighted. A long message indicates the reason for stopping. For a decision point,
the line number where the trace function stopped and the line number to continue with
show.

Columns 73 through 80 contains these information tags on a traced line:

DECISION for a decision point

STOP PNT for an intermediate stopping point
START for the beginning of the trace function
OPTION n for an option choice

TARGET for a destination of the trace function

Multiple information tags appearing on a line are separated with a slash (/).

The trace function stops and redisplays the Source View screen when these occur:
. A target is reached.

. A decision point is reached. All valid options are presented in columns 73 through
80 and line three of the Source View screen.

. Before entering or exiting a PERFORMed unit (DECISION).

. At a GOTO statement that transfers to code not displayed on the screen (STOP
PNT).

. Ata GOTO or EXIT from PERFORMSs in the forward direction, or a LABEL in the
backward direction (STOP PNT).
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. The bottom of the screen is reached in the NEXT or FORWARD direction, or the
top of the screen is reached in the PREVIOUS or BACKWARD direction (STOP
PNT).

. An apparent decision point is reached but only one choice exists. This is shown as a
stopping point rather than a decision point.

To continue the trace function, type the desired option in the command input area and
press Enter.

Note:
See Chapter 5, "Logic," on page 99 or the online help for more information about
TRACKSs and the Logic Order Search pop-ups.

Example 1. This command traces forward to the first EXIT in the program:
TRACE EXITS

To highlight the resulting MARK path, type this command:
FX TRACK

Example 2. This command traces forward through SUBNET, that is a part of the
NETWORK created by the FLOW command:

TRACE SUBNET1
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TREEView | TV name— LABELS ‘ number;‘ 'ﬁ—EYES >
—PERFRANGE} ESTRUCture Lievers Duax REPetition NO
—PROGRAM CONDitional—
—ENty PERF
name—

Function
The TREEVIEW command displays the Tree View screen, that shows a structural
program representation in logical execution order. This command can also be executed
on the Tree View screen to end the current Tree View and start a new Tree View with the
specified targets.

Operands

Blank Specifies that the defaults are used.

PERFRANGE name

Specifies the starting paragraph for the Tree View display. A
name is any PROCEDURE DIVISION paragraph name or
section name. The PROCEDURE literal can also be specified.

PROGRAM name

Specifies the main program or any of the nested programs
representing all the code that is executed by entering the
specified program.

For COBOL II Release 3 or later programs, a data item, label, or
program name that may be ambiguous or used multiple times
can be qualified by using OF followed by the program name. For
example, if the label P120-READ exists in another program and
also in the program VIAIDEMI, then it can be qualified as
P120-READ OF VIAIDEMI.

ENTRY name

Displays the main program structure and the structure for all
ENTRY points. If a name is specified, the structure for that
ENTRY point displays.

LABELS

Generates a Tree View display of the structure of the program
using the paragraphs and section labels of the control flow
statements. LABELS is the default.

STRUCture

Generates a Tree View display of the structure of the program
using control flow verbs (PERFORM, GO TO, ALTER, etc.)
and program labels.
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Operand Description

CONDitional Generates a Tree View display of the conditional statements that
surround control flow statements, plus the control flow
statements and labels.

PERF Generates a Tree View display of the perform range hierarchy
for the program.

LEVELSs number Controls the amount of information displayed on entering Tree
View. Specify the number of nested control flow structures to be
displayed. The default, 2, displays the two levels of nested
performs.

MAX Displays the maximum nesting level. However, if the maximum
nesting level consists of only repeated PERFORM ranges, then
the nested level is truncated to the next higher level that does not
consist exclusively of repeated PERFORM ranges.

REPetition Controls the display of duplicate perform ranges. If YES is
specified, all duplicate perform ranges display. If NO is
specified, duplicate perform ranges are only flagged as
REPEATED and are not expanded unless you type ZOOMIN for
the perform ranges. The default is NO.

Usage Notes

The Tree View screen can also be displayed by selecting View P Tree and pressing Enter.
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VIEW Command

X

View pgm

Function

The VIEW command is used to start a new Source View session for the specified
program while retaining the current session.

Operand Description

Blank Displays the AKR Program Selection pop-up for selection of a program.

Operands

pgm Specifies a program a Source View session is to be started for.

Usage Notes

When finished with the requested program, the END or GOBACK command returns to
the original session.
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ZOOMIN/ZOOMOUT Commands

ZOOMin | ZI »<
ZOOMOut | ZO »<
Function

Operands

Usage Notes

324

The ZOOMIN and ZOOMOUT commands are used to display or exclude source lines
according to the hierarchical levels of the program.

None. These commands are entered in the command input area with no operands and are
dependent on the cursor location.

ZOOMIN and ZOOMOUT are also available on the View pull-down. See the online help
for more information.

The ZOOMIN and ZOOMOUT commands show the structure of a program and provide a
means of stepping through each level or going directly into or out of a particular section
of source code. The ZI and ZO line commands can also be used to perform the ZOOMIN
and ZOOMOUT functions.

Program level hierarchy consists of the IDENTIFICATION DIVISION statement, the
PROGRAM-ID statement, and the END PROGRAM statement, if any. This is especially
useful in revealing the hierarchy of nested programs that is possible with COBOLII
Release 3.

PROCEDURE DIVISION hierarchy consists of section labels, paragraph labels, and
paragraph code. DATA DIVISION hierarchy consists of sections, FDs, 01, or 77 levels,
and all definitions within an 01 level.

For example, begin by excluding all lines from the screen, then type ZOOMIN. The
program level information is shown including the program name and its last physical line.
For COBOLII Release 3 modules with sub-programs, this information shows for each of
the programs. Type ZOOMIN again. The PROGRAM-ID and END-PROG display first
then the DIVISION headings are shown. Type ZOOMIN in the command input area and
place the cursor on the PROCEDURE DIVISION statement, then press Enter. (Or, place
the cursor on the PROCEDURE DIVISION statement, then press PF07/19.) All
PROCEDURE DIVISION headings display.
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To see the source within a particular heading, scroll to it and type ZOOMIN again. The
paragraph names display. Continue following this process to see the code and copy
statements within several paragraphs. Type ZOOMOUT on a paragraph name to exclude it
from the screen after it is viewed. All source lines under the paragraph name are excluded
from the screen.

These are the general guidelines for ZOOMIN:

. If the cursor is on an excluded block of lines, ZOOMIN displays the highest
structure level within that block of lines. If there are multiple statements at that
level, they also display.

. If ZOOMIN is issued repeatedly from the same cursor position, successive heading
levels display.

These are the general guidelines for ZOOMOUT:

. The cursor cannot be positioned on an excluded line when ZOOMOUT is entered.

. ZOOMOUT excludes the levels in a lowest to highest order. [f ZOOMOUT is
issued repeatedly from the same cursor location, successive heading levels are
excluded.

Line Commands

Line commands are entered over the line numbers in the prefix area on the screen. Line
commands are either single format or block format. Single format refers to a line
command being entered on an individual line. Figure 104 illustrates the line command to
exclude line 332.

Figure 104 « Single Format Line Command Example

000331 MOVE ZIP-CODE TO HLD-ZIP.
X00332 IF HLD-ZIP-PREFIX EQUAL CUR-PREFIX
000333 NEXT SENTENCE

A number can be included with some single format commands to indicate a specified
number of lines to be processed using the same command. Processing begins with the line
where the command is entered, and includes the current line and subsequent lines as
indicated by the number specified. If the specified number of lines exceeds the available
source lines, all remaining lines are processed. The maximum you can enter is 99999.
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Figure 105 illustrates the single format Exclude line command followed by a number to
exclude lines 332 through 336.

Figure 105 » Single Format Line Command with a Number Specified

000331 MOVE ZIP-CODE TO HLD-ZIP.

X50332 IF HLD-ZIP-PREFIX EQUAL CUR-PREFIX
000333 NEXT SENTENCE

000334 ELSE

000335 PERFORM P150-SUBTOT

000336 THRU P169-EXIT

000337 MOVE HLD-ZIP-PREFIX TO CUR-PREFIX

Block format refers to double character line commands entered on multiple lines. Block
line commands process for all lines between (and including) the lines containing the
commands. Figure 106 illustrates the block format Exclude Block command being used
to exclude lines 332-336.

Figure 106 » Block Format Line Command Example

000331 MOVE ZIP-CODE TO HLD-ZIP.

XX0332 IF HLD-ZIP-PREFIX EQUAL CUR-PREFIX
000333 NEXT SENTENCE

000334 ELSE

000335 PERFORM P150-SUBTOT

XX0336 THRU P169-EXIT

000337 MOVE HLD-ZIP-PREFIX TO CUR-PREFIX

Line commands can be removed by typing over them with spaces, pressing ERASE EOF
with the cursor at the beginning of the command, or by typing RESET in the command
input area.

Line commands can be ambiguous when entered. Figure 107 illustrates a common
ambiguity.

Figure 107 « Ambiguous Line Command Example

024500 MOVE ZIP-CODE TO HLD-ZIP.
X24600 IF HLD-ZIP-PREFIX EQUAL CUR-PREFIX
024700 NEXT SENTENCE

It is unclear whether two lines, 24 lines or 246 lines are to be excluded. If two lines are to
be excluded, one or more spaces should be entered following the X2. The ERASE EOF
key could be used to erase the numbers following the X2.
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F (First) Line Command

Fn
Function
The F (First) line command redisplays the specified number of excluded lines. These
lines redisplay starting with the first line in the block of excluded lines.
Operands

n. The number of excluded lines to redisplay. The default is 1. If the number specified is
greater than the number of excluded lines, all lines in the excluded block redisplay.

Usage Notes

The F (First) line command redisplays lines excluded as the result of any primary or line
command that excludes lines from the screen display.

Example

Figure 108 and Figure 109 illustrate the first two lines in the excluded block being
redisplayed.

Figure 108  F (First) Line Command Example

000002 PROGRAM-ID. PRDEMO.
F2 - - - - - - - - - - 5 LINES NOT DISPLAYED
000008 INPUT-OUTPUT SECTION.

Figure 109 « F (First) Line Command Results

000002 PROGRAM-ID. PRDEMO.

000003 AUTHOR. WRITTEN BY ASG AT LANGLVL 2.

000004 ENVIRONMENT DIVISION.

- - - - - - - - - - - = - 3 LINES NOT DISPLAYED
000008 INPUT-OUTPUT SECTION.
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H (Highlight) Line Command

Function

Operands

Usage Notes

Example

328

The H (Highlight) line command is used to highlight a line or group of lines.

n. The number of consecutive lines to highlight. The default is 1. If the number specified
is greater than the number of available lines, all remaining lines are highlighted.

The H (Highlight) line command is used to highlight a contiguous group of lines.

Figure 110 and Figure 111 illustrate the Highlight line command being used to highlight
three source code lines.

Figure 110 « H (Highlight) Line Command Examples

H3 281 CALL 'VIAIDEM1' USING MASTER-IN

000282 MASTER-END-OF-FILE
000283 MASTER-REPORT-DATE.
000284

000285 PERFORM P100-PRINT

000286 THRU P119-EXIT.

Figure 111 « H (Highlight) Line Command Results

000281 CALL 'VIAIDEM1' USING MASTER-IN

000282 MASTER-END-OF-FILE
000283 MASTER-REPORT-DATE.
000284

000285 PERFORM P100-PRINT

000286 THRU P119-EXIT.
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HH (Highlight Block) Line Command

HH

Function
The HH (Highlight Block) line command is used to highlight a block of lines.

Operands

None.

Usage Notes

The HH (Highlight block) line command is entered in the prefix area on the first and last
line of the block to be highlighted.

Example

Figure 112 and Figure 113 illustrate the HH line command being used to highlight three
source code lines.

Figure 112 « HH (Highlight Block) Line Command Example

HHO0281 CALL 'VIAIDEM1' USING MASTER-IN

000282 MASTER-END-OF-FILE
HH0283 MASTER-REPORT-DATE.
000284

000285 PERFORM P100-PRINT

000286 THRU P119-EXIT.

Figure 113 « HH (Highlight Block) Line Command Results

000281 CALL 'VIAIDEM1' USING MASTER-IN

000282 MASTER-END-OF-FILE
000283 MASTER-REPORT-DATE.
000284

000285 PERFORM P100-PRINT

000286 THRU P119-EXIT.
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J (Jump) Line Command

J
Function
The J (Jump) line command is used to return to the Source View screen at the location
corresponding to the line where this command is issued on the Tree View screen.
Operands

None.

Usage Notes

Enter the J (Jump) line command on the line that you want to return to.

Label Line Command

.label

Function

The Label line command is used to assign a name to a particular source line.

Operands

Jabel. A period followed by 1 to 5 alphabetic characters to be used as the name for the
line where it is entered.

Usage Notes

You can use the LOCATE primary command followed by a label name to scroll to the
labelled line.

Example

Figure 114 illustrates the .label line command being used to label line 281 to EQL. Line
281 can be referenced with EQL as well as line 281.

Figure 114 « Label Line Command Example

.EQL81 CALL 'VIAIDEMI1' USING MASTER-IN

000282 MASTER-END-OF-FILE
000283 MASTER-REPORT-DATE.
000284

000285 PERFORM P100-PRINT

000286 THRU P119-EXIT.

000287
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10 Commands - Line Commands

L (Last) Line Command

Ln
Function
The L (Last) line command redisplays the specified number of excluded lines. These
lines redisplay starting with the last line in the block of excluded lines.
Operands

n. The number of excluded lines to redisplay. The default is 1. If the number specified is
greater than the number of excluded lines, all lines in the excluded block redisplay.

Usage Notes

The L (Last) line command redisplays lines excluded as the result of any primary or line
command that excludes lines from the screen display.

Example

Figure 115 and Figure 116 illustrate the L line command being used to redisplay the last
two lines in the excluded block.

Figure 115« L (Last) Line Command Example

000002 PROGRAM-ID. VIAIDEMO.
L2 - - - - - - - - - - 5 LINES NOT DISPLAYED
000008 INPUT-OUTPUT SECTION.

Figure 116 « L (Last) Line Command Results

000002 PROGRAM-ID. VIAIDEMO.

- - - - - - - - - - - - - 3 LINES NOT DISPLAYED
000006 SOURCE-COMPUTER. IBM-370.

000007 OBJECT-COMPUTER. IBM-370.

000008 INPUT-OUTPUT SECTION.

331



ASG-Insight Reference Guide

S (Show) Line Command

Sn

Function

Operands

Usage Notes

Example
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The S (Show) line command is used to redisplay the specified number of excluded lines.

These lines redisplay starting with the first line in the excluded block.

n. The number of consecutive excluded lines to show. The default is 1. If the number
specified is greater than the number of excluded lines, all lines in the excluded block

redisplay.

The S (Show) line command redisplays lines excluded as the result of any primary or line

command that excludes l